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User’s Guide

 

Introduction

 

The 

 

VideoShop User’s Guide

 

 takes you step-by-step through the process of 
making a movie with VideoShop. The chapters are presented in roughly the 
same sequence you would follow in making a movie. 

Of course, everyone has individual working styles, so if you are an experienced 
movie maker, you may want to skip around. Still, we recommend that you first 
read Chapters 1-3 to make sure you understand some basic concepts so that you 
can use VideoShop effectively.

If you are new to VideoShop or to movie-making, we recommend you follow 
the lessons in the 

 

VideoShop Tutorial

 

 before reading the 

 

VideoShop User’s Guide

 

. 
Feel free to experiment with the menus, tools, and buttons as you follow the 
instructions. 

 

 

This document was created with FrameMaker 4.0.4
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Welcome to Avid VideoShop

 

Welcome to Avid VideoShop

 



 

. With VideoShop, you can mix video, text, 
graphics, effects, CD-quality audio, and pictures to create high-quality 
videotapes and digital movies. Avid VideoShop is the perfect tool for business 
communicators, educators, and media professionals who need to create 
compelling messages.

This guide is designed to help you master VideoShop quickly and easily. If you 
are not familiar with the basics of operating a Macintosh computer, please refer 
to your Macintosh manual.

This book is divided into the following parts:

 

The Table of Contents

 

 provides a roadmap for the information in this manual.

 

The Introduction

 

 details how to get started with VideoShop, introduces 
VideoShop, and outlines the key steps for creating a digital movie.

 

Chapters 1 through 12, 

 

the bulk

 

 

 

of the

 

 

 

User’s Guide,

 

 take you step-by-step 
through detailed procedures used to create, edit, view, save, and manage digital 
movies in VideoShop.

 

Appendix A, 

 

Memory Management, discusses how to operate VideoShop 
under different memory constraints and gives information on allocating memory. 

 

Appendix B,

 

 File Formats, lists file formats that are compatible with VideoShop 
and describes how to import graphics, audio, and text created in other 
applications into your VideoShop movie.

 

Appendix C, 

 

Finding and Organizing Clips with Catalogs, discusses how to use 
a database to manage clip information.

 

Appendix D, 

 

Troubleshooting Guide, offers suggestions for what to do if you 
encounter difficulties when using VideoShop. The Avid Technical Support Staff 
has found that users can solve many problems readily by checking the settings 
listed in this appendix.

 

Appendix E, 

 

Tips and Techniques, shares some secrets that may help you use 
VideoShop more effectively.

 

The Index

 

 helps you locate information discussed in this manual.
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Getting Started 

 

Follow these steps to ensure that you have VideoShop set up and ready to go:

 

•

 

Check that you have all VideoShop materials

 

•

 

Configure your Macintosh

 

•

 

Make a backup copy of your disks

 

•

 

Install VideoShop

 

•

 

Register for technical support

 

Check for All VideoShop Materials

 

Your VideoShop box should contain the following materials:

 

•

 

VideoShop registration card

 

•

 

VideoShop Tutorial

 

•

 

VideoShop User’s Guide

 

 (this book)

 

•

 

VideoShop Reference Guide

 

•

 

VideoShop Quick Reference Card

 

•

 

Envelope with VideoShop disks

 

•

 

Coupon envelope 

If any of the above items are missing, please contact Avid Customer Relations at 
(508) 640-3070, or contact your local distributor.

 

Configure Your Macintosh

 

We recommend the following system configuration:

 

•

 

Computer:

 

 Quadra or Power Macintosh.

 

•

 

Memory: 

 

Minimum of 5 MB of RAM. For optimal performance, 
we recommend at least 8 MB of RAM.

 

•

 

Storage: 

 

Minimum of 40 MB of hard disk storage. We also 
recommend a removable storage system.

 

•

 

System software: 

 

System 7.0.1 or later.
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•

 

System extensions: 

 

QuickTime 2.0 or later and Sound Manager 
3.0 (included).

Depending on your use of VideoShop, hardware requirements may vary. The 
following table gives you an idea of the general hardware requirements. If you are 
installing boards or devices, please refer to the installation manual that came with 
your hardware.

 

Goal Hardware Requirement

 

Play and work with clips
from a CD-ROM.

CD-ROM drive.

Record your own video
and/or audio to hard disk.

QuickTime-compatible video digitizing board and audio 
board/device. Fast hard drive for optimal performance.

Create and view full-
screen, full-motion video.

Fast hard drive for optimal performance. QuickTime-
compatible video compression/decompression board; 
decompression board must be compatible with the board 
used to record and compress video. (Normally, the same 
board will provide both compression and 
decompression.)

Print your movie to
videotape.

Video-out board (capability included in some video 
digitizing boards).

Archive your video library. Mass storage devices, such as magneto-optical drives, hard 
disks, and removable cartridges.

Improve performance of
movie recording and

playback.

Accelerator board, compression/decompression board.

Create a network environ-
ment for sharing movies.

Accelerator board, compression/decompression board. 
Network: Ethernet or faster for reasonable performance. 



 

17

 

U

 

S E R

 

’

 

S

 

 G

 

U I D E

 

   Introduction

 

Backup Your Disks

 

Your license agreement authorizes you to make one backup copy of the 
VideoShop software. To back up your software, you need to copy each of the 
folders labeled “Install Disk” onto a different double-sided, 

 

high-density

 

 disk. 
Make sure that you name each copy identically to the original folder or disk. If 
you need additional instructions about how to make copies of disks, see your 
Macintosh manual.

 

Install VideoShop

 

The VideoShop installer automatically copies the VideoShop 3.0 software, the 
VideoShop Config file, and the QuickTime INIT onto your hard disk (or onto 
any other disk you specify). Installing VideoShop requires a minimum of 5 MB 
of free disk space. During installation the VideoShop installer:

 

•

 

Creates a new folder called 

 

Avid VideoShop

 



 

 3.0.

 

•

 

Copies the VideoShop software into the 

 

Avid VideoShop

 



 

 3.0 

 

folder.

 

Required Recommended

CPU:

 

Mac II or better Quadra or Power Macintosh

 

Memory:

 

5 MB 8-20 MB depending on movie size and 
complexity

 

Storage:

 

40 MB 100 MB or more

 

System 
Software:

 

7.0.1and tuner 7.1 or later

 

System 
Extensions:

 

QuickTime 2.0
Sound Manager

3.0

Hardware System Update 3.0
QuickTime 2.0 Sound Manager 3.0 
MIDI Manager (to use 
external synthesizers)
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•

 

Creates a folder in the 

 

Avid VideoShop

 



 

 3.0

 

 folder called 

 

Recording Folder

 

 and sets it as the default recording folder. Newly 
recorded clips are automatically placed in this folder unless you 
designate another recording folder. (Please refer to Chapter 11 for 
more information on the recording folder.)

 

•

 

Creates a folder in the 

 

Avid VideoShop

 



 

 3.0

 

 folder called 

 

Plug-
Ins

 

 and sets it as the default plug-ins folder. Filter and transition 
effects are then copied into this folder. (See Chapter 7 for 
information on plug-ins folders.)

 

•

 

Copies 

 

QuickTime 2.0 

 

and the

 

 Avid VideoShop

 

 

 

3.0 Config 

 

file 
into your computer’s System folder. 

 

To install VideoShop on your hard disk:

 

1.

 

Insert 

 

VideoShop Installer Disk 

 

into the internal drive of your Macintosh.

 

2.

 

Double-click the 

 

Avid VideoShop 3.0 Installer

 

 icon.

 

3.

 

Click

 

 Install

 

.

Avid VideoShop and the tutorial files are placed on the startup disk. 

 

Warning:  

 

If you choose 

 

Custom Install

 

, remember VideoShop requires Quick-
Time 2.0 and Sound Manager 3.0 Extensions in your System Extensions folder on 
your startup disk. If you are using older versions of these extensions or do not have 
these extensions, check the QuickTime 2.0 and Sound Manager 3.0 checkboxes at 
the end of the 

 

Custom Install

 

 options list.

 

Important:  

 

If you are planning to use VideoShop to control video equipment that 
use the ViSCA protocol, copy the 

 

ViSCA Control Panel

 

 from the 

 

ViSCA

 



 

 
Driver 1.2

 

 

 

folder

 

 to the Control Panels folder in your System Folder on your star-
tup disk.
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Register for Technical Support

 

Be sure to fill out and send in your product registration card in order to receive 
user service, contest information, free maintenance revisions, technical support, 
and notification of future upgrades to VideoShop.

 

When You Contact Technical Support

 

So that Avid’s Technical Support staff can better help you, please have the 
following information available when you call:

 

• Registration number 

• Version number of VideoShop software

• Macintosh model 

• Version number of Macintosh system software

• Version number of QuickTime software

You can reach the Avid Technical Support staff in a variety of ways:

• Voice telephone: (508) 640-3070 between the hours of 9:00 A.M. 
and 7:00 P.M. (EST)

• AppleLink: AvidNewMedia (Attn.: Technical Support)

• CompuServe: 71333,3020

• America Online: AvidNewMed

• eWorld: AvidNewMedia

• Fax: (508) 640-9486 
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Introduction to VideoShop
VideoShop movies are a wonderful medium for creating storyboards, producing 
dazzling videotape presentations, and developing powerful interactive training 
and educational materials. Regardless of the application or project, VideoShop 
enhances the expression of your ideas.

In 1991, Apple Computer introduced QuickTime, a system software 
architecture for integrating media on the Macintosh. QuickTime revolutionized 
the capabilities of the Macintosh by bringing motion images and sound to every 
color Macintosh. Avid VideoShop is designed to let you take full advantage of 
QuickTime.

VideoShop provides everything you need to create and present QuickTime 
movies quickly, easily, and intuitively. With VideoShop, you can:

• Record video from a VCR or camcorder to your hard disk

• Archive and search for video material

• Storyboard your creative concepts

• Edit movies with cut, copy, and paste simplicity

• Apply filter and transition effects

• Layer and composite multiple movies on the screen

• Add titles and overlay graphics

• Compose a presentation that combines video, text, graphics, music, 
voice overlay, and animation

VideoShop simplifies the creation of high-quality digital movies and videotapes. 
With the ease of cut, copy, and paste, you can compose dramatic movies that 
combine video, graphics, PhotoCD pictures, text, and audio.

To give you a better understanding of how to use VideoShop, let’s outline the 
framework for creating a digital movie:

• Recording

• Movie composition

• Delivery

• The VideoShop windows
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Recording
To create a movie, you first capture the video and audio using recording devices 
you are familiar with, such as a camcorder. Using VideoShop, you then transfer 
the video and audio clips electronically to the hard drive on your Macintosh, 
where the data is stored in a digital format. This is known as digitizing video. 
The VideoShop software lets you edit and manipulate the digitized video clips.

Digitizing
VideoShop’s built-in recording module works in conjunction with any 
QuickTime-compatible digitizing board. The recording module allows you to 
record video and audio to your hard drive from a camcorder, VCR, videodisk, 
or any other video source. (Requires additional hardware.) Please refer to 
Chapter 11 for more information. 

Depending on the kind of hardware digitizing board you are using, the quality of 
your video may vary. Some digitizing cards have compression capabilities built 
in. Other cards capture full video frames without compressing them. It is then up 
to the computer to compress the images before they are transferred to the hard 
disk drive. Some boards let you record and play “full screen” video, while others 
let you make movies that fill only one-quarter of the screen. (For more 
information on compression, please see the VideoShop Reference Guide.) The 
VideoShop recording module supports all the different types of digitizing cards. 

Movie Composition
VideoShop lets you create movies on your Macintosh intuitively and easily. You 
start by storyboarding the movie to build the general flow of images and sound. 
You can edit your movie with VideoShop’s dazzling array of special effects, 
filters, and titles, and you can add multiple tracks of video and audio to create 
layers of video and mix multiple audio tracks. 

Storyboarding
VideoShop provides you with easy-to-use tools for sequencing video, audio, still 
images, text, graphics, and animation clips. To create a movie, simply drag and 
drop media elements into the storyboard. Change the movie sequence by 
rearranging video clips, again simply by dragging and dropping.

Editing and Special Ef fects
Once the storyboard is set, you switch to time view for an accurate, frame-by-
frame view of your clips. In time view, you edit your movie using VideoShop’s 
cut, copy, and paste features, which let you edit precisely to the single frame 
level. VideoShop’s trimming feature lets you make edits that you can “undo” or 
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change. You can also apply filters and special effects to video frames just as easily 
as you apply bold and italic styles to letters in a word processor. Simply select 
frames of video and choose the desired effect from a menu.

Movie Layout
VideoShop’s unique layering and layout features allow you to size, position, and 
composite an unlimited number of media elements. An intuitive canvas interface 
lets you position video and text clips, resize them to any shape, and define 
motion control to “fly” the clips across a path. With multi-layered motion 
control and digital filters, you can create truly stunning effects right on your 
desktop.

Delivery
After you have recorded and edited your movie, you can deliver it in a format 
ready to play on a computer monitor, projection screen, or videotape.

Screen Playout
You can project the VideoShop movie from your Macintosh onto a projection 
screen or computer monitor for high-impact movie presentations. Since all 
movies are saved in the QuickTime format, you can easily incorporate your 
finished movie into other Macintosh or PC training and presentation packages 
that support QuickTime.

Print-to-Tape
VideoShop’s built-in print module allows you to print to videotape with any 
video-out hardware card. Videotapes let you reach a broad audience because 
they do not depend on computers: anyone with a VCR can watch your 
VideoShop movie on a videotape. Compose dynamic motion presentations with 
VideoShop and print them to videotape for mass distribution.

VideoShop Windows
All activity in VideoShop is performed through a collection of VideoShop 
windows. Key windows include the sequencer window (which has two views), 
the canvas window, the clip window, the folder window, the recording window, 
the info palette, and the titling window. The VideoShop logger enhances the 
functionality of the recording window and adds two new windows to VideoShop, 
the device control window and the logging window. Samples of these VideoShop 
windows are displayed on the following pages.
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Sequencer Window (storyboard view)

Sequencer Window (time view)

Play selection

Jump to Previous

Jump to Next

Stretch

Magnify

Mirrored

Select

Storyboard/

Add track
Title Tool
Filter 
Transition 

Zoom

Selection

Info Palette

Fade Out

Fade In

Trim Tool

Time View

Cut

Video Track Audio TrackExpand/Collapse Track
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Canvas Window

Clip Window

 

Path Editor

Clip/Track
Mode

Canvas/Workspace

Aspect Ratio Constrained

Free Form resize

Two Times (x2) resize

Resize From Center

Solo

Anti-Alias

Zoom

Volume

Time

Play backward/Frame backward

 Play forward/Frame forward

Scrub Bar

Shuttle

Menu

In readout Duration readout

Play/Stop

Volume

In and Out handles

Frame, play forward

Frame, play backward
Time shuttle
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Desktop Window

Recording Window

Trash Can

by small icon

Micon

by list
by icon

alphabetically
by date
by size
by type

Find

View View

Micon

folder

Record/Stop

Still Frame

Image

Recording 
dimensions

settings

Video preview

Recording space
progress bar

Recording

Volume
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Info Palette

Titling Window

Help

Time/Duration Readout

Selection Section

Clip Section

Canvas Section

Font Menu

Bold
Italics

Underline Justify
Color Wheel
Insert Text

Selection

Edit Text

Scroll Scroll Direction

Font Size
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The Device Control Window

The Logging Window 

Recalibrate
Setup
Reset
Eject

Rewind
Play Backwards
Frame Backward

Pause/Stop

Frame Forward
Play
Fast Forward

Jog Shuttle

Go To In, In/Out, Go To Out

View By Poster Frame
View By List

View Alphabetically
View By In

View By Out
View By Duration

Record/Batch Digitize

Update Poster Frames

Clip Information

Get Record Settings

Set Record Settings
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Chapter 1

 

Managing Media

 

Macintosh users are familiar with the Macintosh Finder and its ability to display and 
organize files in folders. VideoShop builds on this knowledge and provides 
powerful means for managing media files.

QuickTime video and audio files differ greatly from the word processing, graphics, 
and spreadsheet files that most people are familiar with. With QuickTime files in 
particular, simple names do not adequately distinguish one file from another. That 
is why VideoShop uses 

 

Micons

 

, movie icons—thumbnails of QuickTime movie 
files—which let you quickly preview a selected portion of the movie. The duration 
of a Micon is normally 3-5 seconds.

VideoShop provides a desktop of its own, called the 

 

VideoShop

 

 

 

desktop

 

 (“the 
desktop” in this book).

This chapter explains how the enhanced VideoShop desktop works and how to use 
it to quickly find and organize your movie files. This chapter covers the following 
topics:

• Understanding the VideoShop desktop

• Working with folders and files

• Playing movies

• Adding Micons to QuickTime movies

• Finding media clips 

• Using the 

 

Find

 

 command

 

 

This document was created with FrameMaker 4.0.4
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Understanding the VideoShop Desktop

 

The VideoShop desktop replaces the Macintosh Finder whenever VideoShop is the 
active application.

 

Whenever you work in VideoShop, the desktop displays only QuickTime and 
media-related files. Word processing, spreadsheet, and other application files are 
hidden and the same files in the Finder take on a new appearance. 

Two parts of the VideoShop desktop are displayed immediately whenever you 
launch VideoShop: the volumes window and the desktop window. These 
components let you organize the VideoShop desktop and access media files stored 
on disk.

Finder Desktop VideoShop Desktop
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The Volumes Window

 

The Volumes window has a heavy border and appears in the upper right corner of 
the desktop. It provides access to the disk drives (volumes) currently available on 
your Macintosh.

 

To open a volume:

 

n

 

Click the volume’s icon once.

The desktop window of that volume appears.

 

To close a volume:

 

n

 

Click the volume’s icon once again.

The desktop window of that volume closes.

Volumes window
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Desktop Windows

 

Desktop windows contain all media elements needed to create QuickTime movies, 
such as video and audio clips, sequencers, and graphics files.

Remember, in the desktop windows, the non-graphics and non-QuickTime files 
are hidden. 

 

Working with Folders and Files

 

A folder on the VideoShop desktop behaves like a folder in the Finder, except 
desktop windows in VideoShop have a toolstrip at the top. 

With VideoShop’s commands and toolstrip buttons, you can:

• Arrange files according to name, file type, date last saved, or file size

• Create, name, and delete folders and media files

• Copy and delete media elements

• Display particular file icons to quickly identify the different types of files in 
folders

• View file information, such as file size, last modification date, media duration, 
media types in file, and other information

VideoShop folder

Desktop Window
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To switch between VideoShop and your other applications:

 

n

 

Use the Macintosh’s Application menu, in the upper right corner of your 
screen.

 

or

 

n

 

Click anywhere outside a VideoShop window. 

 

How Desktop Windows Dif fer from Finder Folders

 

Desktop windows behave similarly to Finder folders. You can select files within a 
desktop window in the same way, drag files, select all files ( -A), and double-
click to open folders. 

There are five significant ways in which desktop windows differ from Finder 
folders: 

• A VideoShop toolstrip across the top of each desktop window helps you 
organize folder contents.

• You cannot drag files from a desktop window onto the Finder desktop. 
Instead, files can only be dragged from one desktop window to another or into 
a sequencer.

• You cannot drag files into the Finder’s trash can. Delete selected files by 
clicking the Trash button, the upper right button in every desktop window’s 
toolstrip.

• The desktop window displays each selected file’s size in bytes in the file size 
readout, in the lower left corner of each desktop window. (This is very useful 
when you need to find the size of large video and audio clips.)

• Choose 

 

Get Catalog Info

 

 from VideoShop’s 

 

File

 

 menu when you need data 
about QuickTime clips and other files. This command invokes the VideoShop 
catalog, or whatever database you have selected. Appendix C describes how to 
select a catalog.

�

Desktop window toolstrip
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Media Files Displayed in Desktop Windows

 

VideoShop displays only movie-related files in desktop windows. All other types of 
files are hidden. 

The following table shows those files that are displayed and ways to access each, 
beyond the standard Macintosh method of selecting the file and choosing 

 

Open

 

 
from the 

 

File 

 

menu (

 

E

 

-O).

 

Media Files 

 

VideoShop Folders

 

 contain media files for making QuickTime 
movies. Double-click or open from the

 

 

 

Desktop

 

 menu.

 

Micons

 

 are moving video files. Click once to select and run the 
Micon. Double-click to open and view in a clip window.

The 

 

Hand & Scissors

 

 icon is the default icon for a moving video 
file when a Micon has not yet been created for it. Double-click to 
open and view in a clip window.

The 

 

Sequencer

 

 icon is a saved sequencer file. Double-click to 
open.

 

Audio

 

 icons are sound files in SND standard file format. Double-
click to playout audio. Click once to stop playout.
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Audio CD 

 

icons are tracks of CDs which can be included in 
sequencers. Double-click to playout or drop into a sequencer to 
establish compression settings.

 

MIDI (Musical Instrument Digital Interface)

 

 files are music files 
which can be incorporated into music tracks of VideoShop 
sequencers. Drag and drop these files into the music track of the 
sequencer to display a dialog box from which these files can be 
edited.

 

AIFF (Audio Interchange File Format) 

 

files are a type of audio 
file. Double-click to open a clip window. Hold down the 

 

Option

 

 
key to change the Double Arrow Hand tool visible in the clip 
window to the Hand to grab the file and drag it into the sequencer.

 

Picture

 

 (PICT) icons represent still images. View these files by 
dropping them into VideoShop.

 

Animation

 

 (PICS) icons represent animated files. View these files 
by dropping them into VideoShop.

 

Text

 

 icons represent unformatted text files, as well as all the file 
types that the desktop knows about through QuickTime’s import-
ing capabilities (including CD and audio, for example). View these 
files by dropping them into a sequencer. 

 

Media Files (continued)
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The 

 

Recording Folder

 

 is the target folder for newly recorded video 
clips. Double-click or open from the 

 

Desktop

 

 menu.

The 

 

Plug-Ins Folder 

 

contains VideoShop effects and filters. 
Double-click to open.

 

Transition Effect

 

 icons represent video (or audio) transition effects 
applied between clips. These cannot be opened. Apply transitions 
with the 

 

Transition

 

 command on the 

 

Sequencer

 

 menu. 

 

VideoShop Filters 

 

are applied to a selected frame or frames. These 
cannot be opened. Apply filters with the 

 

Apply Filter

 

 command on 
the 

 

Sequencer

 

 menu. 

The 

 

Desktop Folder

 

 lets you access items on the Finder desktop.

The 

 

Trash Folder 

 

holds those files and folders placed into the 
Finder Trash Can.

 

Media Files (continued)
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Creating New VideoShop Folders

 

In the Finder, you create new folders by choosing 

 

New Folder

 

 from the 

 

File

 

 
menu. In the VideoShop desktop, you create new folders by choosing 

 

New Folder

 

 
from the 

 

Desktop 

 

menu.

 

To create a new folder:

 

1.

 

Open or click to select a desktop window.

VideoShop requires that at least one folder be open. New folders are created 
within this folder.

 

2.

 

Choose 

 

New Folder

 

 from the 

 

Desktop

 

 menu.

A folder icon titled “Empty folder” appears inside the desktop window.

New Empty Folder
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Copying and Renaming Files

 

To create a new copy of media files:

 

1.

 

In the desktop window, select the files you want to copy.

 

2.

 

Choose 

 

Duplicate

 

 from the 

 

Edit

 

 menu, or press 

 

E

 

-D.

The files are copied.

It is currently not possible to duplicate a folder with all of its contents.

 

To rename files and folders:

 

1.

 

Click once to select the file or folder you want to rename.

The name field is outlined. Click the name field with the Selection tool. The 
Selection tool changes to a text insertion cursor.

 

2.

 

Type a new name for the folder.

 

3.

 

Press 

 

Return

 

 or click the mouse anywhere outside the folder to accept the 
new name.

SHOT SET 7 Copy of

Match file



 

39

 

C

 

H A P T E R

 

 1

 

   Managing Media

 

Deleting a Folder or File

 

Warning:  

 

Be careful when deleting folders or files because 

 

the delete operation cannot 
be undone. 

 

If you accidentally delete a file or folder, you may be able to recover it 
with a utility program that retrieves deleted files—but full recovery is not 
guaranteed, even with use of such a utility.

 

To delete a folder or file:

 

1.

 

Select the folder or file to delete.

 

2.

 

Click the 

 

Trash

 

 button in the folder’s toolstrip. 

 

or

 

Select 

 

Delete 

 

from the 

 

Edit 

 

menu or press 

 

E

 

-K.

VideoShop asks if you are sure you want to delete the folder or file.

 

Creating Folder “Shortcuts”

 

When you are working on a project, the folders you need to access may be deeply 
nested. You can make finding and opening frequently used folders easier by 
creating folder shortcuts.

 

To create folder shortcuts:

 

1. Choose Folder Access from the Desktop menu. 

2. Choose Add Folder to This Menu from the submenu. In the dialog box, 
select the desired folder. You may need to navigate up or down the directory 
list to locate the folder.

To open a folder that is not displayed:
1. Choose Folder Access from the Desktop menu and drag the cursor to the 

submenu.

The top part of the submenu lists the currently available drives or disks 
(also called volumes). Choosing a volume from this list opens that drive.

The middle section of the submenu lists folders that have been added to the 
menu for easy retrieval. 

2. Open the desired folder by double-clicking it.

The desktop window opens on the desktop.
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Special Commands for Managing Folders
The bottom portion of the Folder Access submenu lists the following commands 
for managing the list of folders: 

Open Recording Folder. Opens the folder designated to contain recorded video 
files.

Add Folder To This Menu. Adds the name of a selected folder to the 
submenu’s list or, if one is not selected in the current desktop window, prompts 
you to select a folder to add.

Remove Folder From This Menu. Removes the name of a folder from the 
submenu’s list.

Unmount Volume. Closes the selected disk or hard drive and removes it from 
the desktop. If you unmount a removable drive, such as a floppy disk or cartridge, 
VideoShop ejects it.

Managing the List of Often-Used Folders
Folder names can be added or removed from the list in the Folder Access sub-
menu. If you search for a folder often, it’s a good idea to add its name to this list. 
You can always remove folders from the list to make room for other folders.

To add the name of a folder to the folder access submenu:
1. Choose Add Folder To This Menu from the Folder Access submenu.

2. Click to select the folder that you want to add.

3. Click Select Folder.
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The folder’s name appears in the submenu until you remove it.

To remove the name of a folder from the folder access submenu:
1. Choose Remove Folder From This Menu from the Folder Access sub-

menu.

A dialog box displays the names of the currently listed folders.

2. Select the name of the folder you wish to remove.

3. Click Remove.

The folder name is removed from the submenu.

4. Click OK.
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Playing Movies 
To play a movie:

 

n Double-click the movie’s icon. 

Depending on how the person who made the movie chose to save it, VideoShop 
may need additional files to play the movie. (These files hold the video and audio 
clips used in the movie.) The movie-maker is supposed to copy these onto the 
same disk as the movie itself, but mistakes happen. Or, if the files were moved to a 
different folder or renamed, VideoShop will need help locating them. 

When VideoShop cannot find a file it needs, it displays a dialog box:

You have two options: Cancel or Search. If you choose Search, another dialog 
box appears: 

After locating the movie, you can play it.

If you still cannot find the files, contact the person who gave you the movie and 
request the missing files.
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Adding Micons to QuickTime Movies 

When you save a sequence as a movie, or when you record your own video clip, 
the resulting file appears in desktop windows with VideoShop’s default Hand & 
Scissors icon. You can assign a Micon to the movie to more easily identify movie 
media. Note that the Save As Movie command (on the File menu) offers the 
option of automatically creating a Micon when a sequence is saved. 

To add a Micon to a movie:
1. Select the movie’s Hand & Scissors icon.

2. Choose Add Micon To Selected Clip from the Desktop menu.

The Micon takes the place of the former icon. The Micon’s default preview is 
the first 60 frames of the movie, but you can change both the portion and the 
length of the preview.

To customize the portion to be used as a Micon:
1. Double-click the Micon in the VideoShop desktop.

The movie’s clip window is displayed.

2. Use the In and Out handles to select a portion of your movie. The selection 
indicates which portion of the movie is used for the preview.

3. Choose Define Movie Preview from the Edit menu.

Out

handle

In
handle
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4. Close the clip window.

A dialog box appears

5. Click OK or press Return.

You can watch the new preview by selecting the movie’s Micon.

Finding Media Clips
Sifting through large numbers of files on a computer to retrieve your desired files is 
made easier with VideoShop. VideoShop finds and retrieves files using three 
methods:

By name.  Use VideoShop’s Find command and the Find button on each desktop 
window toolstrip, to quickly retrieve and display a stored clip, file, or folder by 
name. VideoShop’s Find command works like the Finder’s Find command. 

By catalog. To find files by their characteristics (size, date last modified, 
keywords, file type) open the Avid Cataloger by choosing the Get Catalog Info 
command from the File menu.

By preview.  Use the Open command to locate and open files. The Open 
command works like the Open command in most other applications with a few 
notable differences. When a clip is selected, a still preview of the image appears. 
This preview helps to identify and differentiate between clips. The Open 
command also lets you search by name, just as with the Find command.

VideoShop allows you to access external databases to organize and keep track of 
your movies. VideoShop includes a tool called the Avid Cataloger, a 
HyperCard-based database that helps you organize, annotate, and find your many 
movie-related files. You can also replace the Avid Cataloger with other catalog or 
database applications. For more information about catalogs, see Appendix C.
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Using the Find Command
If you know the name of a folder, video clip, audio clip, movie, or sequencer that 
you need to display, you can locate it quickly with the Find command. 

Although all folders on your system are located through VideoShop’s Find 
command, non-movie files within those folders (such as text or spreadsheet 
documents) are neither found nor displayed.

To find a media file:
1. Click the Find button on the desktop toolstrip.

or

 

n Select Find from the File menu or press E-F.

A dialog box appears.

2. Type the name of the file into the text field. Don’t worry about capitalization; 
the search function is not case sensitive.

Click the Extra Options button to extend the dialog box. These additional 
settings allow you to restrict the search, which makes the process faster. 
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Search On. Allows you to search specific volumes, or to search all the drives on 
your system. Restricting searches to particular drives can save time.

Name. Offers two choices, Partial Match and Exact Match. If you know the 
exact full name of the file, choose Exact Match. If you know part of the name, 
choose Partial Match (the default choice). VideoShop displays the file with the 
name that most closely matches your entry. VideoShop alerts you to the existence 
of more than one matching name.

Type. Allows you to restrict your search to file type, such as Video, Audio, PICT, 
Movies, Sequencers. For example, if your file is a video clip, choose Video as the 
type. (The file types that are listed depend on the files on your system.) The default 
setting is search All File types.

3. Click Find or press Return.

When VideoShop locates the first file or folder that matches the specified name 
and constraints, it displays the file or folder in a desktop window, with its icon 
selected.

To find a file again: 
1. Select Find Again from the File menu or press E-G, to locate the next 

matching file or folder.

If VideoShop cannot find the file’s name on your system, it sounds an error 
alert.



 

Chapter 2

 

Editing Movies

 

You can think of VideoShop’s sequencer as a blank VideoShop document where 
you assemble the various parts of your movie. The sequencer in 

 

storyboard view

 

 
gives an overview of your project, where you can conceptualize and rearrange the 
components of your movie. The sequencer in 

 

time view

 

 allows for fine-tuning 
and more in-depth editing. This chapter covers the different editing options 
possible in storyboard and time view:

 

Storyboard View:

 

• Dropping clips into the sequencer

• Deleting clips from a sequence

• Using the clip window

• Making a selection in the clip window

• Adding only the video or audio portion of a movie clip with synchronized 
video and audio

• Playing a sequence

• Rearranging clips in the sequencer

 

 

This document was created with FrameMaker 4.0.4
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Time View:

 

• The info palette

• Setting an insertion point

• Making selections

• Basic editing

• Using undo 

• Splicing a clip

• Using the Stretch tool

• Trimming

• Editing audio
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Storyboard View

 

Storyboard view lets you quickly arrange and rearrange media elements to create a 
movie. Storyboard view displays the clips arranged in the sequencer in the order in 
which they play. There is no timing information displayed in this view.

 

To create a new sequencer:

 

n

 

Choose 

 

New 

 

(

 

E

 

-N) from the 

 

File

 

 menu.

The sequencer opens in storyboard view. If you would prefer new sequencers 
to open in time view, change the 

 

Sequencer Preferences

 

 from the 

 

File 

 

menu’s 

 

Preferences

 

 submenu. 

 

To switch a sequencer to storyboard view:

 

You must have a sequencer open to perform this action.

 

n

 

Click the Storyboard/Time View

 

 

 

button on the sequencer.

 

or

 

n

 

Choose 

 

Storyboard View

 

 from the 

 

Sequence 

 

menu.

 

Dropping Clips into the Sequencer

 

To bring media into the sequencer, drag video clips from a desktop window into 
the video track and drag audio clip, AIFF file, and SND file icons into an audio 
track. Drag MIDI files into a MIDI track, drag PICT and PICS files into video 
tracks, and drop text files into title tracks. PICT, PICS, and Text files are 

Storyboard/Time
view button

Video track

Audio track
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automatically converted into movie format as they are brought into the sequencer. 
For more information on these file types, see Appendix B. All files occupy a single 
box in the track, regardless of their duration.

 

To drop clips into the sequencer:

 

1.

 

Open the VideoShop folder containing the clips you want to use.

 

2.

 

Drag the first video clip for your movie from the desktop window into the 
video track of the sequencer.

You need not be concerned with precise placement of the clip; regardless of 
where it is released within the track, it is placed in the first available position at 
the left side of the track. 

The first frame of the selected clip appears in the canvas window. If you place a 
movie clip that contains both video and audio into storyboard view, the audio 
and video clips appear in their respective tracks, aligned vertically.

 

3.

 

If you are editing more than one clip, drag additional clips from the desktop 
window to the video track.

Once again, no matter where it is released, the clip moves to the next available 
position on the track.

 

4.

 

Repeat with all desired clips.

Drop audio clips into the sequencer in the same way.
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Deleting Clips from a Sequence

 

To delete only a portion of the clip, you must switch to time view. For more 
information on editing individual frames, refer to “Basic Editing” later in this 
chapter.

 

To delete an entire clip from a sequence:

 

Make sure you are in storyboard view.

 

1.

 

Click to select the clip in the sequencer that you want to delete.

 

2.

 

Press 

 

Delete

 

.

 

or

 

Select 

 

Delete

 

 from the 

 

Edit 

 

menu or press 

 

E

 

-K.

The entire clip is deleted from the sequence. 

You can select multiple clips in the sequencer by holding down the 

 

Shift 

 

key 
while making your selections.

 

To restore the deleted clip:

 

n

 

Choose 

 

Undo Delete

 

 (

 

E

 

-Z) from the 

 

Edit

 

 menu.

 

Important:  

 

To undo the delete operation, you must undo immediately.

 

Using the Clip Window

 

The 

 

clip window

 

 is where you view a clip in its entirety. Whenever you double-
click a Micon, a corresponding clip window opens. This window lets you view the 
clip, advance forward or backward by frame, as well as define a portion of a clip to 
use in your sequencer.



 

52

VideoShop User’s Guide

 

To play a clip in the clip window:

 

1.

 

Double-click a Micon.

A clip window opens.

 

2.

 

Press the Play

 

 

 

button.

 

or

 

Press the 

 

Space Bar

 

.

 

or

 

Click the Frame Forward

 

 

 

button to advance a frame at a time (or hold down 
the button to play forward).

 

or

 

Choose 

 

Play Forward 

 

from the

 

 Play

 

 menu.

 

Making a Selection in the Clip Window

 

There may be times when you do not want to use an entire clip in a sequencer. In 
the clip window, you can set In and Out points to select any part of the clip.

 

To make a selection in an open clip window:

 

1.

 

Move the In handle until the desired frame is displayed and the desired time is 
shown in the In readout. 

 

or

 

 

 

n

 

Press 

 

I 

 

on the keyboard to set the In point.

Play button Frame forward

In handle Out handle
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2.

 

Move the Out handle until the desired frame is displayed in the window and 
until the desired length of the selection is shown in the Duration readout.

 

or

 

 

 

n

 

Press 

 

O 

 

on the keyboard to set the Out point.

The portion of the clip between the In and Out points you defined is now 
selected.

 

3.

 

Click in the window and drag the defined portion of the clip into an open 
sequencer.

 

Important:  

 

To adjust the In and Out points while preserving the duration of your 
selection, use the Double Arrow Hand tool. To see the Double Arrow Hand tool, 
move the Selection tool to the space between the In and Out handles. The 
Selection tool turns into a Double Arrow Hand tool. Use this tool to slide the 
selection between the In

 

 

 

and

 

 

 

Out

 

 

 

handles

 

 

 

with the Double Arrow Hand tool to 
another area of media in the clip.

AIFF (Audio Interchange File Format) files, when double-clicked, open clip 
windows. Selections are made in these audio clip windows the same way as in video 
clip windows, with the In and Out handles. To insert AIFF files into the sequencer 
from the clip window, hold the 

 

Option

 

 key. This turns the Double Arrow Hand 
tool into the Hand tool, with which you can grab and drag the clip.

In handle Out handle

Duration readoutIn readout
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Adding Only the Video or Audio Portion of a Movie Clip with 
Synchronized Video and Audio

 

Some movie files contain multiple media types, such as video and audio, but you 
want to add only one media type from that file to your movie. For example, you 
may want to drop the video portion in without the sound. This is called a 

 

constrained drop

 

 because you are using only one of the available tracks.

 

To perform a constrained drop:

 

n

 

Press 

 

E

 

 while dragging the movie file (containing both video and audio) 
into a video track, an audio track, or text track. 

Depending on the type of track, the appropriate element takes its position in 
the sequencer. The other media are not added.

 

Playing a Sequence

 

Once your clips are arranged in the sequencer, you are ready to view the material 
put together. Playout takes place in the canvas window. 

 

To play a sequence:

 

n

 

Click the Play button on the canvas window.

 

or

 

n

 

Press the 

 

Space Bar

 

.

The Play button changes to a 

 

Pause

 

 button. The movie is played in the canvas 
window.

 

To stop at any point:

 

n

 

Click the 

 

Pause

 

 button in the canvas window. 

 

or

 

n Press the Space Bar.

Resume playout by pressing the Space Bar again.
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To view frame by frame:

 

n Press the Left or Right Arrow keys on the keyboard.

or

 

n Click the Frame Forward/Frame Backward buttons in the canvas window. 

You can control playback speed and direction with the controller on the bottom of 
the canvas window. For more information concerning the controls of the canvas 
window, see Chapter 3.

Rearranging Clips in the Sequencer
After seeing your movie, you may want to rearrange the order of the clips in some 
way. 

To rearrange the order of two clips in the sequencer: 

 

n Click and drag any clip to the desired location.

The clip is inserted into the chosen slot; all subsequent clips are pushed to the 
box(es) on the right.

If audio and video (and text) for a clip are synchronized, moving any one of the 
synchronized portions also moves the corresponding synchronized clips.
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Time View
Time view is where you edit, cut, copy, clear, paste, trim selected frames, delete 
frames, and apply filter and transition effects to selected areas. You perform these 
edits as simply as you apply italics to selected text in a word processor. You can also 
synchronize audio and video clips in time view. These are the means by which you 
fine-tune your sequences.

To switch from storyboard view to time view:

 

n Click the Storyboard/Time View button at the top of the sequencer.

or 

 

n Select the Magnify tool and double-click a clip in the sequencer.

or

 

n Choose Time View from the Sequence menu.

A time bar at the top of the sequencer indicates your point in the sequence. The 
numbers represent hours, minutes, seconds, and frames (00:01:18:03, for example, 
represents 1 minute, 18 seconds, and 3 frames).

Storyboard/Time

view button

Magnify tool
Time bar
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The Info Palette
When working in time view, the info palette provides invaluable information. The 
info palette is comprised of five sections:

• Help

• Time/Duration

• Selection

• Clip

• Canvas

The help section provides a continuous readout of information about VideoShop. 
As the Selection tool moves over certain buttons and window elements in the 
titling, desktop, clip, canvas and sequencer windows, functional information about 
the element is provided. Even if a button is inactive, information about it is still 
presented. 

The time/duration section of the info palette displays the current time position 
(the playout point) in the sequencer or it displays the duration of a selection. It 
defaults to the time readout. 

To show the duration readout:

 

n Press the Duration button to the left of the readout

Once depressed, the button is red. 

Press the Time button above the Duration button to show the current time 
readout.

You may also toggle the color of the readout from yellow to blue. 
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To change the readout color:

 

n Click once on the readout.

The color changes. Click again to toggle back to yellow.

The selection section of the info palette displays statistical information about any 
selection made in the sequencer in time view. It displays the time of the In and Out 
points, and the Duration of the selection. At an insertion point, the sequencer 
selection displays the same time at the In and the Out readouts relative to the rest of 
the movie. All the information provided in the selection section of the info palette 
is in reference to the movie as a whole. 

The clip section provides statistical information about the clip selected in the 
sequencer. The In, Out, and Duration readouts refer to the position of a selection relative to 
the entire clip. 

The clip section displays the In, Out, and Duration of the clip that is contained 
within the selection. If the selection spans more than one clip, no specific informa-
tion is displayed in the clip section.

For example, the following selection in the sequencer is presented in the info 
palette as follows:

The In point shown in the selection section reads 00:00:05:06. The Out point reads 
00:00:07:10. The Duration of the selection reads 00:00:02:04. These time readings are 
relative to the beginning of the sequencer, 00:00:00:00. 
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In the clip section, the same selection reads out differently. The In point, relative to 
the beginning of the Match clip, reads 00:00:05:04. The Out point reads 
00:00:08:15. The Duration readout always remains constant, 00:00:03:11, as it 
expresses the length of the clip in the sequencer. 

The clip section also supplies information about synchronization. If a synchronized 
clip is selected in the sequencer, the sync icon appears in the upper right 
corner of the section.

If an unsynchronized clip is selected in the sequencer, the unsync icon appears in 
the upper right corner of the info palette clip section.

The canvas section provides information about the position and size of the clip 
selected in the canvas window. The Top and Left readouts display the pixel position 
of the clip relative to the canvas. The Width and Height readouts display the size of 
the selected clip in pixels. 

The upper right corner of the section also displays information about motion 
control. If motion has been added to the selected clip, the motion control icon 
appears.

If no motion has been added to the selected clip, the no motion control icon 
appears in the upper right of the section.

The info palette can be customized, to allow you to see only the sections you deem 
important to your particular task.

To customize the info palette:
1. Click and hold the pop-up menu on the upper right of the info palette 

window.

2. Unmark the section name to hide that section from the info palette. 

Mark any section name from the menu to restore that section to the info 
palette.
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To view only the time /duration section of the info palette:

 

n Click the zoom box in the upper right of the info palette window.

All other sections are hidden, only the time/duration section remains visible.

To hide the info palette:

 

n Click the close box in the upper left of the info palette window.

or

 

n Press the Info Palette button on the sequencer toolstrip.

The info palette is hidden.

To show the info palette:

 

n Press the Info Palette button on the sequencer toolstrip.

or

 

n Select Info Palette from the Windows menu.

The info palette is visible again.

Setting an Insertion Point
The playout point is a single vertical line that travels along all tracks. It indicates 
where you are in the sequence at any time. The video frame that the playout point 
passes or rests on is displayed in the canvas window. Clicking in a track moves the 
playout point to that position and displays the corresponding frame in the canvas 
window.
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Important:  The playout point is immediately before the frame being displayed in 
the canvas window.

The insertion point indicates where your next editing operation will occur. As in a 
word processor or spreadsheet program, the insertion point marks where new 
media is inserted or pasted. The insertion point in a sequencer is indicated by two 
small red triangles. 

An insertion point can straddle one or more tracks and can be placed anywhere in 
time, across all audio and video tracks, or across only a single track. By default, an 
insertion point affects only one track. 

Important:  You can set the insertion point to the current playout point of your 
movie by pressing Enter, not Return. If the playout point is beyond view in the 
sequencer, pressing Enter both sets an insertion point and scrolls the track in the 
sequencer window into view

To constrain an insertion point to a single track:

 

n Click any track at the desired point in the sequence.

The insertion point (and playout point) is moved to the point you clicked. It is 
constrained to the track you selected. 

Playout

point

Insertion

point
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To set an insertion point on multiple tracks:

1. Click the track that is to share the insertion point. 

2. Drag vertically over all other tracks.

The tracks have a shared insertion point.

or

1. Click on a track to create an insertion point.

2. Hold down the Shift key and press the Up Arrow key on the keyboard.

This extends the insertion point to the above track.

3. Hold down the Shift key and press the Down Arrow key on the keyboard to 
extend the insertion point to include the track below.

To set an insertion point across all tracks:

 

n Repeat the steps for setting an insertion point on multiple tracks for every 
track.

or

 

n Click at a point on the time bar.

The insertion point is set across all tracks in the sequence.

Shared

insertion point
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To move the insertion point up or down one track:

 

n Use the Up Arrow key on the keyboard to move the insertion point up one 
track.

or

 

n Use the Down Arrow key on the keyboard to move the insertion point 
down one track. 

Important:  The beginning of a new clip in time view is indicated by a dog-eared 
upper left corner.

Making Selections
Selecting material in VideoShop is much like selecting items in a spreadsheet or 
text in a word processor. You click and drag across the range of media (video or 
audio) you want to select. Once the selection is surrounded by a marquee, you can 
perform editing operations. You can make a selection across all tracks, or constrain 
the selection to a single track.

Important:  Once you make a selection, there is no longer an insertion point. The 
first frame of the selection is designated as the In point, the last frame of the 
selection is the Out point. You can Go to In (E-3) or Go to Out (E-4) from the 
Play menu. To play a selection, choose Play Selection from the Play menu, or 
press the Play Selection button on the sequencer, or press Return.

To make a selection across one or more tracks:
Make sure the Selection tool is active.

1. Click and drag on any track.

If you drag horizontally across a particular track, the marquee is restricted to 
that track. Dragging across and downward selects the tracks below as well.

The length of your selection is indicated on the info palette.

2. Release the mouse button when the selection is complete.
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Important:  When making a selection, it is helpful to watch the canvas window. It 
displays the frames as you select them.

To select an entire clip:

 

n Double-click a clip in the sequencer.

or

1. Click on the clip to create an insertion point.

2. Hold down the Shift key.

3. Press the Jump to Next and then the Jump to Previous button in the 
sequencer’s toolstrip.

The entire clip is selected. The selection data is displayed on the info palette.

Selection
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To extend a selection up or down one track:
1. Make a selection.

2. Hold down the Shift key.

3. Press the Up Arrow key on the keyboard to extend the selection up.

or

Press the Down Arrow key on the keyboard to extend the selection down.

The selection now spans more than one track.

To move a selection up or down one track:
1. Make a selection.

2. Press the Up Arrow key on the keyboard to move the selection up one track.

or

Press the Down Arrow key on the keyboard to move the selection down one 
track.

To make a selection across all tracks:

 

n Click and drag the time bar above all the tracks.

The time bar changes color in the selected area to show that all tracks are 
selected.
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To make a selection from the keyboard:
1. Set an insertion point—press Enter to set the selection to the current time in 

the movie.

2. Hold down the Shift key.

3. Press the Right Arrow key on the keyboard to extend the selection.

4. Press the Up or Down Arrow keys on the keyboard to include multiple tracks 
in the selection.

5. Press Return to play the selection.

When making any selection, it is helpful to watch the canvas window. It displays the 
frame following the last frame of the selection.

SHOT 14

Indicator that
all tracks are
selected

Selection
marquee
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To make a selection while the movie is playing:
1. Play the movie.

2. Press Enter (or the I key on the keyboard) to set an insertion point.

The insertion point becomes the In point.

The Enter and I keys on the keyboard are all used to mark In points. The 
Shift-Enter and O keys are used to mark Out points. Pressing these keys, 
however, pauses the video. You can restart playback by pressing the Space Bar 
or the Play button on the canvas window.

3. Press the Space Bar to resume play.

4. Hold down the Shift key.

5. Press Enter again (or the O key on the keyboard) to set the Out point.

6. Stop the playback of the movie.

You can now play from the In to Out points by pressing the Play Selection 
button or Return. The Go to In (E-3) and Go to Out (E-4) menu items 
on the Play menu move the playout point to the first and last frame of your 
selection.

Basic Editing
You will often want to cut, copy, paste, clear, or delete individual frames, a series of 
frames, or an entire movie. You perform these edits in VideoShop similar to the way 
you perform the same functions in a word processing or spreadsheet program. These 
functions are accomplished most precisely in time view.

Cut (E-X) removes the selection and places it on the clipboard. The clipboard is a 
temporary memory source, where elements are kept only until replaced by another 
selection. The clipboard stores only the most recently cut or copied material. 
Selected media on the clipboard is not stored indefinitely, but only until the next 
function that copies or cuts to the clipboard is performed. Once the selection is on 
the clipboard, you can paste it elsewhere. Cutting material shortens the duration of 
your movie, as media to the right of the cut material slide to the left to fill the 
empty frames. You can undo the cut operation by choosing Undo Cut (E- Z) 
from the Edit menu before another operation is selected.

Copy (E-C) places a duplicate of the selected material on the clipboard. Once the 
selection is on the clipboard, it can be pasted at an insertion point. The duration of 
the movie is unchanged.
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Clear removes selected media but does not place it on the clipboard. The duration 
of the movie remains the same, as blank space replaces the cleared material. 
Choosing Clear from the Edit menu is equivalent to pressing the Delete key. You 
can undo the clear operation by choosing Undo Clear (E-Z) from the Edit menu 
before another operation is selected.

Delete (E-K) removes the selection from the media but does not place it on the 
clipboard. You cannot paste the deleted material, but you can restore the deleted 
material by choosing Undo Delete (E-Z) from the Edit menu before another 
operation is selected. Like the Cut command, Delete shortens the duration of your 
movie, and media to the right of the selection slide automatically to the left to fill 
the empty frames. 

To cut, copy, clear, or delete within the sequencer:
Make sure you are in time view.

1. Select the frame or frames you want to edit by placing the Selection tool where 
you want to begin, then drag the marquee to the desired end of the edit.

2. Choose Cut, Copy, Clear, or Delete from the Edit menu, or type their 
keyboard equivalents.

The selected frames are cut or copied to the clipboard, or cleared from the 
sequencer. 

There are several ways to paste in VideoShop: Paste, Paste Overwrite, Paste 
Scale, and Paste Truncate. Refer to the section on the Edit menu in the 
VideoShop Reference Guide Chapter 10 for details.

To paste the segment within the sequencer:
1. Make sure you have media on the clipboard. To get media on the clipboard, 

make a selection and choose Cut or Copy from the Edit menu.

2. Click to establish the desired insertion point in the sequencer. Note the play-
out point also moves to that location. 

3. Choose Paste (E-V) from the Edit menu.

The material from the clipboard is pasted at the insertion point. Material after 
the insertion point shifts over automatically, changing the duration of your 
movie.
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Using Undo 
Undo enables you to restore the way the sequencer looked before your last edit 
operation. VideoShop provides one level of undo. This means you are able to undo only 
your last operation. 

To undo an operation:

 

n Choose Undo from the Edit menu.

or

 

n Press E-Z.

Once you have performed an undo operation, you can redo the undo by 
choosing Edit Redo from the Edit menu, or by pressing E-Z.

Splicing a Clip
A useful tool in editing is the Cut tool, available from the tool palette on the 
sequencer. The Cut tool is used to cut video clips into smaller clips. Making a cut 
creates a transition point, indicated in time view by a frame with a dog-eared 
corner. Cut segments of a clip are treated independently.



70

VideoShop User’s Guide

To snip one clip in two:
1. Select the Cut tool.

2. Click and drag the clip while watching the canvas.

3. When you reach the frame where you want to snip, release the mouse button.

or

1. Click in the sequencer to set an insertion point.

2. Double-click the Cut tool in the sequencer tool palette.

The clip is snipped into two clips.

To snip across all clips in the sequencer:
1. Select the Cut tool.

2. Click at the point you want snipped.

All clips in the sequencer are snipped.

Using the Stretch Tool
The Stretch tool, available from the tool palette on the sequencer, either elongates 
or shortens the duration of a clip. It performs the same action as the Scale 
Selection command on the Edit menu. 

When the Stretch tool changes the duration of a clip, it also changes the timing; a 
stretched clip plays back in slow motion relative to the amount it is lengthened. 
Likewise, a clip shortened with the Stretch tool plays back faster, relative to the 
amount it is condensed. 

Important:  The Stretch tool neither removes nor inserts frames; rather it allows you 
to view the same number of frames over a different period of time. It is particularly 
useful with PICT files. The duration of the static image in a PICT file can be 
altered to fit any length of time. For more information on changing clip duration, 
refer to Chapter 4. For more information about using still images and importing 
other file types, see Appendix B.
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To change the duration of a clip:
1. Select the Stretch tool.

2. Move the Selection tool to the edge of either end of the clip (the In or Out 
point of the clip).

The Selection tool changes to the Stretch tool.

3. Click and drag to make the clip longer or shorter.

To return a clip to its original duration:
If you dislike the edits performed with the Stretch tool, you can restore the clip’s 
original duration.

1. Select a clip in the sequencer.

2. Choose Scale Selection from the Edit menu.

A dialog box appears.

3. Set the x Scale in the dialog box to 1.

4. Click OK.

Trimming
In addition to cut, copy, and paste, VideoShop offers a trim editing tool. A clip can 
be trimmed only at its beginning (In) and end (Out) points. The In and Out points 
of a clip can be trimmed by grabbing and dragging the green triangles (trim 
handles). Once a clip has been trimmed, the trim handles turn yellow, indicating 
that there are additional media not in view.

Trim handle

Trim tool
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Trimming is one of two basic methods for synchronizing clips in separate tracks. 
Another method is to slide one clip along its track to synchronize it with another. 
When the Selection tool is positioned over the orange bar, it turns into the Hand 
tool with which you can click and grab to slide a clip along its track. Sliding and 
trimming are the basic techniques used for synchronizing clips. (For more 
information on synchronization, see Chapter 4.) 

When positioned over the green triangular trim handles of a clip in time view, the 
Trim tool appears. Dragging the trim handle with the trim tool changes the In or 
Out point of the clip. The trim handles turn yellow to identify that the clip has 
been trimmed (that is, one or more frames have been hidden, not cut).

To restore frames that have been trimmed, use the trim tool to drag the yellow trim 
handles back to their original position. When all the trimmed frames are revealed 
again, the trim handles revert back to green.

To trim a clip from the ends:
1. Place the Selection tool over the trim handle at the end of a clip. 

The Selection tool changes to a Trim tool, indicating that you can trim the 
clip.

2. Click and drag to trim or untrim the clip.

To trim a clip from any point:
1. Select the Cut tool from the sequencer’s tool palette.

2. Press the E and Shift keys to change the Cut tool to the In flag, or the E key 
to change the Cut tool to the Out flag.

3. Click the appropriate flag to both create an In or Out point and trim the 
media to that point.

Trimming is also used to fine tune transitions between two clips. When two clips 
abut, it is best to use the Trim Dialog. The Trim Dialog can be activated when a 
selection is made which spans two adjacent clips.
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To open the Trim Dialog:
1. Use the Selection tool or the Mirrored Selection tool to make a selection in 

the sequencer of an edit point which covers two adjacent clips.

The Trim Dialog button on the sequencer is active.

2. Click the Trim Dialog button.

or

Select Trim Selected Clips from the Sequence menu.

The Trim Dialog appears.

The Trim Dialog shows both selected clips. Note that while you selected only a 
portion of the two clips in the sequencer, the clips in their entirety are represented 
in the Trim Dialog. The Clip A duration and the Clip B duration readouts dis-
play the duration of the entire clips. 

In the Trim Dialog, move the Clip A Out Point and Clip B In Point sliders until 
the readouts show your desired duration, or until you see the proper frame. 
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Press the Tab key to move from Clip A Out Point to Clip B In Point to Rolling 
Trim to the Movie Controller fields. Click the Up and Down Arrows (or use the 
Up and Down Arrows or the Right and Left Arrows on the keyboard) to adjust 
the frames and seconds to be trimmed. 

The Enter Time Code field allows you to manually enter numbers for the seconds 
and frames to trim in an active field. 

To trim one second and twenty frames from Clip A:
1. Press the Tab key until the Clip A Out Point field is activated.

2. Type 120 in the Enter Time Code field. 

The Accept button is highlighted.

3. Once you have established the amount of media to be trimmed, click Accept.

In addition, you can perform a rolling trim. A rolling trim essentially trims both 
clips at once. It moves the edit point; the Clip A Out Point is moved in one 
direction the same amount as the Clip B In Point is moved in the other direction.
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To quickly trim other cuts in the sequencer:
1. Click the Next Cut and Previous Cut buttons in the Trim Dialog. 

The appropriate cut is displayed in the Trim Dialog.

2. Use the techniques described above to quickly trim other cuts in the 
sequencer.

Editing Audio
VideoShop allows you to adjust the volume level of audio clips.

To change playback volume globally, adjust the volume control located at the 
lower left corner of the canvas window. This volume control operates relative to 
the overall volume level. The maximum volume level is defined in the Apple 
Control Panel. The minimum level is zero. Changes made to the playback volume 
in this way are not saved with your movie. Each movie’s volume is controlled by 
independently by its own speaker icon.

It is possible, however, to make and save fine adjustments to individual audio tracks. 
If, for example, you are adding narration at some point in your movie, you might 
want to lower the music to an acceptable background level, then raise it again when 
the narration has finished. Or at the beginning of a clip, you might want to raise the 
volume, gradually, to fade in.

Fine-tuning the volume level of an audio track is accomplished with the rubber-
band located at the bottom of each audio clip in the sequencer.
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To adjust the audio:
1. Position the Selection tool over the rubberband until it turns into the Pointed 

Finger tool. 

2. Click and drag with the Pointed Finger to adjust the rubberband in as many 
ways and at as many different locations as you want. The farther down it is 
pulled, the lower the volume.

Position the Pointed Finger tool over the rubberband handle. At the 
beginning of a clip, the rubberband handle is a green square. At the end of a 
clip, the rubberband handle is a red square. You can click at any point on the 
rubberband in the track and create auxiliary rubberband handles, which are 
black squares. 

3. Click and drag downward, then release. 

The maximum volume level is determined by your source audio. The 
minimum is zero.

To remove an auxiliary rubberband handle:
1. Position the Selection tool over the rubberband in the video track. 

The Selection tool changes to a Pointed Finger tool.

2. Click and drag the black rubberband handle either up or down off the rubber-
band with the Pointed Finger tool.

The auxiliary rubberband handle is removed. 

To fade with the Fade In button:
1. Click to set an insertion point towards the beginning of the video clip, at the 

point you want the video to be completely faded in.

2. Click to press the Fade In button.

The rubberband automatically adjusts to fade in from the beginning of the clip 
to the point you specified; the green handle moves to the base, an auxiliary 
rubberband handle is created at the insertion point.
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To fade with the Fade Out button:
1. Mark the point at which you want the video to begin fading out with an 

insertion point.

2. Click to press the Fade Out button.

The rubberband automatically adjusts to fade out from the insertion point to 
the end of the video clip; the red handle moves to the base, an auxiliary 
rubberband handle is created at the insertion point.

The Fade In and Fade Out buttons can be used on MIDI (Musical Instrument 
Digital Interface) music, audio, and video tracks.
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A VideoShop sequencer can play standard MIDI files by importing them as 
QuickTime movie files, and playing them through QuickTime’s internal 
synthesizer. A sample MIDI file, Nina’s Eyes, has been included in the VideoShop 
Tutorial Clips folder for your experimentation. MIDI files are dropped into a MIDI 
Track. 

Once in the MIDI track of a sequencer, they can be cut, copied, pasted, stretched, 
and rubberbanded like any other VideoShop audio track. Because MIDI music files 
represent music as a series of messages to the internal synthesizer instead of an actual 
waveform, these files use much less disk space than an AIFF or SND audio file. 

To edit MIDI files:
1. Press the Add Track button on the sequencer toolstrip. 

2. Select MIDI Track from the pop-up menu.

A MIDI track is added to the sequencer.

3. Drag and drop a MIDI file from a desktop window to the sequencer.

A dialog box appears. There may be a slight delay in the display of the dialog box, 
while QuickTime processes the file.

Here you can preview the music and assign different instruments to the music tracks 
(up to 16). 

4. Click OK to load the file into the track of the sequencer.



 

Chapter 3

 

Canvas and Movie Layout

 

Chapter 2 described how to perform basic edits in the VideoShop sequencer. The 
VideoShop 

 

canvas window

 

 is where you can view a movie during editing. It is 
also where all screen position editing takes place, such as cross screen motion 
control, compositing, and layering.

The metaphors in this window are similar to those in a paint package or drawing 
program, in which you are able to position, resize, and layer media elements. The 
canvas window is where all spatial editing takes place; you can layout media 
elements and define motion to make clips “fly” along a path. 

This chapter covers the following topics:

• Controlling playout

• Setting the canvas background

• Working in canvas and workspace views

• Working in clip/track mode

• Using the bounding box

• Positioning clips in the canvas window

• Resizing clips

• Zooming in and out of the canvas

• Using transparent clips

 

 

This document was created with FrameMaker 4.0.4
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Using the Canvas Window

 

The canvas window is where you watch the movie as it is composed. The canvas 
window is a companion to the sequencer. Whenever you open a new or previously 
saved sequencer, a related canvas window is displayed. 

 

Controlling Playout

 

Movie playout begins from the 

 

playout point

 

—the vertical line that cuts through 
tracks in the sequencer. To move the playout point to the beginning of a sequence, 
choose 

 

Go To Beginning

 

 from the 

 

Play 

 

menu, or press 

 

E

 

-1.

 

To play out a sequence:

 

n

 

Click the Play button in the canvas window. 

SHOT SET 1
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or

 

n

 

Press the 

 

Space Bar

 

.

 

or

 

n

 

Choose 

 

Play Forward 

 

from the 

 

Play 

 

menu.

 

To pause a sequence:

 

n

 

Click the

 

 

 

Pause button in the canvas window.

 

or

 

n

 

Press the 

 

Space Bar

 

.

 

To view a specific frame in the canvas window:

 

n

 

In time view, click the desired frame in the sequencer until the frame you 
want is displayed on the canvas. 

 

or

 

n

 

Drag the 

 

time shuttle

 

 in the canvas window until the frame you want 
appears on the canvas.

 

or

 

n

 

Grab the horizontal scroll handle in the sequencer and slide it until the frame 
you want appears in the canvas window.

 

or

 

n

 

Use the 

 

Left

 

 and 

 

Right

 

 

 

Arrow

 

 keys on the keyboard to advance or reverse 
one frame at a time. 
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To slow down or speed up playout (while listening to audio):

 

By default, VideoShop plays out a movie at normal speed, but you can speed up or 
slow down playout dramatically. Both the video and the audio play at the rate you 
choose.

 

n

 

Drag the 

 

scrub bar

 

 to the right for forward playout. The farther right, the 
faster the movie plays. Dragging the scrub bar left will produce the same 
effect while playing backwards.

After you drop a video clip into the sequencer, the canvas window displays the first 
frame of the clip. Press the Play button in the window to playout the sequence. 

 

To move quickly to any point in the sequence in time view:

 

n

 

Click the point to which you want to move on a track in the sequencer. 

The canvas window displays the frame currently at the playout point.

 

To play a movie in reverse:

 

n

 

To quickly reverse, drag the canvas window’s time shuttle to the left.

 

or

 

n

 

Select 

 

Play Reverse 

 

from

 

 

 

the 

 

Play

 

 menu.
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Setting the Canvas Background

 

You can set the canvas background to any color or pattern to increase the visual 
impact of your movie. Backgrounds are used predominantly when the video size is 
smaller than the canvas size; where the canvas extends beyond the video is where 
the canvas background is exposed.

 

To choose a pattern for the canvas:

 

1.

 

Choose 

 

Canvas Background

 

 from the 

 

Canvas

 

 menu.

A dialog box with a list of background pattern names appears.

 

2.

 

Choose one of the textures from the 

 

Canvas Background

 

 menu in the dialog 
box.

 

3.

 

Click 

 

OK

 

, or press 

 

Return 

 

to use the currently chosen pattern as the backdrop 
for your movie.

 

To choose a color for the canvas:

 

1.

 

Choose 

 

Canvas Background

 

 from the 

 

Canvas

 

 menu.

 

2.

 

Click

 

 Solid Color

 

.

A color wheel appears.

 

3.

 

Choose a color and click 

 

OK

 

, or press 

 

Return

 

 to accept this color for the 
canvas background. 
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Important:  

 

Canvas backgrounds are not saved with the movie unless the Mixdown 
Movie option is selected when you Save As Movie. For more information, refer to 
Chapter 9.

 

To modify the size of the canvas:

 

1.

 

Choose the 

 

Canvas Size

 

 command from the 

 

Canvas

 

 menu. 

A dialog box appears.

VideoShop’s default canvas size is 160 horizontal pixels by 120 vertical pixels 
(about 1/8 the size of a 12-inch monitor). You can change the default canvas 
size with the

 

 Sequencer Preferences

 

 command under the 

 

Preferences 
command

 

 on the 

 

File

 

 menu. 

 

2.

 

Choose from a number of fixed sizes, or enter your own. 

 

3.

 

Check 

 

Scale Movies To New Size

 

 to enlarge or shrink all video clips to the 
canvas’s new dimensions. This is very useful when you know the final size of 
your movie and want all clips to conform to this size. 

 

Warning:  

 

Scaling clips larger than their original sizes can adversely affect image 
quality. 

The size of your canvas determines the size of your final movie. To determine 
which movie size you want, refer to Chapter 9.
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Working in Canvas and Workspace Views

 

In the canvas window, there is extra “workspace” around the canvas. Clips in this 
workspace are not a part of the final movie. If a clip is partially in the canvas and 
partially in the workspace, it is cropped in the final movie—only the portion on the 
canvas is shown.

When you move clips around in the canvas window, remember that only those 
portions of clips that lie directly over the canvas are visible in the final movie. 
VideoShop’s default view hides the portions of clips that lie on the workspace.

You can hide and reveal the contents of the workspace with the canvas window’s 

 

Canvas/Workspace

 

 toggle button. VideoShop defaults to canvas view.

 

To change from canvas view to workspace view:

 

n

 

Click the Canvas/Workspace

 

 

 

button on the canvas window’s toolstrip.

 

or

 

n

 

Choose 

 

Show Canvas Only 

 

or

 

 Show Workspace 

 

from the

 

 Canvas 

 

menu.

Workspace

Canvas
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Working in Clip/Track Mode

 

VideoShop’s canvas is similar to a painting or drawing program’s canvas, with one 
important difference: clips in a VideoShop canvas also include the element of time. 

Each track is made up of multiple clips. For each clip you select in the canvas 
window, there are probably clips before and after it in its track (in the domain of 
time). Therefore, when you select a clip in the canvas for layout, resizing, 
positioning, or layering, you must determine whether you also want to manipulate 
the other elements in that track (those that occur before or after in time). You set 
this option with the Clip/Track Mode

 

 

 

button.

You can control selections made in the canvas window with the Clip/Track Mode 
button, which toggles between two settings: track mode and clip mode.

 

Track mode

 

 lets you select an entire track in the canvas window—all clips on the 
track are moved in unison. If clips are positioned differently, they maintain their 
spatial orientation relative to one another. If the track has clips in different 
locations, the bounding box surrounds all those locations. Any size or scale changes 
applied to the track are applied to all the clips on the track.

 

Clip mode

 

 lets you select individual clips in the canvas window. When a clip is 
selected in this mode, the bounding box pertains 

 

only to that particular clip.

 

 Moving 
or resizing clips in this view has no effect on other clips on the same track. 

 

Using the Bounding Box
If clips in a track have been resized and positioned in clip mode, you can still 
manipulate the entire track. Since the clips in a track can have various sizes and 
positions, you define the size of the track by the bounding box around all of its 
clips.

Important:  Each clip in the sequencer has its own clip location in the canvas 
window.

A video track in the sequencer often contains more than a single clip. When a 
sequence is played out, the playout point passes over each separate clip in the track, 
and as it does so, the canvas window displays the frames of that clip. 

In VideoShop, a video clip is assigned its own location and size in the canvas 
window. In fact, every clip on the track can be assigned a different location, even 
though all are part of the same movie sequence. 
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As the playout point reaches a clip in a sequence, the clip is played in its assigned 
location in the canvas window. When the playout point passes to another clip, that 
clip plays in its assigned location. If the clips are not assigned different locations and 
sizes, the entire track simply plays out within one location and size.

To select an entire track:
1. Click the canvas window’s Clip/Track Mode button to display track mode.

Track mode is the default setting.

2. In the canvas window, click to select a clip on the track.

The track’s bounding box is displayed. This bounding box defines the 
boundaries of all the clips on the active track.

To select clips in a track:
1. Click the Clip/Track Mode button on the canvas window toolstrip to display 

clip mode.

2. Click the clip in the canvas. 

The clip’s bounding box is displayed. This bounding box defines the 
boundaries of only the selected clip.

Bounding box
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Positioning Clips in the Canvas Window
Use the Selection tool to drag selected clips around in the canvas window.

To drag a clip:
1. Select the clip in the canvas by clicking anywhere on it.

The bounding box appears.

A readout of the top left position of the clip appears in the canvas readout 
section of the info palette.

2. Drag the clip to any point within the canvas window. 

Important:  If you find it difficult to place the clip precisely where you want it on the 
canvas, try adjusting the grid with the commands on the Constraints submenu of 
the Canvas menu. For information on the Constraints submenu commands, refer 
to the VideoShop Reference Guide.
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To select all clips in the canvas window:
1. Click anywhere on the canvas window to select it.

2. Choose Select All from the Edit menu, or press E-A.

All clips are selected in the canvas window.

Resizing Clips
To select clips in the canvas window, click anywhere on the image in the canvas 
with the Selection tool. After a clip is selected, a bounding box appears around it. A 
special Double Arrow tool appears with which you can alter the bounding box to 
resize the clip. If you need precise dimensions, you can enter new dimensions with 
the Clip Size command on the Canvas menu. 

To resize a clip in the canvas window:
1. Select the clip in the canvas window. 

A bounding box appears around its borders. (In track mode, the bounding box 
of the entire track appears.)

2. Move the cursor over the lower right corner of the bounding box. 

The Selection tool changes to a Double Arrow tool. 

Bounding box

New size
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3. Drag the Double Arrow tool to change the dimensions of the bounding box. 

When you release the mouse, the video clip scales to fit the bounding box at its 
new size. 

As you resize the bounding box, the canvas readout in the info palette displays 
the dimensions of the box in pixels. 

4. By using the Resize buttons, you can constrain clip size for different 
resizing options. 

For more information, see “Options for Resizing Clips” later in this chapter.

To resize a clip from the menu:
1. Select the clip in the canvas window. 

The clip’s bounding box appears around its borders.

2. Choose Clip Size from the Canvas menu. 

This displays a submenu with several dimension choices. 

If you want to enter precise numeric dimensions, choose Set Size from the 
Canvas menu to display the Clip Size dialog box and a new set of choices.
This dialog box lets you change the size of the clip, the frame, or the entire 
track.
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• Resize clip changes the size of the selected clip only, leaving other clips on the 
track unchanged.

• Resize entire track changes the size of all the clips on the active track. 

• Resize frame only changes the size of the single frame selected. 
(See Chapter 6.)

3. Type in horizontal and vertical clip dimensions, or choose a size from the 
menu. 

4. Press OK to accept your changes.

Options for Resizing Clips
You can resize selected clips from any resizing handle (the small dark boxes) on a 
bounding box. You can control the sizing and scaling of clips in the canvas window 
with the Resize buttons in the canvas window.

The Aspect Ratio Constrained button maintains the ratio of the clip’s dimensions 
(height to width) to each other (the aspect ratio) as you enlarge or shrink the clip.

The Freeform button lets you reshape the clip without any constraints, as if the 
bounding box were a rubberband. This helps you achieve compressed (thinner) or 
expanded (fatter) appearances. You can, however, distort the dimensions and lose 
the original aspect ratio of the clip.

The x2 button maintains the clip’s aspect ratio but snaps the clip larger or smaller in 
2x increments (twice as large, four times, one half the size, one quarter, and so on).

The Resize From Center button can be used with all the above buttons. 
This button maintains the position of the center of the clip through any method of 
resizing.
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Warning:  In track mode, scale changes to the bounding box also scale each clip on 
the track proportionately. In clip mode, only the selected clip is affected.

Clip Size and Playback Quality
The benefit of making a clip larger is that you and your audience can see the video 
more clearly. On the other hand, the larger a clip is, the more processing power and 
time it takes for your Macintosh to display. Playout can be affected adversely if the 
clips get too large. 

Fast computers (such as Quadras) won’t be as affected by larger clips as much as 
slower machines (such as LCs). Playout on slower computers may be choppy if you 
resize clips.

To get the best performance possible from slower computers:

• Don’t go beyond twice (2x) the original size. This consumes a great deal of 
computer power to display, and the image quality is generally degraded. 

• Avoid intermediate sizes. The scales of 25%, 50%, 100%, and 200% work very 
well for movie playout. Intermediate sizes (such as 65%) can cause problems.

Reading Clip Size and Position Information
Whenever you want to know information about a clip in the canvas window, select 
the clip and look in info palette. The time of the selected frame appears in the time 
readout section. (For example, 00:00:03:11 means the movie is displaying the frame 
at 0 hours, 0 minutes, 3 seconds and 11 frames.)

Clip smaller than canvas Clip larger than canvas
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The info palette’s canvas readout displays the clip’s height (H) and width (W) in 
pixels. (The same information is also available through the Clip Size command on 
the Canvas menu.)

The canvas readout on the info palette constantly displays information about the 
distance of the clip’s upper left corner from the top and left side of the canvas. 

In other words, the reference point for clip position is the upper left corner of the 
canvas—not the canvas window workspace. Remember that only clips that lie over 
the canvas are visible in a final movie. 

Zooming in or out of the Canvas
It’s often useful to zoom to see detailed areas when working on small movies, or to 
shrink down to allow you to work on full screen movies on a single monitor. 

To zoom in or zoom out on your canvas:

 

n Click the Zoom (mountain) buttons in the canvas window. 

Clicking the large mountain button zooms in the canvas in 2x increments; 
clicking the small mountain button zooms out by half. 

or

1. Click and drag on the percentage menu between the Zoom buttons.

2. Choose a new percentage.

The movie zooms to the new dimension.

Caution:  The Zoom buttons do not affect actual movie size; they are simply a way 
to view movies in the canvas window. Your final movie clips do not show the new 
scale. The zoom affects all clips in the canvas window—until you change the zoom 
again.

Canvas position
readout



94

VideoShop User’s Guide

Using Transparent Clips
Transparency and shape effects are used most often for their aesthetic value; in 
VideoShop they are important in multi-track movies. The percentage of 
transparency of a clip in the canvas window determines how visible clips beneath 
(or lower in the layering order) the transparent clip become. At a transparency 
setting of 0% a clip is opaque—nothing behind it shows through. But, if you assign 
a transparency level of 50%, the clip takes on a washed out look, permitting the 
clip(s) behind to peek through. At 100%, the clip is entirely transparent and reveals 
all lower clips.

Important:  Changing a clip’s transparency or shape may degrade playout 
performance. Mixdown after changing these levels. Refer to Chapter 9 for more 
information on mixdown.

There are three ways to change the opacity of clips:

• with the Video Transparency dialog

• with the video track rubberbands

• with the Fade In and Fade Out buttons on the sequencer. 

The Video Transparency dialog lets you adjust an entire clip at once, as well as 
adjust the shape and appearance of the edges of the clip. The video rubberbands let 
you adjust the level of a portion of a clip, or the clip in its entirety. The Fade In 
button lets you mark a point and quickly fade the clip from transparent to opaque. 
The Fade Out button is used to quickly fade from opaque to transparent from a 
marked point.

To use the video rubberbands:
Video track rubberbands default to full opacity, or 0% transparency. You can adjust 
this default with the Peak Transparency slider in the Video Transparency dialog 
box.

1. Position the Selection tool over the rubberband in the video track. 

The Selection tool changes to a Pointed Finger tool.

Position the Pointed Finger tool over the rubberband handle. At the 
beginning of a clip, the rubberband handle is a green square. At the end of a 
clip, the rubberband handle is a red square. You can click at any point on the 
rubberband in the track and create auxiliary rubberband handles, which are 
black squares. 
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2. Click and drag downward, then release. 

Pulling downward increases transparency (decreases opacity). Pulling the 
rubberband handle upward decreases opacity (increases transparency).

To remove an auxiliary rubberband handle:
1. Position the Selection tool over the rubberband in the video track. 

The Selection tool changes to a Pointed Finger tool.

2. Click and drag the black rubberband handle either up or down off the 
rubberband with the Pointed Finger tool.

The auxiliary rubberband handle is removed.
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To fade with the Fade In button:
1. Click to set an insertion point towards the beginning of the video clip, at the 

point you want the video to be completely faded in.

2. Click to press the Fade In button.

The rubberband automatically adjusts to fade in from the beginning of the clip 
to the point you specified; the green handle moves to the base, an auxiliary 
rubberband handle is created at the insertion point.

To fade with the Fade Out button:
1. Mark the point at which you want the video to begin fading out with an 

insertion point.

2. Click to press the Fade Out button.

The rubberband automatically adjusts to fade out from the insertion point to 
the end of the video clip; the red handle moves to the base, an auxiliary 
rubberband handle is created at the insertion point.

The Fade In and Fade Out buttons can be used on MIDI, audio, and video tracks.
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To set an entire clip’s transparency level:
1. In the canvas window, select the clip to be effected.

2. Choose Video Transparency from the Canvas menu.

The Video Transparency dialog box is displayed. In this dialog box are 
transparency controls—a transparency bar and percentage field.

Sliding the shuttle left or right decreases or increases the transparency. 
A preview of the effect on the clip is displayed in the canvas window.

3. Adjust the transparency of the clip with the shuttle, or type a percentage into 
the field.

4. Click OK, or press Return to accept the new transparency level.
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Any change to the transparency level made with the Video Transparency dialog is 
applied to an entire clip, not just a selection of frames within the clip. To change 
the transparency or shape of only a portion of the clip, use the Cut tool from the 
sequencer tool palette to cut the clip into smaller sections. These sections are then 
recognized as individual clips, whose transparency settings can be adjusted.

To change a clip’s shape and edge quality:
1. In the canvas window, select the desired clip.

2. Choose Video Transparency from the Canvas menu.

The Video Transparency dialog box is displayed. In this dialog box are 
shape controls for softening a clip’s edges and changing its shape.

3. Adjust the edge sharpness and shape of the clip.

Slide the shuttle across the Edge Softness bar to the left or right to blur or 
sharpen a clip’s edges. You can also type in a precise value—sharp edges are 
lower numbers, blurred edges, higher.

Setting changes are reflected in the canvas window.

4. Click OK, or press Return to accept the new values.

Any change to the edges or shape made with the Video Transparency dialog is 
applied to an entire clip, not just a selection of frames within the clip. To change 
the shape of only a portion of the clip, use the Cut tool from the sequencer’s tool 
palette to cut the clip into smaller sections. These sections are then recognized as 
individual clips, whose edges and shape settings can be adjusted.



 

Chapter 4

 

Synchronizing Clips

 

Because movies are usually constructed from dozens of video and audio clips, 
precise editing of the beginning and end points of clips on the video and audio 
tracks is vital. You may want a flower to bloom at a particular point to coincide 
with the sound track. A cut to a clip of people walking on a beach has a greater 
impact when synchronized with a change in audio. These are examples of why you 
need to be able to position and synchronize audio and video clips, whether in a 
simple two-track movie or in an elaborate multi-track production.

Synchronizing is a matter of changing the location and the beginning or end point 
of clips in the sequencer’s time view. 

This chapter covers the following methods for synchronizing clips: 

• Sliding clips on a track

• Precise synchronization

• Locking synchronization

• Editing clips with the trim tool

• Changing a clip’s duration

• Inserting and removing blank time

 

 

This document was created with FrameMaker 4.0.4
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Sliding Clips on a Track

 

You can easily adjust synchronization by sliding clips in a sequencer to the right or 
left in time view. Sliding to the left causes the clip to play earlier in the sequence; 
sliding to the right causes the clip to play later. Clips have an orange bar along the 
bottom, which lets you slide clips right or left. By moving clips, you can align them 
with clips on other tracks. 

If a clip containing both video and audio (or text) is dropped into a sequencer, 
the audio and video portions of the clip are locked together. We say that this clip 
has 

 

synchronized

 

 audio and video. When you slide one track of a synchronized 
clip, all media elements of the clip are moved.

 

Important:  

 

You must be in time view to slide clips. Press the Storyboard/Time View 
button on the sequencer toolstrip to change views. 

For easier manipulation of clips in the sequencer, adjust the sequencer’s Zoom 
Menu so that you can see more time in the sequencer at once. The entire length of 
clips are in view and easier to manipulate.

 

To slide a clip:

 

1.

 

In the sequencer, position the Selection tool over the orange slide bar beneath 
a clip.

The Selection tool changes to a Hand tool that grabs around the orange slide 
bar when clicked. 

 

2.

 

Drag the orange slide bar to the left or right until the clip is positioned where 
you want it.

A rectangular outline of the clip helps you position it on the track. Position the 
outline in relation to other clips in the movie, or in relation to the 

 

time readout.

 

 
(For example, if you want the beginning of the clip at exactly 4 seconds, look for 
00:00:04:00 in the time readout on the info palette.) 

Place the Hand Tool over the orange bar to slide the clip.
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Important:  

 

Press the 

 

Control

 

 key to turn the Selection tool to a Hand tool 
anywhere in the sequencer. When clips in the sequencer are so short or so 
compressed that you cannot fit the Selection tool over the orange slide bar, press 
the 

 

Control

 

 key to get the Hand tool.

 

Caution:  

 

It may appear that a clip cannot be pushed any further when it butts up 
against another clip. If you continue to push for a second, however, the media to 
the right of the clip begin to slide.

 

To slide video or audio alone:

 

The following method lets you move only one track of a synchronized video and 
audio clip, without moving the other track.

 

1.

 

Select across both synchronized tracks.

 

2.

 

Choose 

 

Unsync Selected Clips

 

 from the Sequence menu.

When you click on the clip you want to move, you will notice the marker in 
the sequencer section of the info palette has changed from the synced clip icon 
to the unsynced clip icon.

 

3.

 

Drag the clip by the orange slide bar to the left or right until the clip’s outline 
is positioned where you want it.

Only the grabbed track slides. Any associated synchronized video or audio is left in 
place. 

 

To temorarily unsync clips to slide video or audio alone:

 

The following method allows you to temporarily unsynchronize tracks so that one 
of the tracks (video or audio) can be moved independently of the second track.

 

1.

 

Position the Hand tool over the orange slide bar.

 

2.

 

Hold down the 

 

Shift 

 

key.

 

3.

 

Drag the clip by the orange slide bar to the left or right until the clip’s outline 
is positioned where you want it.

Only the grabbed track slides. Any associated synchronized video or audio is 
left in place. 
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When you click on the clip you want to move, you will notice the marker in 
the sequencer section of the info palette remains the synced clip icon.

When the 

 

Shift

 

 key is released, the clips are still synchronized. If you grab a 
track now, 

 

without

 

 pressing the 

 

Shift

 

 key, the clips on both tracks move 
together.

 

Precise Synchronization

 

Sometimes you need more precise alignment than you can accomplish by aligning 
clips visually. For example, you may need the end point of a video clip to occur 
precisely at the 00:00:09:00 (9 second) point of the time bar, and you may need the 
beginning point of another video clip, on another track, to be at that same point. 

There are three ways to obtain this more precise control over clip positions and 
synchronization.

 

To gain more precise control:

 

n

 

Select the Magnify tool from the sequencer tool palette and click the 
sequencer until the readout indicates 

 

One Frame

 

.

 

or

 

n

 

Click the Zoom In button on the sequencer with the Selection tool until 
the readout indicates One Frame.

 

or

 

n

 

Click the Zoom Menu readout to display a pop-up menu of view selection 
and choose One Frame.
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At the One Frame scale, all the frames per second of a video clip are displayed 
in the sequencer. (The number of frames per second depends on the 
VideoShop’s frame rate, which is set with

 

 

 

the 

 

Preferences

 

 command on the 

 

File

 

 menu.) This gives you very fine control of individual frames in a clip, so it 
is easier to manipulate the beginning and end points of clips. At a scale of one 
frame, individual video frames snap easily into precise frame positions and 
times on the track. 

 

To align clips with sticky sliding:

 

1.

 

In the sequencer, position the Selection tool over the orange slide bar beneath 
a clip.

The Selection tool changes to a Hand tool that grabs around the orange slide 
bar when clicked. 

 

2.

 

Drag the orange slide bar to the left or right slowly towards the area where you 
see the clip on the track above or below. 

The outline, denoting the placement of the clip, sticks as it meets the clip on 
the other track. This is called 

 

sticky sliding

 

.

 

3.

 

Release the clip at the stick point for precise alignment.

For more information on synchronization methods, see Appendix E, “Tips and 
Techniques.”

Video sample

Repeat frame
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Locking Synchronization

 

Aside from track-to-track synchronization of audio and video clips, 
synchronization has a more traditional movie meaning, in the sense of a sound 
track being in-sync with the pictures, where the audio is locked to the video. 

If a movie clip has synchronized video and audio tracks, VideoShop allows you to 
either move both tracks together to maintain synchronization, or to move each 
track independently.

Generally, synchronization is a track-to-track action: you synchronize an audio clip 
on an audio track to a video clip on a video track. Or, you synchronize the end of a 
video clip on one track with the beginning of another video clip on another track. 
In any case, you are always synchronizing

 

 clips

 

. 

Clips referred to in this section are video and audio clips; the same procedures and 
methods are applicable to both.

 

To lock synchronization of audio and video clips:

 

1.

 

Position the video and audio clips to be synchronized so they line up 
appropriately. 

 

2.

 

Play the sequence out to ensure the audio and video are synchronized 
accurately. (Press the Play

 

 

 

button on the canvas window or press the 

 

Space Bar

 

.) 

 

3.

 

Make a selection across the two tracks with the Selection tool.

 

4.

 

Choose the 

 

Sync Selected Clips

 

 command from the 

 

Sequence

 

 menu.

SHOT 5
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This command locks the selected media from two or more tracks in their 
positions relative to each other. 

 

5.

 

The clips on the tracks now move as one unit.

 

6.

 

Synchronized clips, when selected, show the 

 

sync symbol

 

 in the clip section 
of the info palette. 

 

To unlock synchronized clips:

 

1.

 

Make a selection across the synchronized clips with the Selection tool.

 

2.

 

Choose

 

 Unsync Selected Clips

 

 from the 

 

Sequence

 

 menu.

Unsynchronized clips show the 

 

unsync symbol

 

 in the info palette.

 

Important:  

 

Trimming a clip that has been lock-synchronized to another trims both 
clips together. Hold down the 

 

Shift 

 

key to temporarily release the other clips, 
allowing you to trim only one clip. The clips are still locked.

 

Editing Clips with the Trim Tool

 

In addition to synchronizing clips to each other by physically moving or sliding 
them along their tracks, you can move the trim handles of clips (the green triangles 
at the beginning and end of a clip) to display more or fewer frames. When a clip has 
been trimmed, the green trim handles turn yellow. The end of one clip can be 
made to coincide with the beginning of another clip. 

When you trim in the sequencer, you can hide or reveal frames without losing 
them. The Selection tool turns into a 

 

Trim

 

 tool when you position it over the 
green and yellow triangular trim handles of a clip in the sequencer.

The Selection tool 
turns to
the Trim tool 
when on top

of the triangular 
trim handle.
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The Trim tool works something like pull-down shades on a house window. You 
can hide or reveal frames on a track. As you click and drag the Trim tool over 
frames on a track, the frames are hidden, though still present; this is called a 

 

non-destructive

 

 trim. 

Clicking and dragging the Trim tool back to its original position on the track 
reveals all of the previously hidden frames. 

Adjustments with the Trim tool reveal as much or as little of a clip as you wish. 
Frames that are hidden do not play in the canvas window and are not saved with the 
movie. 

The trim handles at the beginning and end of a clip serve three purposes:

• To indicate the beginning (In) and end (Out) points of a clip.

• To act as handles for the Trim tool to grab.

• To indicate when frames have been trimmed; the green trim points change to 
yellow when frames have been hidden.

 

To synchronize clips by trimming:

 

1.

 

In the sequencer, position the Selection tool over a trim point.

When the Selection tool is over the trim handel, it changes to the Trim tool. 

 

2.

 

Click and drag the Trim tool back over the clip’s frames.

As you drag the Trim tool, the time/duration readout on the info palette indi-
cates the tool’s point in time. When you release the mouse, the range of 
trimmed frames appears blank. 
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Notice that after you have trimmed frames, that trim point changes color from 
green to yellow. This indicates that some frames have been hidden and can be 
revealed again later.

 

3.

 

To reveal trimmed frames, click and drag the Trim tool back.

The Trim Dialog is another means of trimming clips for synchronization. 

 

To access the Trim Dialog:

 

1.

 

Make a selection across two abutting video clips either with the Selection tool 
or the Mirrored Selection Tool.

 

2.

 

Press the 

 

Trim Dialog

 

 button.

The Trim Dialog opens.

 

Important:  

 

The Trim Dialog shows the selected clips in their entirety, not just the 
frames selected in the sequencer.
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3.

 

Move the Clip A Out Point and Clip B In Point or Rolling Trim sliders and 
up and down arrows until the appropriate frames appear.

 

4.

 

Click 

 

OK

 

 or press 

 

Return

 

.

The frames are trimmed in the sequencer; the trim handles turn yellow to 
signify material has been trimmed.

When using the Trim Dialog on two clips with synchronized audio and video, the 
corresponding audio clip is trimmed as well; the synchronization remains locked.

 

Caution:  

 

Using the Trim Dialog on an unsynchronized video-only clip and a clip 
with synchronized video and audio, the corresponding audio 

 

is not trimmed

 

. Only 
using the Trim Dialog on two synchronized video and audio clips trims audio.

For more information about trimming, see Chapter 2.
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Changing a Clip’s Duration
Often it is convenient to expand or contract the duration of a clip. For example, if 
an audio clip is 10 seconds in duration, but a video clip is 11 seconds long, you can 
scale down the video clip by speeding its playback until it, too, is 10 seconds long. 
The two clips can then be aligned on two different tracks and locked into sync. 

If you scale up or down only slightly, you will change the playback quality of the 
selection only slightly. Naturally, if you make a considerable change in the clip’s 
duration, you will hear or see a difference in playback. A clip that has been scaled 
much longer has many repeat frames and plays in slow motion. Experiment with 
this feature to get a sense of what results to expect.

To change the duration of a clip:
1. In time view, drag the Selection tool to select all the frames of a clip in a single 

track, or double-click the clip to select the entire clip.

2. Choose Scale Selection from the Edit menu.

This displays a dialog box with several fields that relate to the duration of the 
selected frames. You can change any one of these fields.

Movie Ticks. Displays the number of ticks taken up by the currently selected 
frames. A tick is a time unit. For example, a movie created at 30 frames per second 
is on a 30 tick time scale, A 25 frame per second movie has a 25 tick time scale.

Seconds. Displays the number of seconds taken up by the currently selected 
frames.

x Scale. Displays the scale of the selection in relation to its original footage. 
Initially, selected frames are represented as having a scale of 1.00 (100%). 

S O
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3. Enter a new duration for the selected frames in one of the three fields. 

4. Click OK in the dialog box, or press Return.

The selected frames are changed to reflect their new duration. Their 
relationship to frames before and after the selection is unchanged, for example, 
blank time before and after remains in place. 

Notice that if you select only a portion of a clip, the selected frames become a 
clip, with beginning and ending trim handles and a dog-eared transition point.

To change clip speed or duration using the Stretch tool:
For information on the Stretch tool, see Chapter 2.

Before you begin, make sure you are in time view.

1. Select the Stretch tool from the sequencer’s tool palette.

2. Move the tool to the beginning or end of a clip.

At the transition point, the tool turns into the Stretch tool.

3. Click and drag the clip to the desired length.



111

CH A P T E R  4    Synchronizing Clips

To change a scaled clip back to its original duration:
1. Select the entire clip.

2. Choose Scale Selection from the Edit menu.

3. Type 1.0 in the x Scale field.

4. Click OK, or press Return.

Inserting or Removing Blank Time
Sometimes it is useful to insert a specific amount of blank time between clips in 
order to better to synchronize them. For example, you may want a particular kind 
of clip to appear in your movie every three seconds, separated by blank time or by 
a clip from another track.

To insert a specific amount of blank time at the insertion point:
1. Choose the Insert Blank Time command from the Edit menu. 

A dialog box appears.
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2. Type the duration for blank time in the Movie Ticks or Seconds fields.

3. Click OK, or press Return.

To define more precisely where to insert blank time:
1. Move the playout point one frame at a time by clicking the Frame Forward 

button in the canvas window. 

2. Press the Enter, I, or O key on the keyboard to set the insertion point at the 
playout point.

If you insert blank time within a clip, the clip is split into two.

Caution:  Inserting blank time is different from sliding clips. When you insert blank 
time, all clips in the track beyond the insertion point are shifted over by the same 
amount of time. To insert blank time over more than one track, press the Shift and 
Up and Down Arrow keys to extend the insertion point to the other tracks.

To remove blank time:
1. Double-click the area to select the entire region of blank time, or use the 

Selection tool to select an area of blank time.

2. Choose Cut from the Edit menu, or press E-X.

 or 

Choose Delete from the Edit menu, or press E-K.

The blank time is removed from the sequencer. All media to the right of the 
removed blank time slides to the left to fill the removed area.



 

Chapter 5

 

Multiple Tracks

 

Multiple-track movies employ more than one video, audio, or title track. In 
VideoShop you can edit with a virtually unlimited number of tracks in a sequencer. 
Clips are positioned and aligned on the different tracks. During playout, the playout 
point passes over all the tracks and plays each clip regardless of the track it is on. 

An important element to keep in mind is synchronizing the media in multiple 
tracks. Before attempting a multi-track movie, you should be familiar with sliding 
clips and synchronizing clips. (This is described in Chapter 4.) You should also 
understand how clips on different tracks can be laid out and moved in the canvas 
window. (Refer to Chapter 3.) This chapter covers:

• Adding new tracks

• Removing tracks

• Understanding video track layout

• Changing layers for multiple-track movies

• Layering multiple-tracks

• Creating inset movies

• Creating split screen movies

• Using active and inactive tracks

• Collapsing and expanding tracks

• Soloing a track

• Playing multiple audio tracks

• Optimizing a selection

 

 

This document was created with FrameMaker 4.0.4
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Adding New Tracks

 

You can add new empty tracks of any type (video, audio, music, or title) at any time 
when working on a movie. Choose the appropriate type of track: drop video and 
picture clips into video tracks, audio into audio tracks, and so on.

 

To add new tracks:

 

1.

 

Click and hold the 

 

Add Track

 

 button on the sequencer to display a menu.

 

2.

 

Choose the desired track from the submenu.

 

or

 

Choose 

 

Add Track

 

 from the 

 

Sequence

 

 menu, then choose the type of track 
from the submenu. 

As soon as you make a choice with either method, the new empty track is 
added as the topmost track in the sequencer.

 

Removing Tracks

 

You can delete tracks from the sequencer whenever you no longer need them. 
It is good practice to delete tracks you don’t need, if only to make it easier to see 
the other tracks in the sequencer. If the track has video, audio, music, or titles in it, 
that media are deleted as well. 

 

To delete a track of any type:

 

1.

 

In the sequencer, click the bottom half of the track’s icon at the far left of the 
track.

 

or

 

Choose 

 

Track Settings

 

 from the 

 

Sequence

 

 menu and choose the track from 
the submenu.

The Track Settings dialog box appears.
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2.

 

Click 

 

Remove

 

 

 

Track

 

.

 

or

 

n

 

Select the track to be deleted from the 

 

Remove Track

 

 submenu on the 

 

Sequence 

 

menu.

The track (and any media on it) is deleted from the sequence. The track just 
below the deleted track replaces it in the layering order. 

 

Understanding Video Track Layout

 

If you select a clip in the canvas window while the Clip/Track Mode button is in 
the track mode, a bounding box appears. This box represents the track’s space 
(spatial dimensions of clips in the track). All the clips in the track are played within 
this space. 

As long as the Clip/Track Mode button is set to track mode, any changes to the 
bounding box (or the clips from the track) affect the location of all the clips in that 
track. These changes have no effect on clips in other tracks. 

If you click the Clip/Track Mode

 

 

 

button to display clip mode, you can assign 
different locations and sizes to clips on an individual basis. These changes can affect 
the track’s bounding box, but again, have no effect on other clips in the track. 
For more information on the bounding box, refer to Chapter 3.
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Layering Multiple-Track Movies

 

The layering order of tracks in VideoShop is similar to the layering order of objects 
in a Macintosh drawing program. The track’s front-to-back order is arranged in the 
sequencer; the effect of the track order is viewed in the canvas window. VideoShop 
assigns a number to each track in a sequence to designate its position in the layering 
order, starting with number 

 

1

 

 for the topmost track in the sequencer. You can see 
this numbering order by choosing 

 

Track Settings

 

 from the 

 

Sequence

 

 menu.

The effect of a layering order on a multi-track movie sequence can most easily be 
demonstrated with video tracks. If two video tracks contain clips of equal duration 
and are playing at the same time, the uppermost track in the sequencer is higher in 
the layering order and therefore has a lower number. It is in front of the tracks 
below it.

In the canvas window, the track at the top of the layering order may obscure the 
track beneath it. To see the lower track, click and drag the clips on the upper track 
out of the way in the canvas window.

 

Important:  

 

The layering order of tracks is not particularly relevant for audio tracks. 
However, the audio and video or title tracks that relate to each other can be
organized together. Remember, when you drop in a clip that contains both audio 
and video, the respective media are inserted in the next available track in the 
sequence.

 

To change the layering order of tracks in a sequencer:

 

1.

 

In the sequencer, position the Selection tool over the track handle at the far left 
of the track’s icon, at the far left side of the track.

When the Selection tool moves over the track handle, it changes into a Hand 
tool. Pressing the mouse button displays an outline of the track.

 

2.

 

Drag the track outline up or down in the sequencer, onto a track that is 
directly above or below it. 

When you release the mouse button, the new layering order is displayed. The 
clips on the track that is moved higher in the layering order are displayed in the 
canvas window in front of the clips in tracks lower in the layering order.
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Creating Inset Movies (Picture-in-Picture)

 

An inset movie is one in which one movie plays within another at the same time. 
You can use the inset technique to create a picture-in-picture effect. In 
VideoShop, an inset movie is a two-track movie. You need at least two video 
tracks to create an inset movie.

To create an inset movie, one track is moved lower in the sequencer’s layering 
order. Thus, it becomes the background movie. For more information about 
layering, see “Layering Multiple Tracks” earlier in this chapter.

Change the 
layering order
of tracks by 
grabbing the
track handle and
dragging up
or down.

Picture-in-picture
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In the sequencer, the track higher up in the layering order becomes the 
foreground movie—it appears in front of the clips playing in the lower track(s). 

In the canvas window, this track can be made smaller so that it seems to float on top 
of the background movie. When the movie sequence is played out, both the 
background and the foreground tracks play simultaneously (for the duration which 
they coincide). 

 

To create an inset movie:

 

This procedure assumes that the sequencer is 

 

empty

 

 at the start. 

Before you begin switch the sequencer to storyboard view.

 

1.

 

Drag and drop the clip(s) for the background movie into the video track of the 
sequencer.

You can now add the foreground clip and float it on top of the background.

 

2.

 

Create a new video track by choosing 

 

Add Track

 

 from the 

 

Sequence

 

 menu 
and then 

 

Video Track

 

 from the submenu. 

A new video track appears above the one containing the background clips. 
This track is uppermost in the sequence layering order, and is the foreground.

 

3.

 

Drag and drop the clips for the inset movie into the 

 

uppermost

 

 (foreground) 
video track. 

 

4.

 

Switch the sequencer to time view by clicking the Storyboard/Time View

 

 

 

button on the upper left of the sequencer.
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5.

 

Resize the foreground track to a size smaller than the background movie.

All the clips on the inset track will play out at the size you set for the first clip. 

Play out the movie to view the full background movie and the inset movie. 
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Creating Split Screen Movies (Video Walls)

 

Split screen movies can depict events occurring simultaneously in two or more 
different locations. For example, you can show an exterior view of a space shuttle 
being launched while also showing an interior view of the astronauts working 
inside the shuttle.

As with inset movies, you need at least two video tracks for split screen movies. 
The layering order of split screen movies is of no consequence. Two or more tracks 
play out in different locations in the canvas window simultaneously.

 

To create a split screen movie:

 

This procedure assumes that the sequencer is 

 

empty

 

 at the start. 

Before you begin switch the sequencer to storyboard view. 

 

1.

 

Drag and drop video 1 into the sequencer.

 

2.

 

Add three new video tracks with the Add Track

 

 

 

button on the sequencer. Or, 
choose 

 

Add Track 

 

from the 

 

Sequence

 

 menu, and then choose 

 

Video

 

 

 

track

 

 
from the submenu.

 

3.

 

Drag and drop video 2, video 3, and video 4 into the new tracks.

Split screen movie
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4.

 

In the canvas window, click to select the topmost, or foreground, video.

 

5.

 

Resize the clip with the resize handles and reposition it on the lower right side 
of the canvas.

Watch the canvas readout in the info palette to see both a readout of the 
height and width of the clip as you resize and the position of the clip in 
relation to the canvas.
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Repeat steps 5 and 6 for video clips 1, 2, and 3, moving each clip to a different 
corner of the canvas.

Play the movie to view the split screen movie.

 

Using Active and Inactive Tracks

 

A track is active when its video, audio, or titles play in the canvas window during 
playout. Any new track in a sequencer is active (VideoShop’s default). When a track 
is inactive, its contents are neither displayed nor heard during playout. When you 
save the movie, inactive tracks are neither saved nor mixed down. (For information 
about saving, refer to Chapter 9.) A track’s active status is determined from the 
Track Settings dialog box. 

You might want to make a track inactive as you experiment with several similar 
tracks in a movie. 

 

To make a track inactive:

 

1.

 

Choose the 

 

Track Settings

 

 command from the 

 

Sequence

 

 menu, then choose 
the appropriate track from the submenu. 

 

or

 

Click the indicator at the base of the track icon at the left of the track.

Both methods open the Track Settings dialog box.
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2.

 

Click the 

 

Track Active

 

 checkbox to remove the check.

 

3.

 

Click 

 

OK

 

, or press 

 

Return

 

.

 

To reactivate a track:

 

1.

 

Choose the 

 

Track Settings

 

 command from the 

 

Sequence

 

 menu, then choose 
the appropriate track from the submenu. 

 

or

 

Click the indicator at the base of the track icon at the left of the track.

Both methods open the Track Settings dialog box.

 

2.

 

Check the 

 

Track Active 

 

checkbox.

 

3.

 

Click 

 

OK

 

, or press 

 

Return

 

.

The track is activated.
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Collapsing and Expanding Tracks

 

Working with multiple tracks can take up a large amount of screen space. 
With VideoShop, you can collapse and expand tracks. This lets you see more tracks 
in your sequencer at a time, and makes the editing process faster. One of the main 
benefits of working with collapsed tracks is that redraw is accelerated.

You can use all editing techniques while tracks are collapsed: trims, filters, 
transitions, media removal, and cut, copy, and paste commands work exactly the 
same with collapsed tracks as with expanded tracks. When video tracks are 
collapsed, the name of each video clip is displayed to help keep your sequencer 
organized.

Caution:  You cannot use an audio or video rubberband while the track is collapsed.

To collapse or expand a track:

1. Click the top half of the track’s icon. 

or

Choose Expand/Collapse from the Sequence menu.

2. Select the track to collapse from the Expand/Collapse submenu.

The track collapses or expands.
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Soloing a Track
When you play multiple clips in a sequence at the same time, performance degrades 
noticeably. Use the solo feature to play only one visible track at a time. Solo 
essentially sets all other visual tracks to inactive. Solo is especially useful with 
motion control (discussed in Chapter 6) and when you have multiple tracks with 
overlapping clips.

To play an individual track, click VideoShop’s Solo button in the canvas window, or 
choose the Solo Track command from the Canvas menu. The video, sound, MIDI, 
and title tracks can be made solo tracks.

While a track is designated as the solo track, all other visual tracks are temporarily 
deactivated. Once you remove the solo track designation, all the tracks return to 
their former settings. 

To designate a solo track:
1. In the canvas window, click the track to be played alone.

2. Click the Solo button.

or

Choose Solo Track from the Canvas menu.

All other tracks are made inactive. Only the selected track plays.

Click the track

identifier to

expand or collapse

tracks.
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To make an audio or MIDI track solo:
Make sure the track is expanded (not collapsed).

1. Click the base of a video or title track’s icon. 

or

Choose Track Settings from the Sequence menu.

The Track Settings dialog box appears.

2. Click the Track Active checkbox (to remove the check) to deactivate the 
video or title track.

3. Repeat for all active non-audio tracks.

4. Play to hear audio only.

Playing Multiple Audio Tracks
A multi-track sound track is often used in movies. One track might contain a 
voice-over—a narrator speaking and describing events seen on camera. Another 
track might be background music or sound effects that come in and out and play at 
different volumes.

In VideoShop, two audio tracks are required to produce this basic effect, one for 
the voice-over (the narration synchronized to the video), and another for the 
background music. Setting the volumes of the two tracks controls how a track is 
heard above the other.

To control multiple audio tracks:
1. Position the Selection tool over an audio track’s rubberband. 

The Selection tool changes to a Pointed Finger tool. 

2. Adjust the volume up or down by dragging the rubberband with the Pointed 
Finger tool. 
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3. Repeat for additional audio tracks.

You can add as many audio tracks as you need to contain numerous sound effects, 
music, and voice clips. By sliding and positioning them on their tracks and 
controlling their volumes, you can create complex and realistic sound tracks for 
your movies.

Caution:  You cannot adjust audio with the rubberband if the track is collapsed.

Optimizing a Selection
You can optimize or temporarily mixdown any portion(s) of a sequence. When 
you have multiple tracks of video, text, and audio all containing clips playing at the 
same time, the performance of your movie can degrade. To quickly preview how 
the final mixed down movie will look, select the portions of your movie that need 
streamlining and optimize them by choosing Optimize Selection from the 
Sequence menu. You can still edit a portion of a movie that has been optimized. 
After you perform an edit, though, the optimized section is no longer optimized. 
Refer to Chapter 9 for details on compression and mixdown.

To optimize a selection:
1. In time view, select a duration across all tracks by clicking and dragging in the 

time bar.

Optimize a 

selection by 

dragging in the

time bar.
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2. Choose Optimize Selection from the Sequence menu.

This will mixdown all the tracks to an optimized selection. The optimized 
selection is denoted by a green colored bar across the time bar.

Caution:  Editing frames of an optimized selection removes any optimization 
previously applied to the clips.

The optimized region
is highlighted in
the time bar.



 

Chapter 6

 

Motion Control

 

In VideoShop, you can use the

 

 path editor

 

 in the canvas window to define a screen 
motion path for visual media elements: video, graphics, and title clips. By adding 
motion to a media element you can make your clips “fly” across the screen. Motion 
for clips can be combined with transparency settings to create dream-like sequences 
with transparent images floating across the screen, for example.

In addition to controlling a clip’s motion over a path, you can change a clip’s size as 
it moves from one path point to another. If you change the size of the clip at any 
path point, the clip dynamically resizes as it moves.

This chapter covers the methods for controlling clip motion:

• Using the path editor

• Using predefined paths

• Saving and loading your own paths

• Controlling path speed

• Navigating along a path

• Aligning for motion

• Resizing dynamically

 

 

This document was created with FrameMaker 4.0.4
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Using the Path Editor

 

Clips can move on a path across the screen in VideoShop. A 

 

path

 

 is created using 
the path editor in the canvas window. A path consists of any number of straight line 
segments. The first path point is green, the last path point is red, and any points 
between are white. 

 

A path always applies to an entire clip.

 

To create a path for a clip:

 

1.

 

In the canvas window, click to select the clip that you want to move along a 
path.

 

2.

 

Resize the clip to your preferred starting size.
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3.

 

Move the clip to the location where you want it to begin.

 

4.

 

Click the 

 

Path Editor

 

 button.

Three tools appear on the left side of the canvas window; a line is connected 
from the center of the clip to the 

 

Add Path Point 

 

tool.

 

5.

 

Click in canvas window to create path points for the clip to follow.

Path
editor
tools
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6.

 

Repeat step 5 until your path is defined.

 

7.

 

Double-click the last point to complete the path automatically.

 

or

 

Click to select any other tool. The path is complete.

The clip follows the defined path when played.

 

To add a path point to the end of a path:

 

1.

 

Select the clip in the canvas window.

 

2.

 

Click the Path Editor button.

The three Path Editor tools appear on the left side of the canvas window.

 

3.

 

Select the Add Path Point tool.

 

4.

 

Click to add a path point to the end of the path.
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To add a point in the middle of a path:

 

1.

 

Click the Path Editor button.

Three tools appear on the left of the canvas window.

 

2.

 

Select the 

 

Modify Path 

 

tool.

 

3.

 

Click and drag the path line to create a new path point. 

Click and drag to
add a new path
point.
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To edit a path:

 

1.

 

Click the Path Editor button.

Three tools appear on the left of the canvas window.

 

2.

 

Select the Modify Path

 

 

 

tool.

 

3.

 

Click on any path point and move it to a new location. 

 

To remove a path point:

 

1.

 

Advance to a clip in your movie that has a path defined.

 

2.

 

Click the Path Editor button.

Three tools appear on the left of the canvas window.

 

3.

 

Select the 

 

Delete Path Point

 

 tool.

 

4.

 

Click the point that you wish to remove.

The path point is deleted.
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To remove an entire path:

 

1.

 

Advance to a clip in your movie that has a path defined.

 

2.

 

Select the clip in the canvas window.

 

3.

 

Choose 

 

Clip Motion

 

 from the 

 

Canvas

 

 menu.

The Define Clip Motion dialog box appears.

 

4.

 

Click 

 

Remove

 

 in the Define Clip Motion dialog box.

 

5.

 

Click 

 

OK

 

.

The path is removed.

SET 7

Click to remove
a path point.
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Using Predefined Paths

 

Since it is possible to create complex path motions, VideoShop allows you to apply 
predefined paths to a clip, or to create your own saved clip motions.

 

To use a predetermined path:

 

1.

 

Select a clip in the canvas window.

 

2.

 

Choose 

 

Clip Motion 

 

from the 

 

Canvas

 

 menu.

The Define Clip Motion dialog box appears.

 

3.

 

Check the 

 

Apply Motion

 

 checkbox.

A direction menu appears.

 

4.

 

Select your desired direction.

The 

 

In

 

 selections move a clip into your designated path point, making the 
path point the end point. The 

 

Out

 

 selections move the clip out from your des-
ignated path point, making that path point a start point. 

The clip moves in a straight line across the path.

If you have created a path you like, you can save it and apply it again to other clips 
at a later date.
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Saving and Loading Your Own Paths

 

With VideoShop, you have the flexibility to create and save paths to use on other 
projects at a later date.

 

To save a path:

 

1.

 

Create a path for the clip.

 

2.

 

Choose 

 

Clip Motion

 

 from the 

 

Canvas

 

 menu.

The Define Clip Motion dialog box appears.

 

3.

 

Click 

 

Save

 

 in the Define Clip Motion dialog box.

A Save dialog box appears.

 

4.

 

Name the path.

 

5.

 

Click 

 

OK

 

, or press 

 

Return

 

.
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To apply a saved path:

 

1.

 

Select the clip in the canvas window.

 

2.

 

Choose 

 

Clip Motion

 

 from the 

 

Canvas 

 

menu.

The Define Clip Motion dialog box appears.

 

3.

 

Click 

 

Load 

 

in the Define Clip Motion dialog box.

 

4.

 

Select a path.

 

Controlling Path Speed

 

The speed a clip travels when flying along a path is determined by the duration of 
the clip and the length of the path.   No matter how long the path is, the clip travels 
from the first path point to the last path point over the duration of the clip. For 
example, with the same path, shortening the clip’s duration increases the speed that 
the clip flies along the screen.

 

To change the motion speed of a clip:

 

Before you begin, switch the sequencer to time view.

 

1.

 

In the sequencer, double-click to select the entire clip.

 

2.

 

Choose 

 

Scale Selection 

 

from the 

 

Edit

 

 menu.

The dialog box appears, displaying the current duration of the selection.

 

3.

 

Enter the desired

 

 

 

values for 

 

Movie Ticks, Seconds, or X Scale.

4. Click OK, or press Return.

or
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Change the duration of the clip by trimming the end with the Trim tool. 
For more information on changing duration refer to Chapter 4.

or

Change the duration of the clip with the Stretch tool. For more information 
on stretching clips refer to Chapter 2.

Navigating along a Path
To help you create and edit paths, VideoShop provides some convenient shortcuts. 
These shortcuts let you navigate along a path, jumping from one path point to the 
next.

To step from path point to path point:
1. Select a clip in the canvas window.

2. Click the Path Editor button.

3. Hold down the Option key.

4. Click the Frame Forward button on the canvas to advance to the next path 
point, or click the Frame Backward button to move to the previous path 
point.

The canvas window displays the path point; the playout point moves to the 
corresponding frame in the sequencer.

Aligning for Motion
The Align command controls alignment in the canvas window. Alignment locks 
clips in time and tracks in space. The Align command can be used to create motion 
control without using the path editor.

Alignment controls the synchronization of two clips in the same track over time. This feature 
precisely matches up one clip on a track with another. The Align command works 
with motion control, just as the Sync Selection command works with sound 
synchronization. 

When the beginning frame of a selected clip is aligned to the previous clip, the 
selected clip gradually moves across the canvas to the position of the previous clip. 
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Likewise, when the end frame of a selected clip is aligned to the next clip, the 
selected clip gradually moves to the position of the next clip.

 To apply motion with the Align command:
Make sure you are in clip mode. If not, press the Clip/Track mode button.

1. Select a clip in the canvas window.

2. Choose either Last Frame to Next Clip or First Frame to Previous Clip 
from the Align submenu of the Canvas menu, or establish your own 
parameters with the Custom dialog box.

When the movie is played, the aligned clip moves to the position of the clip to 
which it was aligned.

Resizing Dynamically
You can resize a clip over time to add to motion in the canvas window. When you 
resize a clip at a path point, VideoShop dynamically shrinks or enlarges it while 
moving it from the previous path point to the resized path point.

The change in size occurs gradually, as the clip moves during playout from one key 
frame to the next. 

To resize a clip as it moves along a path:
1. In the canvas window, select a clip in your movie that has a path defined.

2. Click the Path Editor button.

The path editor tools appear on the left of the canvas window.

3. Select the Modify Path tool.

4. Click a path point.

A bounding box appears around the clip. At the bounding box, the 
Modify Path tool turns into the Double Arrow tool.



141

CH A P T E R  6    Motion Control

5. Use the Double Arrow tool to resize the clip at that path point.

During playout, the clip resizes dynamically.

The canvas section of the info palette provides a readout of the size and position of 
the clip relative to the canvas as you set path points and as you play.
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Chapter 7

 

Special Effects

 

Special effects add polish and visual impact to your movies. VideoShop includes 
two categories of effects, transitions and filters.

Transitions are effects that blend the end of one clip with the beginning of another, 
providing seamless passage between either video or audio clips. 

Filters are graphic effects applied to movie frames over a specific period of time. 
Some filters are designed for one individual track, others work only over multiple 
tracks.

This chapter covers:

• Using the Plug-Ins folder

• Applying filters

• Applying multi-track filters

• Applying filters to titles

• Changing the duration of filters

• Changing the quality of filters

• Applying transitions

• Altering the transition style

• Changing the duration of transitions

• Correcting color 

• Removing filter and transition effects

 

 

This document was created with FrameMaker 4.0.4
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Using the Plug-Ins Folder

 

VideoShop provides its own filters, transitions, canvas backgrounds, and third-party 
plug-in effects. All effects are stored in a VideoShop folder named Plug-Ins.

 

To add a new ef fect:

 

1.

 

In the Finder, double-click to open the Plug-Ins folder.

 

2.

 

Place the new plug-in into the appropriate folder: the Filters folder, 
Transitions folder, Backdrops folder, Components folder, or Third-Party 
folder.

 

Important:  

 

The folders within the Plug-Ins folder simply facilitate the organization 
and management of different effects. VideoShop can find new effects anywhere 
within the Plug-Ins folder. 

 

3.

 

Quit VideoShop.

 

4.

 

Launch VideoShop again.

Your new effect is available by clicking the Filter and Transition buttons on the 
sequencer, or by choosing the 

 

Apply Filter 

 

or 

 

Apply Transition

 

 commands from 
the 

 

Sequence

 

 menu. Canvas backgrounds are accessible through the 

 

Canvas 
Backgrounds

 

 command on the 

 

Sequence

 

 menu.

VideoShop has been enhanced to take advantage of the increased performance of 
Power Macintosh. You will notice a greater responsiveness during normal editing. It 
is typical for some transitions and filters to process 2 to 5 times faster when running 
on a Power Macintosh.
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A special file (in the Extensions folder inside your System Folder) called the 

 

Avid 
VideoShop

 



 

 PowerPlug

 

 accelerates VideoShop. If you are running on a Power 
Macintosh and this file is not present, you will be notified when VideoShop starts 
up. You should then attempt to locate this file and place it in the Extensions folder. 
If you have used the installer and chose VideoShop for Power Macintosh, then this 
file should already be installed.

The VideoShop application must aware of the location of the Plug-Ins folder. 
Either the application needs to be in the same spot as the Plug-Ins folder, or you 
need to let VideoShop know it is in another location. The following method for 
designating a new Plug-Ins folder is also used for identifying its location.

 

To change the default plug-ins folder:

 

1.

 

Choose the 

 

Preferences

 

 command from the 

 

File

 

 menu.

 

2.

 

Choose 

 

Avid Desktop 

 

from the 

 

Preferences

 

 submenu.

 

3.

 

Click 

 

Set plug-ins folder

 

.

A dialog box appears.

 

4.

 

Select the desired new effects folder.

 

5.

 

Click 

 

OK

 

, or press 

 

Return.
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Applying Filters

 

Filters are special effects that change the appearance or characteristics of the frames 
to which they are applied. There are one track, two track and three track filters. .

This section describes how to apply single-track video to your movie. To apply fil-
ters to a number of tracks, refer to the section “Applying 
Multi-Track Filters” later in this chapter. 

For a list of all filters included with VideoShop and the number of tracks over 
which they are applied, refer to the “Effects Listing” in the 

 

VideoShop Reference 
Guide

 

.

There are two ways to apply a filter effect to a video sequence. Use the first method 
if you would like to preview different filters before applying them. The second 
method is a shortcut, which allows you to bypass the previewing stage and to 
directly select and apply your chosen filter.

 

To apply a filter: 

 

Make sure you are in time view.

 

1.

 

Select the frames over which to apply the filter.

 

 

Important:  

 

When making a selection, it is helpful to watch the canvas window, 
which displays the last frame of your selection.

SHOT 3
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2.

 

Click the 

 

Filter

 

 button.

 

or

 

Choose 

 

Apply Filter

 

 from the 

 

Sequence

 

 menu, then choose 

 

Apply Filter

 

 
from the submenu.

The Apply Filter dialog box appears. 

The top left side of the dialog box contains a menu showing how many tracks 
you have selected. Next is a list of filters available. Only filters applicable to the 
number of tracks selected appear. For example, if you have selected a region 
over one track, only single-track filters are available.

On the right side of the dialog box are several features.

 

Preview. 

 

Shows you how a sequence appears after the filter has been applied. The 
controls under the preview window allow you to play the sequence, shuttle back 
and forth along it, and advance or rewind frame by frame.

 

Duration bar. 

 

Allows you to increase or decrease the amount of video or audio 
media over which the filter is applied. If, for example, you selected 8 frames in the 
sequencer over which to apply the filter, this bar reflects this duration but allows 
you to manually increase or decrease it as you see fit. 

Number of
tracks selected

List of filters

Ef fect quality menu

Preview area

Duration bar

Built ef fects list
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Effect Quality. 

 

Determines which hardware or software compression algorithm is 
used to build your filter effect. For more information of effect quality, see the 
section

 

 

 

“Changing the Quality of Filters” later in this chapter.

 

Built Effects. 

 

Keeps track of previewed filters. After you have finished previewing 
filters, choose a filter from this list to apply to your movie sequence. 

 

3.

 

Choose a filter from the list of available filters and click 

 

Build Effect

 

.

As with all Macintosh menus and lists, if a filter’s name is followed by ellipses 
(...), there are parameters specific to the filter displayed in a dialog box. The 
dialog box lets you set parameters appropriate to the type of filter and, if 
appropriate, to select the settings in the options dialog for that filter effect.

A Building Effect dialog box opens. As the effect is being built, you can check 

 

Show Preview

 

 to see the effect applied to your selected frames.

 

The Building Effect dialog box closes automatically at the end of this process, 
and the Effects Preview plays out the selected frames affected by the chosen 
filter.

Now, you can select another filter to preview in the same way. Any previously 
built filters are listed in the 

 

Built Effects

 

 menu. 

 

4.

 

When you have previewed all the filters you want to see, select one from the 
list of built effects, and click 

 

OK

 

 to insert the filter into your sequencer.

The dialog box closes and the filter is inserted into your movie. A blue bar 
appears over the portion of the clip to which the filter has been applied.
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To use a shortcut to apply a filter:

 

Make sure you are in time view.

 

1.

 

Select frames to which to apply a filter.

 

Important:  

 

While making a selection, it is helpful to watch the canvas window, it 
displays the last frame of your selection.

 

2.

 

Click and hold the 

 

Filter

 

 button, then select the filter to apply from the 
submenu.

or

Choose 

 

Apply Filter

 

 from the 

 

Sequence

 

 menu, then select the filter to apply 
from the submenu.

A Building Effect dialog box opens. As the effect is being built, you can check 
Show Preview to see the effect being applied to your selected frames. 

The Building Effect dialog box closes automatically at the end of this process, 
and the filter is automatically inserted into your movie sequence. Once a filter 
has been applied, a blue bar appears over that portion of the track, indicating 
that a filter has been applied to those frames.

A blue bar appears
over the region with

a filter ef fect.
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Applying Multi-Track Filters

 

When you select across multiple tracks and click the Filter button, only those filters 
which work with the specific number of tracks are listed. Multi-track filters 
include: fade in, fade out, chroma/luma key, morph, Alpha Map, and Alpha 
Channel Filter. See Appendix E, “Tips and Techniques,” for more information on 
specific multi-track filters.

 

To fade in or fade out:

 

1.

 

Add a new track to your sequencer and insert the foreground video or title 
sequence to be faded. (Refer to Chapter 5, “Multiple Tracks,” and Chapter 8, 
“Adding Titles to Movies.”)

 

2.

 

Add another video track for the background over which media will fade in or 
fade out.

 

3.

 

Position the track containing the foreground media directly above the track 
containing the background. (Refer to Chapter 5.)

 

4.

 

Make a selection across both tracks. 

The filter effect will be applied to this selection.

 

5.

 

Click the Filter button on the sequencer toolstrip and choose 

 

Fade in

 

 from the 
submenu.

When the effect is completed, the two sources are blended together. The 
resulting effect appears in the first video track. 
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Applying Filters to Titles

 

Although special effects filters apply primarily to video and audio tracks, the fade 
in, fade out, and Alpha Map can also be applied to titles. For more information on 
Alpha Filters, see Appendix E, “Tips and Techniques.” VideoShop also provides the 
option to add drop shadows to titles. For more information on adding titles to 
movies and using drop shadows in titles, refer to Chapter 8.

 

Caution:  

 

Only the Fade In, Fade Out, and Alpha Map filters can be applied to 
titles.

 

Changing the Duration of Filters

 

The duration of a filter effect is determined by the duration of media (video, audio, 
or titles) selected. The selection duration readout in the sequencer window and the 
effect duration readout in the Filter Effect dialog box display this duration. 

 

To change the duration of a filter ef fect:

 

n

 

In the Filter Effect dialog box, slide the handles on the

 

 effect duration bar

 

 
right or left to add or subtract frames from either the beginning or end of the 
effect duration.
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The effect duration readout indicates the frames over which the effect is 
applied. Effect duration can be trimmed down to any single frame of the 
sequencer selection. Effect duration can be extended up to two seconds at 
either end of the sequencer selection. If you need to extend the effect further 
than two seconds at either end or four seconds overall, you must return to the 
sequencer and make a longer initial selection. You can always trim if you select 
too much.

 

Caution:  

 

Changing the duration of a filter effect is not the same as stretching a clip. 
If the duration of a filter effect is changed, the media over which the filter is applied 
also change. If media containing a filter effect are stretched or shrunk, playout of 
the sequence either slows down or speeds up, but the underlying media remain 
unchanged.

SHOT 11

Ef fect duration 
readout



 

153

 

C

 

H A P T E R

 

 7

 

   Special Effects

 

Changing the Quality of Filters

 

There are five quality settings available for filter effects. Each setting is chosen from 
the 

 

Effect Quality

 

 menu in the Filter Effect dialog box.

 

Default Video. 

 

VideoShop attempts to build the effect with compression settings 
that match those of the source material. If VideoShop cannot match the quality and 
frame rate of the source material, then the default compressor 

 

Apple Video

 

 is used.

 

Default Graphics. 

 

Functions in the same way as Default Video, except that if 
VideoShop cannot match the quality and frame rate of the source material, then the 
default compressor 

 

Apple Animation

 

 is used.

 

Best Quality. 

 

Defaults to 

 

Apple None

 

, however, if you have redefined the 
definition of 

 

Best Quality in the Effects Preferences dialog, VideoShop uses the 
definition that you have chosen.

Custom Quality. Defaults to Apple Video, but the definition of Custom 
Quality can be redefined through the Effects Preferences dialog box. If you have 
redefined Custom Quality through the effects preferences, then VideoShop uses 
the definition that you have chosen.

Other. Brings up a dialog box from which you can choose a compressor, effect 
quality, and motion settings on the fly. 

The choice of compressors available is determined by QuickTime and by the type 
of video hardware installed in your Macintosh. For detailed information about 
compression settings refer to Chapter 9.
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Applying Transitions
Transitions are the boundary between two clips. Transition effects are used to blend 
the end of one clip with the beginning of another. For example, you might want to 
dissolve from one clip to the next, rather than abruptly ending one and beginning 
another. 

A transition effect is applied at the boundary between video or audio clips. For a list 
of all transition effects included with VideoShop, refer to “Effects Listing” in the 
VideoShop Reference Guide. 

There are two ways to apply transition effects. One allows you to preview different 
transitions before choosing one. The other method allows you to bypass the 
preview and apply a specific transition effect immediately. 

To apply a transition:
Make sure you are in time view.

1. Locate a transition point (indicated by a dog-eared corner) between two clips.

2. Select the Mirrored Selection tool from the sequencer’s tool palette.

3. Place the Mirrored Selection tool over the transition point, then click and 
drag.

As you drag the Mirrored Selection tool, the selection automatically expands 
an equal number of frames on the right and left of the transition frame.

Click and drag
near a transition
point to make a

mirrored selection.

Mirrored Selection
 tool
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or

Select an uneven area across two clips with the Selection tool.

You can select a duration for the transition either by eye or by using the time/
duration readout on the info palette.

4. Click the Transition button on the sequencer.

or

Choose Apply Transition, then Apply Transition from the Sequence menu.

An Apply Transition dialog box is displayed.

The left side of the dialog box contains a menu of transition effect categories. 
Next is a complete list of the transition effects available in the chosen category. 
Beneath that is an animated preview of the effect as applied to two test images. 

Ef fect category

transition list

Transition preview

Transition description

Transition style 

Built ef fect listDuration bar Preview area

Ef fect qualitystyle preview
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A description of the effect follows.

On the right side of the dialog box are several menus: 

Transition Style. Determines how VideoShop overlaps clips when creating a 
transition.

Effect Quality. Determines compression settings when the transition effect is 
built.

Preview Area. Shows the transition applied to your selected frames. 

Duration bar. Controls the duration of your transition effect. If, for example, you 
selected 8 frames in the sequencer over which to apply the transition, the green/red 
bar is displayed to reflect this duration. 

Built Effects list. Keeps track of those transitions already previewed. Once you 
have finished previewing transitions, choose one from this list to apply to your 
movie sequence. 

5. Choose a transition effect from the list and click Build Effect.

The first preview box showed the transition as applied to red and green test 
images. The preview shows the transition as it is applied to your selection.

6. When you have previewed all the transitions you want to see, choose one from 
the list of built effects, and click OK to insert the effect into your sequencer.

The dialog box closes and the effect is applied. A blue bar appears over the 
portion of the clip to which the effect has been applied.

When you apply a transition, VideoShop creates new media that contain the 
affected movie frames.
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In time view, the transition clip is separated from the rest of the clips by a dog-eared 
corner with a blue bar on top. In storyboard view, it appears as a separate clip, 
named for the transition.

To use a shortcut to apply a transition ef fect:
Make sure you are in time view.

1. With the Selection tool or the Mirrored Selection tool, make a selection over a 
transition point.

2. Click and hold the Transition button, then select a transition from the 
submenu.

or

Choose Apply Transition from the Sequence menu, then select a transition 
from the submenu.

A Building Effect dialog box opens. As the effect is being built, you can check 
Show Preview to see the effect as it is applied to your selected frames.

When the Building Effect dialog box closes, the built effect is automatically 
inserted into your movie sequence. A blue bar appears over the new transition 
clip.

A blue bar
indicates that
an ef fect has

been applied.
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Altering the Transition Style
When some transition effects are created, a portion of the first clip overlaps and 
interweaves with a portion of the second clip. The Transition Style menu on the 
Apply Transition dialog box lets you choose how the clips overlap and how the 
duration of your movie is affected. 

Transition styles:

Pull In. The second clip is pulled underneath the first clip. The duration of the 
overall video sequence is shortened by one half of the transition duration. 

If media have not been trimmed, Pull In and Pull and Stretch are the only 
transition styles available.

Pull and Stretch. The second clip is pulled underneath the first clip, just as with 
Pull In. However, the transition is then stretched (played at half speed) to maintain 
the original duration of the video sequence.

If media have not been trimmed, Pull In and Pull and Stretch are the only 
transition styles available. 
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Centered at Cut. Both clips are unrolled evenly by one half of the transition 
duration. The overall duration of the video sequence does not change.

This style of transition is only available if both the first and second clips have been 
trimmed. (For more information on trimming, refer to Chapter 4.) The duration of 
the transition is limited by the amount of media trimmed from both clips. If one 
second has been trimmed from the first clip and two seconds have been trimmed 
from the second clip, the transition duration can be at most two seconds (one 
second of material from each clip).

Start at Cut. The first clip is untrimmed to extend under the second clip. The 
overall duration of the video sequence does not change.

This style of transition is only possible after the first clip has been trimmed. (For 
more information on trimming, refer to Chapter 4.) The duration of the transition 
is limited by the amount of media that was trimmed. If two seconds have been 
trimmed from the first clip, the transition duration can be at most two seconds.
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End at Cut. The second clip is trimmed to extend under the first clip. The overall 
duration of the video sequence does not change.

This style of transition is only possible after the second clip has been trimmed. (For 
more information on trimming, refer to Chapter 4.) The duration of the transition 
is limited by the amount of media that was trimmed from the clip. For example, if 
two seconds have been trimmed from the second clip, the transition duration can 
be at most two seconds.

To see a demonstration of each transition style:
1. Choose the style of transition to view from the Transition Style menu in the 

Apply Transition dialog box.

To choose Start at Cut, End at Cut, or Centered at Cut, media must be 
trimmed from the first and/or second clip.

2. Click the diagram next to the Transition Style menu. 

The diagram animates, demonstrating the transition.

3. Click the diagram again to see the demonstration again.
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Changing the Duration of Transitions
The duration of a transition effect is determined by the amount of media (video or 
audio—transitions cannot be applied to titles) selected. The time readout in the 
sequencer window and the effect duration readout in the Apply Transition dialog 
box display the duration. 

To change the duration of a transition ef fect:

 

n In the Transition Effect dialog box, slide the handles on the effect duration 
bar to the right or left to add or subtract media from either the beginning or 
end of the transition. 

The preview window shows the first and last frames in the transition and 
displays the duration of the transition between them.

The minimum transition duration is three frames. The amount of time that can 
be added to the transition effect is limited to one second at each end.

Caution:  Changing the duration of a transition effect is not the same as stretching a 
clip.
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Correcting Color
Many times, a movie editor makes certain aesthetic changes to movie frames that 
are similar to the retouching effects that a photographer applies to an image 
negative before printing. 

To edit individual frames and make color changes:

 

n Use the Color Balance filter supplied with VideoShop.

or

 

n Paste frames into a graphics application that has painting and color tools. 
Refer to Appendix B for more information on how to do this.

Caution:  Certain third party CODECs (compression/decompression 
components) are very sensitive to hard edges between areas of high contrast or big 
color changes. This can sometimes produce compression artifacts on some effects.

For more information about incorporating filter effects, refer to the “Applying 
Filters” section of this chapter. For a visual glossary of available filters, refer to the 
“Effects Listing” in the VideoShop Reference Guide.

Removing Filter and Transition Ef fects
To delete an ef fect:
Make sure you are in time view.

1. Click the blue bar over the affected frames. 

2. When the bar has been selected and displays moving diagonal lines, press 
Delete. 

The filter is removed.
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Caution:  When the blue bar is deleted, only the most recently applied effect is 
removed.

Click the blue

bar and press

Delete to

remove an

ef fect.
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Chapter 8

 

Adding Titles to Movies

 

VideoShop has a built-in title tool. With it, you can create titles and captions, scroll 
them across the screen, change their features, anti-alias, and add drop shadows to 
them. Advanced features allow you to create dramatic effects with text and to save 
text as a transcript track, which can be useful in movies created for CD-ROM 
publishing.

This chapter covers the following topics:

• Creating a title

• Editing a title

• Inserting the title into the sequencer

• Changing the timing of a title

• Changing the duration of a title

• Editing a title in the sequencer

• Creating a dynamic title

• Positioning a title in the canvas window

• Anti-aliasing titles 

• Scrolling titles

• Defining a scroll region

• Defining a language

• Adding drop shadows to titles

 

 

This document was created with FrameMaker 4.0.4
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Creating a Title

 

When a sequencer first opens, it does not have a title track. To add titles to your 
movie, first add a title track, select the frames over which you want the title to 
appear, open the titling window, and then enter your text and define its style.

 

To add a title track:

 

n

 

Click the Add Track button on the top of the sequencer and choose Title 
Track from the pop-up menu.

 

or

 

Choose 

 

Title Track 

 

from the 

 

Add Track

 

 submenu of the 

 

Sequence

 

 menu.

A title track appears at the top of the sequencer. As always, you can rearrange the 
layering of any track by grabbing the track handle on the left side of a track and 
dragging it up or down to the new position. 

Titling window
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Titles usually appear as foreground over video. The title track needs to be higher in 
the sequencer window than the video track to display the title over the video. If a 
title it to appear behind video (through a window in the video, for example), the 
title track must be lower in the layering order than the video track.

 

To open the titling window:

 

If you do not have a title track in your sequencer, add a title track.

Make sure you are in time view by clicking the Storyboard/Time View button. 

 

1.

 

In the title track, select an area for the title.

As you select, the underlying video appears in the canvas window, the 
selection portion of the info palette displays information about the frames you 
have chosen for the title.

 

2.

 

Click the 

 

Text

 

 tool.

 

or

 

From the 

 

Window

 

 menu, choose 

 

Titling 

 

(

 

E

 

-E). 

Text box
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The titling window is displayed. Titles are typed into the text box of this 
window (the area designated by a dotted line). The frame currently displayed in 
the canvas window also appears in the titling window.

 

To create a title:

 

1.

 

Position the Selection tool in the text box (the box located at the top of the 
window) of the titling window. 

The Selection tool turns into an 

 

Edit Text

 

 tool.

The Selection tool turns into a Hand tool when it is inside the text box. 
By clicking and dragging with the Hand tool, you can position the text box 
anywhere in the titling window. 

 

2.

 

Type in your text.

 

Important:  

 

If the text is too wide for the titling window, the text wraps around and 
the text box adds a new line. You can resize the text box from lower right 
corner when the Edit Text

 

 

 

tool is selected.

If your title does not need editing, your next step is to incorporate the title into 
your movie. Refer to the “Inserting the title into the sequencer” section of this 
chapter for instructions.
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Editing a Title

 

There are many ways to modify your title while you are in the titling window. You 
can change the font, font size, color, alignment, and other attributes. VideoShop 
supports TrueType fonts. If Adobe Type Manager (ATM) is installed, VideoShop 
supports PostScript Type 1 fonts. 

 

To select a font:

 

1.

 

With the Edit Text

 

 

 

tool, select the portion of your title that you want to 
modify.

 

2.

 

Click the 

 

Font 

 

button to choose from a list of available fonts

 

or

 

n

 

Choose a font from the 

 

Font

 

 submenu of the 

 

Title

 

 menu.

VideoShop remembers the last font you selected for the text; the next title you add 
is automatically the same font.

 

To change point size:

 

1.

 

Select (by clicking and dragging) the portion of the title you want to resize.

 

2.

 

Click the 

 

Font Size 

 

button and select a new point size.

 

or

 

n

 

Choose a point size from the 

 

Size

 

 submenu of the 

 

Title

 

 menu.

VideoShop remembers the last font size you selected for the text; the next title you 
add is automatically the same font size.

 

Important:  

 

In addition to the font size increments (such as those available in any 
word processing program), VideoShop lets you adjust the size of your title with 
much greater precision through the options 

 

Smaller

 

 and 

 

Larger

 

. Each 
selection of these decreases or increases, respectively, the size of the title by a single 
point. The 

 

Other

 

 option brings up a dialog box in which you can type in a precise 
point size.

Only those point sizes available on your Macintosh are available in VideoShop; 
all point sizes are not available on every configuration.
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To change the style of a title: 

 

1.

 

Select the text that you want to change.

 

2.

 

Click the appropriate icon(s) at the top of the titling window. 

 

or

 

Choose a style from the 

 

Style

 

 submenu of the 

 

Title

 

 menu.

 

To set the alignment of a title:

 

Click either the 

 

Center

 

 button, the 

 

Left Justify

 

 button, or the 

 

Right Justify

 

 
button.

 

To add color to a title:

 

1.

 

Select (click and drag) the part of the title to which you want to apply color.

 

2.

 

Click the 

 

Color Wheel

 

 button to bring up the color wheel.

 

3.

 

Select a color.

 

4.

 

Click 

 

OK

 

, or press 

 

Return

 

.

VideoShop remembers the last color you selected for the text; the next title 
you add is automatically the same color.

 

Inserting the Title into the Sequencer

 

Once you have added all the desired type specifications to your title, you can insert 
the title into the sequencer in three ways:

• Insert the title for a selected duration

• Insert the title at a specific point and for a standardized duration

• Drag and drop the title into the sequencer, and reposition it later

 

To insert the title into a selection in the sequencer:

 

1.

 

Make a selection in the title track where you want the title to appear. 

The duration of the selection is displayed in the selection readout in the info 
palette. To view the background video as you select, watch the canvas 
window.
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2.

 

Click the 

 

Insert Text 

 

button in the upper right of the titling window.

 

To insert the title at a particular point in the sequencer:

 

1.

 

Click in a title track to set an insertion point. 

 

2.

 

Click the Insert Text button on the upper right of the titling window.

The beginning of your title is inserted at that point. It continues for a default of 
5 seconds.

Select a region

in which to

insert the title.

The title will be
inserted at the
insertion point.
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To insert the title by dragging it into the sequencer:

 

1.

 

In the titling window, select the Selection tool.

 

2.

 

Position the Selection tool over the text box. 

The Selection tool turns into the Hand tool. 

 

3.

 

With the Hand tool, click and drag the title from the titling window into a title 
track of the sequencer.
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To automatically close the titling window:

 

n

 

Select 

 

Auto Close Window

 

 from the 

 

Title

 

 menu.

After this option is selected, each time text is inserted into the sequencer with 
the Insert Text button (or by pressing 

 

E

 

-J or by selecting the 

 

Insert into 
Sequencer

 

 command from the 

 

Title

 

 menu), the titling window automatically 
closes.

 

Changing the Timing of a Title

 

Once a title has been inserted into the title track, you can move it to another point 
in time using the same procedure as moving video or audio clips.

 

To slide a title:

 

1.

 

Position the Selection

 

 

 

tool at the orange slide bar at the bottom of the text clip 
in the title track.

The Selection

 

 

 

tool changes to the Hand tool.

 

2. Click to grab the clip.

3. Slide the clip to any new location. 

If, when you slide the clip to the right, it butts up against another clip, it will 
halt the slide. To push both clips, continue to push. Both clips slide to the 
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right.

Changing the Duration of a Title
Titles are cut, copied, and pasted the same as video or sound clips. Select an area to 
cut or copy, then make the appropriate selection from the Edit menu. 

You can also trim title clips in the same as other clips. Once you have created a title 
and placed it in the sequencer, you may want to make the title longer or shorter. To 
shorten the title, select and cut, or trim the end just as you would a video clip. To 
extend the duration, use the Stretch tool or the Scale Selection command.

Grab and slide the
title to a new
location.
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To stretch a title:
1. Select the Stretch tool.

2. Click on the end of the title clip and stretch to extend the duration.

To change the duration of a clip:
1. In time view, drag the Selection tool to select all the frames of a clip in a single 

track, or double-click the clip to select the entire clip.

2. Choose Scale Selection from the Edit menu.

This displays a dialog box with several fields that relate to the duration of the 
selected frames. You can change any one of these fields. The dialog box allows 
a new duration to be entered in seconds, in ticks, or as a percentage of the 
original selection duration.

Use the stretch
tool to change 
the duration of
a title.
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Movie Ticks. Displays the number of ticks in the selected frames. A tick is a time 
unit. For example, a movie created at 30 frames per second is on a 30 tick time 
scale, a 25 frame per second movie has a 25 tick time scale.

Seconds. Displays the number of seconds in the selected frames.

x Scale. Displays the scale of the selection in relation to its original duration. Until 
you change it, it remains at 1.00 (100%). 

3. Enter a new duration for the selected frames in one of the three fields. 

4. Click OK in the dialog box, or press Return.

The selection is edited to the specific duration. It’s relationship to frames 
before and after the selection is unchanged; for example, blank time before and 
after remains in place. 

Note that if you select only a portion of a clip, the selected frames become a 
clip, with beginning and ending trim handles and a dog-eared transition point.

To trim a title:
1. Position the Selection tool at the trim handle at the end of the clip until you 

see the Trim tool.

2. Trim the title to the desired duration.

Important:  The material you trim is not deleted; it is merely hidden. You can untrim 
it at a later date. 
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Caution:  You cannot use the Trim Dialog on titles.

Editing a Title in the Sequencer
Once you have created a title and dropped it into the sequencer, you can still freely 
edit it. To edit a title, you need to send it back to the titling window, where your 
text editing tools are located. You do this by selecting the portion of text that you 
want to edit, and then opening the titling window.

To edit a title:
1. Select the title clip to edit. 

To select an entire title clip, double-click in the sequencer. To select a part of a 
clip, click and drag.

The selection readout in the info palette displays information about your 
selection.

You can also select and edit separate sections of a text clip.

2. Click the Text tool on the sequencer toolstrip to send the title from the 
sequencer back to the titling window.

The titling window becomes the active window.

3. Edit any or all of the text in the title box by dragging the Edit Text tool to 
highlight it, then applying any changes of color, font, scrolling, and so on.

4. Click the Insert Text button to update the title in the sequencer.

Creating a Dynamic Title
So far you have learned how to edit the characteristics of a title clip. With 
VideoShop you can also change the characteristics of a title over time. For example, 
the a title may be blue for two seconds, then green for two seconds, and then 
underlined for three seconds. You do this by selecting and editing successive 
portions of a single title clip.
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To change title characteristics over time:
1. Select a portion of a title clip in the sequencer.

Caution:  Changes are made to the title only for the selected duration.

2. Click the Text tool to open the titling window.

3. Change the characteristics of the title (font, style, size, color).

4. Click the Insert Text button.

5. Repeat for other parts of the title.

For information on adding drop shadows to titles, see “Adding Drop Shadows 
to Titles” later in this chapter. For information on applying filters to titles, 
see Chapter 7.

Positioning a Title in the Canvas Window
Once titles have been positioned temporally in the sequencer, you can position 
them spatially in the canvas window. Text is positioned and resized the same as 
video or graphics, with the bounding box. For more information on the bounding 
box, refer to Chapter 3.

To position a title:
1. Create a title in the titling window and insert it into the sequencer.

Make sure the playout point is over the title clip.

2. Select the title in the canvas window and move it to the desired position.

3. Resize the clip by dragging any edge of the bounding box.

or

Use the Clip Size commands on the Canvas menu.

Important:  Titles are recognized in the canvas window as clips. They can be resized 
and moved from within the canvas window.
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Anti-Aliasing Titles
You may notice in the canvas window that the curved and diagonal edges of your 
titles are jagged. This is known as aliasing. VideoShop smooths out the aliasing or 
anti-alias the titles when you click the Anti-Alias button in the canvas 
window, or select High Quality from the Canvas menu. Although the High 
Quality (Anti-Alias) command improves the look of your text in the canvas 
window, it slows down the performance during playback until you mixdown the 
movie or the selection. (Refer to Chapter 9 for information about mixdown.) 
When you save and mixdown the movie, VideoShop automatically anti-aliases all 
text. The Anti-Alias setting affects the entire movie, not just the selected text clip.

To anti-alias titles:
1. Add a title to a title track in your sequencer.

Be sure the playout point is over the title clip.

2. Select the title in the canvas window.

3. Click the Anti-Alias button.

or

Choose High Quality from the Canvas menu.

Important:  If you are not using a 16-bit or 32-bit monitor, use the Anti-Alias button 
to improve the quality of both titles and video.

Scrolling Titles
VideoShop provides the ability to scroll text in and out of your movie. This is 
accomplished either by using the path editor on each title clip, or by selecting a 
scrolling option in the titling window. 

You have the option to scroll your title into frame, out of frame, or through the 
frame. You can also choose the scroll direction (left, right, bottom, or top).

To scroll a title in your movie:
1. Choose In, Out, or Through from the Scroll pop-up menu on the titling 

window.
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A grow-box and scroll bar appear on the text box to allow you to resize the 
scroll region. 

2. Choose scroll direction from the Direction pop-up menu.

You must define how the text wraps while in the titling window. The height 
and width of the scroll region (described in the next section) determine how 
much text is in view in the canvas window.

Defining a Scroll Region
When using automatic scrolling in VideoShop, you can define the region in which 
the text scrolls. For example, you may want text to scroll through the entire frame, 
beginning off screen above and ending off screen below. In another case, you might 
want only one line of text at a time to scroll through a small region of the frame. 
Define this by resizing and positioning the scroll region.

To define a scroll region:
1. Type a title in the titling window.

or 

Select a title in the sequencer, and open the titling window by clicking the Text 
tool.

Scroll

type

Scroll direction

Scroll region
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2. Select scrolling direction.

3. Select a font and font size from the menus (or inherit the font and font 
attributes from the previous title).

4. Select the Edit Text tool in the titling window and resize the scroll region using 
the grow box in the lower right hand corner.

Caution:  In the canvas window you can only resize the text. In the titling window, 
you can only resize the text scroll region.

Defining a Language
With VideoShop, you can add multiple title tracks to a sequencer and define 
different languages for them; for each language you add, a different title track needs 
to be created. Once saved, a movie can then be played in any one of the defined 
languages.

To define a language:
Make sure your title track is not collapsed.

1. Add a title to your sequencer.
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2. Click at the indicator at the base of the track’s icon at the left of the track.

The Text Track Settings dialog box opens.

3. Check the Track Language checkbox.

The Languages submenu is activated.

4. Choose a language from the Languages submenu.

5. Click OK, or press Return.

To select a language on opening a movie:
The movie must have been saved with title tracks of different languages.

1. Double-click to open the movie.

2. Choose the desired language from the Languages submenu of the Play menu.

3. Press the Play button on the clip window, press the Space Bar, or choose Play 
from the Play menu.

For information on creating transcript tracks, refer to Appendix E, “Tips and 
Techniques.”

Adding Drop Shadows to Titles
With VideoShop, you can apply drop shadows to titles. You can even apply various 
levels of transparency to the drop shadows. Drop shadows can be applied to both 
stationary and scrolling titles. When you add your first title to a movie, it 
automatically has a 2 X 2 pixel offset drop shadow. There are two ways to change 
the drop shadow parameters or remove them altogether.
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To alter drop shadows:
1. Select a title in the canvas window.

2. Choose Text Drop Shadow from the Canvas menu.

The Text Drop Shadow dialog box is displayed.

3. Adjust the vertical and horizontal offsets to create a drop shadow.

4. Adjust the transparency slide (or type a precise value in the setting field) to 
make the drop shadow translucent.

5. Click OK, or press Return.
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To adjust drop shadows from the Title menu:
1. Select a title in the canvas window.

2. Choose the appropriate parameters from the Drop Shadow submenu under 
the Title menu.

3. Press the Insert Text button.

The drop shadow is added to the clip. VideoShop remembers the your drop 
shadow settings; the next title you inherits these drop shadow settings.



 

Chapter 9

 

Saving Sequencers and Movies

 

Save the sequencer—VideoShop’s basic document—while you work, just as you 
would periodically save word processing or spreadsheet files in progress. 

When you finish composing a movie in VideoShop, instead of printing to paper, 
you save it as a movie which can either be printed to videotape or distributed as a 
digital file that can be read on other computers. 

Just as a word processor saves a text file that can be printed as a pamphlet, a book, 
a letter, or a movie script, VideoShop saves a movie file that can be printed to 
videotape or CD-ROM as a music video, a television commercial, a kiosk 
presentation, or a video catalog (other output options are available). The term 

 

movie

 

 is used here generically to denote any video document during or after 
production; the 

 

sequencer

 

 is the production environment, which can, and must, 
be saved, session by session, until editing is completed.

The performance and quality of the movie can be 

 

optimized

 

 through a process 
known as 

 

mixdown

 

. You can mixdown an entire movie when you save it and you 
can optimize and preview selections while still editing. 

 

 

This document was created with FrameMaker 4.0.4
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This chapter discusses saving sequencers, saving movies, optimizing selections, and 
movie mixdown, and explains the various compression and mixdown options; 
it covers the following topics:

• Saving sequencers

• Saving as a digital movie

• Mixing down for smoother playback

• Optimizing while editing

• Optimizing a selection

• Mixing down and loss of data

• Mixing down to save a movie

• Choosing compression settings

• Other mixdown issues

• Improving movie performance before mixdown
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Saving Sequencers

 

When you first open a new sequencer, its title bar reads 

 

“Sequencer: Untitled,”

 

 and a 
number indicates the number of new sequencers opened in the present work 
session. Since each sequencer is associated with a canvas, the canvas window shares 
the same name and number as its sequencer window. 

You must save your sequencer, the production environment, with its tracks and 
editing tools, until you are completely done editing. Once you save your work as a 
movie (unless you also save the sequencer) you lose the ability to edit. A completed 
movie is like any other self contained video clip: you can drop it into a sequencer 
and include it in other movies. It is recommended that you to save multiple versions 
of the sequencer as you edit.

After opening a new sequencer and dropping video and audio clips into the 
sequencer tracks, name and save the sequencer. 

SET 1
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To save a sequencer:

 

1.

 

Choose 

 

Save 

 

from the 

 

File

 

 menu.

This opens the familiar Macintosh Save File dialog box. Use the file directory 
to select a particular folder.

 

2.

 

Type a name for the sequence. 

 

3.

 

Click 

 

Save

 

, or press 

 

Return

 

. 

This saves your work to the hard disk. From now on, as you construct your 
movie, choose 

 

Save 

 

frequently (or simply press 

 

E

 

- S) whenever you make 
substantial changes to the sequence. You may want to use 

 

Save As

 

 from time to 
time to update previously saved sequencers. As long as your work is saved as a 
sequencer, it can be re-opened and edited. Save your sequencer as a movie 
only when you are finished editing or want to optimize the playback. The 
sequencer appears with its VideoShop icon in the folder in which it was saved.

 

Saving Multiple Versions of the Sequencer 

 

You may want to save multiple versions of the same project under different names. 
This allows you to experiment with different versions or save incremental versions 
of a project. You can then return to an earlier version if you don’t like your later 
work.

 

Important:  

 

The 

 

Save As

 

 command is available only when the sequencer has 
previously been saved.
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To save a sequencer under a dif ferent name:

 

1.

 

 Choose 

 

Save As

 

 from the 

 

File

 

 menu.

 

2.

 

 Type a new name, and select the appropriate folder.

 

3.

 

 Click 

 

OK

 

, or press 

 

Return

 

. 

 

More about Sequencers

 

A sequencer is not a self contained QuickTime movie file that can be distributed. It 
is strictly a VideoShop document—a collection of tracks containing edited clips that 
can be opened only by VideoShop.

The audio and video clips in the sequencer are actually only references, pointers, to 
the audio and video files on disk. As edits are made in the sequencer, these 
references to the audio or video files are altered accordingly. Saving the sequencer 
saves these references and their references to each other.

When a sequencer is re-opened, VideoShop must locate the referenced audio and 
video files and re-sequence them. For this reason, you cannot freely distribute a 
sequencer file without including all the original audio and video files that were 
used in its creation—the sequencer will not be able to display its clips. 

If you delete files used in a sequencer from your disk between sessions, the 
sequencer will not be able to display the clips. (Restoring the files to your disk also 
restores them to the sequencer.)

 

Distributing a Sequencer to Another Macintosh

 

If you move a sequencer to another Macintosh or share it with another movie 
maker, be sure to include on the transport disk all the movie files used to create the 
sequencer. If you include movie titles in your sequence, the fonts used for the titles 
must also be available on the target computer. 

 

Exporting Selections as PICT, PICS, AIFF, or SND Files

 

Selections of audio clips, video frames, and titles can be saved as audio, PICT 
image, and Text files with the 

 

Export Selection

 

 command on the 

 

File

 

 menu. This 
lets you save a portion of an audio clip, a single frame, or titles and transcripts as 
separate files that can be incorporated in other movies.

See “Optimizing a Selection” in this chapter for more information.



 

190

VideoShop User’s Guide

 

Saving as a Digital Movie

 

Once you have finished all your editing and the sequence requires no further 
revision, you can save it as a standalone digital movie for distribution or inclusion in 
another application.

It is a good idea to save a movie under a different name from its sequencer, so as not 
to inadvertently write over the final sequencer. Keep the final sequencer available 
so you can re-edit a movie if necessary.

 

To save a movie:

 

Warning:  

 

Be sure to save a final copy of the project 

 

as a sequencer

 

 in case you ever 
need to re-edit the movie. 

Click anywhere in the sequencer or canvas window to make it active.

 

1.

 

Choose 

 

Save As Movie

 

 from the 

 

File

 

 menu. 

The Save As Movie dialog box opens.
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2.

 

Choose the movie format you want to create from the 

 

Format

 

 pop-up menu. 
(See “Self-Contained Movies,” “Reference Movies,” “Cross-Platform 
Format,” and “Standalone Players” later in this chapter.)

 

3.

 

Check any other options for saving the movie. (These are described in the 
section, “Options for Saving Movies” later in this chapter.)

 

4.

 

Type a name for the movie.

Use a 

 

unique

 

 name, so as not to overwrite the sequencer.

 

5.

 

Choose the appropriate folder or drive. 

 

6.

 

Click 

 

Save

 

, or press 

 

Return

 

.

The new movie is saved and stored in the designated folder.

Once you select the 

 

Save As Movie

 

 command from the 

 

File

 

 menu, a dialog box is 
displayed with three format options for saving a sequence as a movie:

• A Self-Contained Movie 

• A Reference Movie 

• A Cross-Platform Movie 

• A Standalone Player (which can be either a self-contained or reference movie)

You also have the following options:

• Add Micon to File

• Mixdown Movie

• Smart Optimize

• Player Settings
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The following sections describe each option. The option you choose depends on 
the situation for which the movie is created. Whichever you choose, remember 
that no sequencer information is included with the file—these are actual movies.

 

Caution:  

 

If you want to re-edit the movie, you must save the final sequencer.
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Self-Contained Movies

 

A self-contained movie is a QuickTime movie that can be played by VideoShop or 
any QuickTime-compatible video and non-video application. Examples of 
non-video applications that play QuickTime movies include word processing 
applications that play movies within documents, or authoring applications, such as 
HyperCard, which can include QuickTime movies in its stacks.

The self-contained movie keeps its own copies of the clips used to create it. You can 
distribute a self-contained movie to anyone who has a QuickTime-compatible 
movie application. 

Self-contained movies can have Micons assigned to them or they can display the 
generic Hand & Scissors icon.

Self-contained movie files can become quite large, even simple 3–4 minute movies 
take up 8 or 9 MB of disk space. Sufficient hard disk space is required.

 

Important:  

 

If you drop a self-contained movie into a VideoShop sequencer, 
VideoShop treats it like any other clip. This makes saving self-contained movies 
useful for people working in a group on a large project—the smaller individual 
movies can be shared as clips in the larger final movie.

 

Caution:  

 

There is no 

 

functional

 

 difference between a reference and a self-contained 
movie; they act exactly the same to the system. The only difference is that a self-
contained movie has the movie data encapsulated, and a reference movie does not.

 

Reference Movies

 

A reference movie contains references or pointers to the original video and audio 
clips, and retains all editing information for the creation of the movie. It 
contains no sequencer or clips. If the associated clips are available on the same hard 
disk, a reference movie can be played by VideoShop or any other QuickTime-
compatible application. If the associated clips are not available on the same disk, a 
reference file cannot play as a movie. 

If the associated clips are available, the movie can be played. Dropping the reference 
movie into a sequencer loads it as a single clip into the sequencer (again, only if the 
associated clips are available).
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Reference movies are much smaller than self-contained movies, taking only 30 or 
40 KB of disk space. This makes them useful for storage and playout on the same 
computer that was used to create them, where the same clips are still available. They 
can also be useful for archiving and transporting.

 

A scenario for saving as a Reference Movie 

 

Since self-contained movies contain duplicates of the clips used to make the 
movies, it only takes a few to consume 50–60 MB of disk space; you may not be 
able to archive or distribute several movies easily. However, the movie reference 
files for these same movies could take only 100 KB. By saving and archiving only 
the movie reference files, and simply keeping the original clips available on your 
computer, you can dramatically reduce the storage requirements of these movies. 

 

As long as the clips are available, the movies will play.

 

For distribution you need to save and mixdown self-contained movies, but 
archiving reference movie files makes better use of your storage space.

If VideoShop or another application attempts to open a reference movie but cannot 
find the referenced clips, screen messages will ask you to find the named clips and 
open them. If the clips are not found, the movie will not play.

 

Cross-Platform Format 

 

When this option is selected, VideoShop saves a self-contained movie in the IBM 
PC format. The movie can be played on any PC with Windows and QuickTime for 
Windows and a QuickTime-compatible movie application. 

 

Standalone Players

 

A standalone player is a movie that can be played on any Macintosh with Quick-
Time, even one that does not have a QuickTime-compatible movie application. 
Both self-contained movies and reference movies can be saved as standalone players. 
In a sense, VideoShop includes a copy of a movie application with every standalone 
player. Standalone players are very useful in situations where you want to be sure a 
movie gets played by your audience regardless of the system setup of the audience—
for example, in CD-ROM distribution.

If a 

 

self-contained movie

 

 is saved as a standalone player, you do not need to include 
anything else with the movie to distribute it—all the clips and a playout application 
are included in the file. These files can be very large even a two-minute standalone 
player or a self-contained movie can be 10 MB.
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If you save a 

 

reference movie

 

 as a standalone player, you must also include copies of 
the original clips when you distribute the movie.

 

Options for Saving Movies

 

The following is a quick synopsis of the movie options:

 

Add Micon to File

 

When this option is checked, VideoShop automatically creates a Micon with the 
new movie file. The first 30 frames of the movie are used as the animated preview. 
When this option is unchecked, the new movie receives a generic Hand & Scissors 
icon.

 

Standalone Player 

 

When this option is checked, VideoShop saves the movie in a form that can be 
played on any Macintosh, even without a QuickTime movie application. Simply 
double-clicking this file plays the movie. Unchecked, the movie is left as either a 
plain self-contained movie or a reference movie, which requires a movie application 
for playing. File sizes are often very large.

 

Player Settings 

 

This button is darkened only when 

 

Standalone Player 

 

is checked. This opens a 
dialog box with settings in which you can specify parameters for background color, 
window types, and play actions for the player.

 

Mixdown Movie 

 

This option is available only when 

 

Self-Contained Movie 

 

or 

 

Cross-Platform 
Movie 

 

is chosen. When this option is checked, the saved movie is optimized, or 
fine-tuned, for better playout performance and smaller file size. When this option is 
unchecked, the movie is saved unoptimized.

 

Mixing Down for Smoother Playback

 

Mixdown

 

 is a process that optimizes movie playout performance. There is a marked 
performance improvement with particular classes of Macintoshes with slower 
speeds and limited memory. Mixdown involves the compositing of information, 
which reduces a movie’s storage and RAM requirements by interleaving its various 
tracks. 
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Movie media can be optimized during the editing process or during the final save, 
when you save your sequencer as a movie. There are two situations when you 
should consider optimizing:

•

 

For final movie delivery

 

—Once all unoptimized sequencer tracks are ready 
to be saved as a final movie, they can be mixed down for general distribution 
and playout situations.

•

 

During the saving process

 

—When you save a movie to disk, you can mix-
down the entire movie for better playout.

Each edit in an open sequencer takes up a certain amount of memory. When you 
edit very complex movies or work on a Macintosh with little memory, playback 
may get choppy. Optimization of movie parts in progress is both practical and 
necessary.

 

Optimizing While Editing

 

When a movie has motion control, titles, multiple tracks, and transparency effects 
included, even the most powerful Macintoshes may not be able to play the 
sequence smoothly. When especially complex sections of the movie are played, 
performance may be poor—pauses may occur, or frames can be dropped. 

This is where 

 

Optimize Selection

 

 can help. Optimizing in VideoShop is a process 
in which you can control a set of movie characteristics. You can:

• Compress the movie’s data rate with an appropriate compression utility. 
Smaller movie files play more smoothly and need less storage space.

• Mixdown the tracks into one stream of media.

• Control the video color depth (the number of colors displayed by each pixel: 
8 colors, 256 colors, thousands of colors, and so on). The more colors, the 
higher the color fidelity, and the more RAM necessary. 

• Control image quality. Higher-quality video images display less visual noise 
and have better sharpness. 

• Control the movie’s frame rate (frames per second). Higher-quality video 
demands higher frame rates, which also tax a computer’s processing power. 
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By limiting the movie’s information demands in each of these areas to appropriate 
levels, you can decrease file size and improve performance. Making practical 
choices in optimizing a section of the movie helps strike a balance between movie 
quality and playback smoothness.

Optimizing a Selection
Certain effects, such as motion control, transparency, and translucency tend to hurt 
a movie’s playout performance. Choppy playback can distort your perception of a 
sequence and make it difficult to edit accurately. 

VideoShop lets you selectively and temporarily optimize segments of a sequencer 
with the Optimize Selection command on the Sequencer menu. All the video 
clips within the selection then play more smoothly.

Caution:  Editing frames that have been optimized removes the optimization.

Optimization involves a mixdown operation compressing all the visual tracks into a 
single video track. Note that successive compression optimizations on the same 
media can lead to image degradation.

To optimize a selected duration of a sequence:
1. In time view, select the duration by clicking and dragging in the time bar.

All tracks in the sequencer must be selected to optimize a portion of your 
project.

2. Choose Optimize Selection from the Sequence menu.

Editing any component of an optimized selection removes the temporary 
optimization.
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Smart Optimization
During mixdown, you can opt for Smart Optimization. Smart optimization 
recompresses only those images that need it. Movies comprised of simple cuts and 
few special effects are prime candidates for smart optimization. Movies with a lot of 
layering and compositing, motion control and titles do not necessarily benefit from 
smart optimization. During this process, any source material that matches the 
movie content exactly are simply copied. Since all images are not recompressed, 
smart optimization is faster than traditional optimization.

Mixing Down and Loss of Data
Because mixdown involves data compression and possibly reduced image 
information, a certain amount of data is always lost to the optimized movie 
(although the final sequencer will still contain the original sequence). This loss of 
data is usually not very noticeable as degraded image quality, and it is worthwhile 
for the smoother playout the movie achieves.

But a mixed down movie, if it is dropped as a clip into another VideoShop movie 
sequence and optimized again, may start to show poor image quality. It is best not to 
mixdown the same material twice. If you want to create a movie for inclusion in 
another movie, either keep the sequence simple enough to not require mixdown, 
or apply only the most limited compression settings (high-quality).

Mixing Down to Save a Movie
When you save a multi-track sequencer as a self-contained movie, mixing down 
improves the movie’s playout performance and reduces its storage requirements. 
The result is smoother playback and a smaller movie file size. 

During mixdown, multiple tracks are interleaved into one video track and one 
audio track, and video image data is compressed. By reducing the amount of overall 
data that the computer must process during playout, playout performance can be 
improved.

Additionally, by mixing down you can tune a movie to play best from a particular 
class of Macintosh or from CD-ROM. 
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To mixdown during Save As Movie:
1. When you are ready to save a sequence as a movie, choose Save As Movie 

from the File menu.

The Save File dialog box appears.

2. Check Mixdown Movie in the Save File dialog box. 

Checking Mixdown Movie activates the Video and Sound buttons. 

3. Click Video to display a Compression Settings dialog box where you can 
specify parameters for type of compression, frame rate, color depth, and other 
optimization settings. 

(These settings are described in the next section.)

4. Click Sound to display a Sound Output Options dialog box where you can 
specify parameters for rate, size, and use.

(These settings are described later in this chapter.)

5. Click OK, or press Return to apply your settings.

6. Click Save, or press Return to save your sequence as a movie.



200

VideoShop User’s Guide

Choosing Compression Settings
Once you have selected Mixdown Movie, the Video and Sound buttons become 
active. 

Video Compression Settings
Click Video to display these settings in the Compression Settings dialog box:

Compressor 
A pop-up menu appears with a list of compression utility choices. File compression 
can reduce the size of a file, the amount of data, the number of colors, and the level 
of detail. By reducing file size, and, optionally, color and resolution, compression 
improves playout performance.

The menu lists QuickTime’s built-in video compressors. Some video boards 
include additional compressors, such as for real-time compression and 
decompression. Hold down the E key and pull down the menu to see an extended 
list of compressors.

Choose a compressor from this pop-up menu. 

QuickTime movie performance is directly related to how much digital data is 
required to describe the movie. A compressed movie has less data and so is easier 
for a computer to process and play. Each compressor is best suited toward a 
particular kind of movie material (motion video, still graphics, animation). 
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Choose the compressor that best fits your movie. In cases where a movie is com-
posed of different types of media, choose the compressor that suits the majority of 
the media.

Apple Animation. Best for compressing 16-bit (thousands of colors) or 24-bit 
(millions of colors) animated or still images that are computer-generated (rather 
than recorded from analog videotape).

Apple Cinepak. Best for compressing highest quality final movies for CD-ROM 
distribution when processing time is not an issue. Saving and mixdown may take 
several hours if you use this compressor. Final file size is quite small and quality is 
very high. 

Apple Component Video. Does not compress, but streamlines data to twice the 
efficiency of raw data.

Apple Graphics. Best for compressing 8-bit (256 colors) computer-generated 
animated or still images or video recorded from an analog source to be played using 
an 8-bit display (256 colors or grays).

Apple None. Best for mixing down during the editing process.

Apple Photo-JPEG. Best for compressing movies with numerous high-
resolution (24-bit) still images.

Apple Video. Best for compressing motion video recorded from an analog 
source. The movie is stored at 16-bit color depth (thousands of colors) unless a 
24-bit compression card is installed.

One of QuickTime’s features is its plug-in architecture. As new compressor utilities 
become available—implemented either through hardware or software—they are 
accessible through VideoShop in this Compressor menu. 

Color Depth 
Each of the compression methods has its own various options for video color depth 
(the number of colors displayed by each pixel—256 colors, thousands of colors, 16 
million, and so on). Color depth is selected through the pop-up menu just below 
the Compressor pop-up menu. VideoShop automatically assigns a color depth for 
each compression method, but you can specify a different choice. Specifying a 
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lower color depth can improve playout performance; higher depths demand more 
processing power from a computer.

Quality 
This slider control determines an optimized movie’s image fidelity. The Most 
setting yields the best image quality. Bear in mind, however, that the higher the 
image quality, the larger the amount of data required to describe each movie frame, 
and hence the greater the disk storage and processing power requirements placed 
on the Macintosh.

Depending on the amount of free hard disk space, the length of the clip(s) to be 
optimized, and the power of the Macintosh, consider a Quality setting less than 
Most.

As you move and release the quality slider, the effect on image quality is displayed 
in the preview box. When deciding on a Quality setting, balance these three 
considerations:

• Image quality is lost forever as a result of mixing down a movie at a setting 
below Most.

• It is better to mixdown movies at the highest practical quality setting, as you 
can always decrease the quality later.

• The higher the image quality, the greater the processing power needed and the 
greater the hard disk space required.

Frame Per Second 
Frames per second determines the number of actual samples (frames) that are saved 
and displayed per second. This is distinguished from movie ticks (all movies are 
played at 30 ticks per second). Therefore, in a movie that is stored at 10 frames per 
second, each frame (or sample) is displayed for 3 ticks (totaling 30 ticks per second) 
when played. The additional frames are called repeat frames and are represented in 
the sequencer in time view as gray frames.
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The mixdown frame rate value (in frames per second) represents a cap on the 
sequence frame rate. Specify frame rate value by entering a value in the Frames Per 
Second field or through the pop-up menu.

Why would you want to decrease a movie’s frame rate? The higher the frame rate, 
the higher the processing power and storage space required by the computer. To 
tune a movie for optimal performance on a particular class of Macintosh or CD, or 
to decrease a movie’s storage requirement, cap the movie’s frame rate.

If you want all the clips in a sequence to retain their native frame rates (none are 
capped), use a mixdown frame rate of 0 fps.

Frame Dif ferencing 
Frame differencing minimizes the amount of data required to represent each frame 
in a movie and the processing power and storage requirements for a movie.

Unless a movie contains an extreme amount of motion, there is a fair amount of 
redundancy from one movie frame to the next. Rather than storing all the data for 
each individual frame, frame differencing stores only the changes from one frame to 
the next.

Key Frame Rate 
Frame differencing is done by splitting the movie into chunks. Using the first frame 
of the chunk as the starting point, every other frame in the chunk is then compared 
to its previous frame—only the differences are saved. When the movie is played out, 
VideoShop rebuilds each frame.

The first frame of a chunk is called the key frame. The key frame rate specifies the 
number of frames from one key frame to the next. 



204

VideoShop User’s Guide

Why not have only one key frame, in an effort to minimize disk storage and 
processing requirements? The problem with this approach is that as the number of 
key frames decreases, random accessibility of any individual frame is sacrificed. 
Broadly spaced key frames produce satisfactory results only if the movie being 
optimized is meant primarily for linear playback.

When deciding on a key frame rate, you should bear in mind that if QuickTime 
begins to fall behind in its audio/video synchronization during playout, it will 
freeze a key frame until it reaches the next key frame. Extremely long intervals 
between key frames can result in choppy playout under low-memory conditions or 
on slower Macintoshes. You generally want as high a key frame rate (as low a 
number) as is practical.

Sound Output Options
Once you have selected Mixdown Movie, the Video and Sound buttons become 
active. Click Sound to display these settings in the Sound Output Options dialog 
box:

Rate
The rate at which sound samples are compressed relates to the fidelity of the sound 
produced. Higher fidelity settings produce better quality digital audio. Higher 
sound fidelity, however, requires greater processing power and hard disk space. The 
default rate setting is 22.050 kHz. Additional rates supported by your hardware 
(compression boards) appear here. The following settings are offered by the Apple 
Sound Manager:

• 22.050 kHz

• 44.100 kHz

• 11.025 kHz
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Size
Choose 8-bit or 16-bit as digital sample resolution. 16-bit sound produces better 
quality audio. The size relates to how fast your Macintosh can handle the audio 
information. Take the processing power of your Macintosh into account when 
selecting a compression size.

Use
Choose Mono or Stereo. Stereo allows two channel audio to be handled, but 
demands greater processing power from your Macintosh. To play, record, and 
compress stereo sound, you need a Macintosh or hardware with stereo-out 
capabilities. 

Considering Other Mixdown Issues
Here are some other factors you should consider during mixdown:

• Image quality degrades when optimized and when any compression method 
other than Apple None or Apple Component Video is used (even with a 
Quality setting of Most). In many cases, the degradation is not noticeable, 
particularly if the movie dimensions are kept small. 

• The mixdown process temporarily requires twice the hard disk space of the 
final (optimized) standalone movie. If this space is not available on your hard 
disk, mixdown cannot take place.

• After mixdown, the height and width of a movie with multiple video tracks are 
determined by the height and width of the bounding box that bounds all the 
video clips displayed in the movie’s playout window. If the resulting movie has 
a larger screen area than its individual clips, it requires greater processing 
power.

In this instance, you can achieve better performance by optimizing video tracks 
individually and saving the composite movie without mixdown. If such a 
movie is mixed down, frame differencing with a high key frame rate should 
help improve performance, as the redundant data from the bounding rectangle 
is not saved or redrawn.
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Improving Movie Performance before
Mixdown
Mixdown is not the only way to improve movie performance. There are a few tips 
to keep in mind which make for smoother playout from the start of a project. 

• Audio sampling rate and stereo versus mono sound. The higher the sampling 
rate when the audio is captured and digitized, the greater the processing power 
required to play the audio. Stereo audio also requires greater processing power 
than mono audio. Choosing a lower sampling rate and mono makes for 
smoother playback, particularly on less powerful Macintoshes.

• Movie dimensions (height x width, in pixels).The larger the pixel area, the 
greater the processing power required to play the movie. Increasing the size of 
the movie in the playout window makes larger demands on your computer. 
Keep clip size as small as possible for editing purposes.

• Avoid disk fragmentation it cripples movie playout. To optimize your hard 
disk’s performance, use a disk defragmentation utility.

• Use a fast hard disk.

• Saving a standalone movie without mixdown interleaves audio and video data, 
providing better and smoother playback performance.

Other factors that affect performance include the following:

• Video frame rate.

• Key frame rate. A high key frame rate improves performance to a point by 
reducing overall data rate. But if the CPU cannot keep up, it will suddenly play 
very poorly, as it will have to skip to key frames to play.

• CPU.



 

Chapter 10

 

Videotape Production

 

Just as desktop publishing has revolutionized the publishing industry, desktop video 
is revolutionizing the video industry and expanding its use to new and exciting 
markets. Making videotapes is no longer only for video professionals. Graphic 
artists, independent producers, corporate trainers, and home hobbyists are catching 
on to desktop video.

Earlier chapters explained how to create, edit, and save your movie. This chapter 
covers what you need to know to put your movie on videotape or CD-ROM. 

You can print a sequencer or a finished movie to videotape for distribution. You do 
not have to print the entire movie; you can specify the times of the starting and end 
points of any portion of a movie to tape only that portion. 

Printing a movie simply means recording onto videotape what you see on the 
screen. So if the movie fills up only a quarter of the screen when you play it, it will 
also fill up only a quarter of the screen after you have printed or recorded it to tape.

When printing, VideoShop allocates all of the processing power of the computer to 
achieve the best performance for the taped movie. For best results, close any 
unnecessary applications and utilities on your computer. You can also improve 
performance by turning off file sharing and network access, including mail services.

By printing an open sequencer, you bypass the time-consuming process of first 
saving a sequencer as a movie. But if playback quality is poor when you preview 
the movie, playback will also be poor on the videotape. You may get better quality 
playback if you save the sequence as a movie and mixdown before printing to 
videotape. Refer to Chapter 9 for information on mixing down your movie.

 

 

This document was created with FrameMaker 4.0.4
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This chapter covers the following topics necessary for distributing movies:

• Video capture and compression boards

• Hardware for videotape production

• Using print-to-video

• Video signals

• Digital delivery

• CD-ROM publishing 
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Video Capture and Compression Boards

 

To use VideoShop for full screen videotape production, you need a compression 
board. A normal Macintosh computer is not powerful enough to capture or draw 
30 frames of video every second. Therefore, a special card is required to compress 
and decompress the video and allow full screen 30 fps editing and playback.

 

Videotape Production Solution

 

The following table lists recommended software and hardware for producing 
videotapes.

 

Software

 

VideoShop 3.0
Disk defragmentation software
3D Graphics package
Plug-in filters
Clip media
Paint package

 

CPU hardware

 

Mac AV or Quadra
20 MB RAM
Compression card
Encoder/scan converter

 

Peripherals

 

CD-ROM Drive
8mm videotape deck
S-VHS videotape deck
NTSC Monitor
2 GB hard drive or disk array
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VideoShop Configuration

 

The following table lists recommended settings in VideoShop for videotape 
production.

 

Hardware for Videotape Production

 

Recording a finished movie or sequence (printing the movie) from your 
Macintosh onto videotape requires the following equipment:

• A video capture and compression board

• A video-out board in your Macintosh

• An encoder device to produce the correct video formatted signal

• A connected videotape recorder/player 

 

Recording

 

640 x 480 with hardware compression
30 fps (or 60 fields per second)
24-bit color

 

Editing

 

640 x 480 canvas size
Zoom to 25%

 

Special
features

 

Canvas window for compositing
Canvas zoom to fit on monitor
Automatic scrolling credits
Organize scenes by folder
Plug-in backgrounds
Special effects

 

Saving

 

640 x 480
Mixdown movie
Hardware compression
30 fps

 

Delivery

 

Print-to-video
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Video-Out Boards

 

To print to videotape, the digital data from the computer must be converted to 
analog data. The device that makes the conversion is called a video-out board, and 
is installed in one of the expansion or NuBus slots in your Macintosh. There are 
many components to a video-out board, so be sure that you ask your dealer if your 
board can print to videotape. 

The newer Macintosh AV models have built-in video-out capabilities. There are 
also external devices that convert computer screen images to output that can be 
recorded on tape.

Many video digitizing boards (which convert analog video camera frames into 
digital frames) have built-in video-out capabilities. You can save the price of a new 
video-out board if you purchase such a digitizing board. 

 

Encoder Devices

 

Producing the correct video signal requires an encoder hardware device connected 
to both your Macintosh and the recording device. (Some video-out boards also 
include encoder features.) This is a crucial piece of equipment—the quality of this 
device makes a significant difference in the quality of the final videotape. 

See the encoder’s user manual for instructions on connecting and operating the 
device. 

 

Using Print-to-Video

 

Print-to-video

 

 blacks out your screen and uses all the computer’s power to play 
your movie. Use 

 

print-to-video

 

 when you are ready to print a videotape or 
demonstrate your complete movie on screen.

You can preview open sequences and finished movies in folders with the same 
method. Basically, this kind of previewing involves printing the sequence to 
video—to your monitor, in this case. The process is similar to printing a movie to 
videotape, but does not require any videotape recording hardware. 
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To preview with print-to-video:

 

1.

 

If you are previewing an open sequencer, click the sequencer to make sure it is 
active. 

 

or

 

If you are previewing a sequencer or finished movie while it is stored in a 
desktop window, select the icon or Micon. You can select multiple movie files 
by pressing the 

 

Shift

 

 key and clicking each file.

 

2.

 

Choose 

 

Print To Video

 

 from the 

 

File

 

 menu or press 

 

E

 

-P.

In either case, VideoShop displays the 

 

Print To Video

 

 dialog box, in which 
you can specify how to playback your movie on your monitor. 

 

3.

 

In the dialog box, type in the starting time of the first frame

 

 

 

(

 

From:

 

) you want 
to print.

The default starting time is 00:00:00, the beginning of the movie. Entering a 
starting time later in the sequence lets you preview a portion of the sequence 
to tape. Leave this setting as it is if you want to play the entire movie.

 

4.

 

Type in the ending time of the last frame (

 

To:

 

) you want to print.

The default ending time is the last frame of the movie.
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5.

 

Select the other parameters that affect previewing a movie:

• In the area labeled 

 

Playback screen, 

 

click to select the appropriate 
monitor for viewing the movie, if more than one monitor is connected to 
your Macintosh. The monitor selection determines the selection of the 
correct video-out board in your Macintosh. The left-right orientation of 
the monitors in the 

 

Playback Screen

 

 area is determined by the 

 

Monitors

 

 
file with the Apple menu’s 

 

Control Panels 

 

command. 

• Check 

 

Delay Before Printing

 

 if you want to delay the preview by ten 
seconds. VideoShop displays the ten-second countdown after you click 

 

OK

 

. (This delay is useful primarily for printing to videotape.)

• Check 

 

Center Movie

 

 when you want the movie positioned in the center 
of the screen. Otherwise, the movie is positioned at the last location of the 
Selection tool before you initiate printing.

• Check 

 

Loop Playout

 

 when you want the movie to play in a continuous 
cycle. At the end of playback, the movie immediately begins playback 
again from its starting point in a constant loop. 

• Choose 

 

Original Size

 

 or 

 

2x

 

 or 

 

4x

 

 from the pop-up menu that controls 
movie dimensions. (Note that a larger size can degrade playback 
performance on some Macintoshes.)

• Click 

 

Background Color

 

 to display the Macintosh color wheel, where 
you can select a color for the playback screen. If unchecked, the color 
defaults to the background color you chose in the playout window.

 

6.

 

In the dialog box, click 

 

OK

 

.

VideoShop closes the dialog box and prints the movie to the selected monitor. 
The movie plays on the monitor as a preview.
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To print-to-video from the desktop:

 

1.

 

Click a clip icon to select it in a desktop window.

 

2.

 

Choose 

 

Print to Video

 

 from the 

 

File 

 

menu, or press 

 

E

 

- P.

Set the parameters in the Print to Video dialog box.

 

3.

 

Click 

 

OK

 

, or press 

 

Return

 

.

 

To stop playback and return to VideoShop:

 

n

 

Click the mouse button once.

 

To pause and restart playback without returning to VideoShop:

 

n

 

Press the 

 

Space Bar

 

, just as you would to control playback in the canvas 
window. You can also use the arrow keys on the keyboard to step through 
the movie.

 

Video Signals

 

To print to a videotape, you must produce an NTSC (or PAL or SECAM) video 
signal. Videotape recorded in one format cannot be viewed on a videotape player or 
monitor of a different format. NTSC is the standard used in North America and 
Japan. PAL is the most prevalent standard in Europe. In France, both SECAM and 
PAL are used. 

 

Digital Delivery

 

You can distribute a finished QuickTime movie saved by VideoShop for play on 
Macintosh and non-Macintosh platform computers simply by transferring the 
movie to other storage devices. The transfer is performed by duplicating the movie 
onto hard disk cartridges, CD-ROMs, or other portable storage media.

VideoShop saves movies in the QuickTime format, so any application that can play 
or import a QuickTime movie can include a movie from VideoShop. You can add a 
movie to a word processing or database document, for example, to demonstrate a 
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subject described in the text. VideoShop does not have to be present for the movie 
to play in the document. Consult your application user manual for information on 
including QuickTime movies.

 

CD-ROM Publishing

 

As electronic publishing is becoming commonplace, CD-ROM distribution is 
becoming popular. Now, digital movies can be included in CD-ROM publications 
and played on Macintosh and Windows machines. Many magazine publications, 
reference book publishers, and courseware developers are turning to desktop video 
to help them enter the field of digital video publishing.

 

What You Need to Create a CD-ROM Movie

 

The CD-ROM, by virtue of its extremely large capacity (over 600 MB) and low 
per-unit cost (about that of a floppy disk), is currently the most practical and 
cost-effective medium for archiving and distributing QuickTime movies. 

Authoring CD playable movies, however, presents some special challenges. 
Specifically, the performance (data transfer rate and seek time) of currently available 
CD-ROM units does not approach that of even a modest hard disk.

Therefore, you need to take special care when making CD playable movies:

• Avoid file fragmentation; it cripples movie playback. 

• Mixdown is a must.

 

To mixdown your movie for CD-ROM playback:

 

1.

 

Choose 

 

Save as Movie

 

 from the 

 

File

 

 menu. 

This displays the Compression Settings dialog box. 

For parameters for satisfactory CD-ROM playback of a movie, see the listing 
later in this section

 

.

 

 Set the 

 

Limit Data Rate

 

 parameter. Choose 

 

Mixdown

 

 

 

Movie 

 

from the Save Movie dialog box to display the Compression Settings 
dialog box. 

The default data rate setting is 90 KB per second. This setting is suitable for 
CD-ROM drives with a transfer rate of 150 KB per second. To accommodate 
newer CD-ROM drives, which have a transfer rate of 300 KB per second, set 

 

Limit Data Rate

 

 to 150 KB per second. 

 

Apple Compact Video Compressor

 

 is 
the best choice for compressing media to be transferred to a CD-ROM.
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CD-ROM Production Solution

 

The following table lists recommended software and hardware for producing 
CD-ROMs.

 

VideoShop Configuration

 

The following table lists recommended VideoShop settings for producing 
CD-ROMs.

 

Software

 

VideoShop 2.0
Authoring software (Director, Apple Media Kit, Hyper-
Card
Disk defragmentation software

 

CPU hardware

 

Mac AV or Quadra
20 MB RAM
Compression card

 

Peripherals

 

CD-ROM drive
CD-ROM recorder
2 GB hard drive or disk array

 

Recording

 

320 x 240 with hardware compression
30 fps
24 bit color
8-bit 22 kHz audio

 

Editing

 

320 x 240 canvas size
Zoom to 50% (if one monitor)

 

Special features

 

Multiple language tracks
Transcript tracks
Limited data rate save
Standalone player
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Saving For all Macintoshes:
320 x 240
Mixdown movie
Cinepak
10 fps
20 keyframe
data transfer rate of 200 KB
For Quadras with double speed CD-ROM:
15 fps
20 keyframe
data transfer rate of 200 KB

Delivery CD-ROM
Hard disk
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Chapter 11

 

Capturing Video and Audio

 

VideoShop lets you capture audio and video from VCRs, camcorders, audio tape 
decks, and other devices for use in your movie. 

Using a variety of off-the-shelf hardware products, you can digitize audio and video 
from any source directly to your hard disk.

The following discussions assume that appropriate hardware is installed on your 
Macintosh:

• Understanding the recording process

• Designating the recording folder

• Using the recording window

• Adjusting video parameters

• Adjusting audio parameters

• Recording scenarios

• Selecting digitizing hardware

 

 

This document was created with FrameMaker 4.0.4
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Understanding the Recording Process

 

The following table provides an overview of the steps for recording and tells where 
to find the detailed instructions. 

 

Description Where to Get Information

 

1. Check to make sure you have a
digitizing board and its software installed on

your Macintosh

 

—

 

generally you need a VDIG
(Video Digitizing Component) to digitize and

a CODEC (Compression/decompression
component) if you have a compression card.

These belong in your System folder.

“Selecting Digitizing Hard-
ware” section of this chapter.

2. Connect the device from which you want to
record

 

—

 

VCR, camcorder, laser disk.
Documentation for your digi-
tizing board.

3. Define a recording folder. “Designating the Recording 
Folder” section in this chapter.

4. Choose 

 

Movie Recording

 

 from the 

 

Win-
dows

 

 menu.
“Using the Recording Win-
dow” section in this chapter.

5. Adjust video and audio settings

 

—

 

choose

 

Video On/Off

 

 or 

 

Sound On/Off

 

 from the

 

Recording

 

 menu.

“Adjusting Video Parameters” 
and “Adjusting Audio Parame-
ters”
sections in this chapter.

6. Turn on the device from which you are
recording.

Documentation for the device.

7. Test the connection by pressingthe Play or
Record button.

Not applicable.

Start recording. “Adjusting Video Parameters” 
and “Adjusting Audio Parame-
ters” 
sections in this chapter.
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Important:  

 

Before recording, make sure you understand this process. You must 
adjust settings in the correct order. 

 

Designating the Recording Folder

 

When you record, you create new video and audio clips on your hard drive. Before 
recording, you need to select a folder to hold these newly created clips. 

The VideoShop installer creates a default folder called “Recording Folder.” You can 
select any folder on your hard disk to be the recording folder—but you can have 
only one recording folder at a time.

 

To designate a folder as the recording folder:

 

1.

 

Select the folder where newly recorded clips should be placed.

 

2.

 

Choose 

 

Assign Recording Folder

 

 from the 

 

Desktop

 

 menu.

An arrow over the folder indicates that it is the recording folder.

 

Important:  

 

You can select any folder on any volume to designate as your recording 
folder.

 

Close the recording window. Not applicable.

 

Description Where to Get Information
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Using the Recording Window

 

VideoShop’s recording window is where you start, stop, and control the recording 
process. When the recording window is displayed, a 

 

Recording 

 

menu appears on 
the menu bar. The Recording

 

 

 

menu contains commands for specifying recording 
parameters and settings.

 

To open the recording window:

 

n

 

Choose Recording from the 

 

Windows

 

 menu.

folder

Record/Stop

Still Frame

Image

Recording 
dimensions

settings

Video preview

Recording space
progress bar

Recording

Volume
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VideoShop opens the recording window and displays the Recording menu on 
the menu bar.

 

To change the size of the recording preview window:

 

n

 

Choose the appropriate size from the 

 

Video Preview Size

 

 submenu of the 
Recording menu.

 

or

 

1.

 

Position the Selection tool in the lower right corner of the recording window 
crop region.

The Selection tool changes to a Double Arrow tool.

 

2.

 

Drag the Double Arrow tool to resize the window. 

The new recording dimensions are indicated on the right side of the recording 
window.

 

To define a crop region:

 

1.

 

Position the Selection tool inside the recording preview area. 

The Selection tool changes to a crosshair. 

 

2.

 

Click and drag to define the crop region marquee, which is constrained to the 
aspect ratio of the movie dimensions. Holding down the 

 

Option

 

 key while 
dragging creates a freeform crop marquee to any size and aspect ratio. 

Recording dimensions
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The dimensions of the crop region are displayed in the recording window.

 

Important:  

 

To see the effect of a cropped video image, turn on the recording 
device. A video image is displayed in the recording window; you can view the 
effects of cropping the image here.

 

3.

 

If necessary, move the crop region marquee by positioning the Selection tool 
inside the crop region and dragging.
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Important:  

 

To undo the crop region and return to the full size of the recording 
window, click anywhere in the crop region.

 

Caution:  

 

Do not begin recording until you have adjusted the video and audio 
parameters, as described below.

 

To change the preview volume level:

 

The volume control in the recording window lets you listen to the audio as you 
record. (To control the volume of the captured audio, use the volume control in the 
Sound Settings dialog box, as described later in this chapter.)

 

1.

 

Position the Selection tool over the audio icon in the recording window, then 
click and hold.

A 

 

volume control bar

 

 appears.

 

2.

 

Adjust the volume level using the slider in the volume control bar.
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To adjust image parameters:

 

1.

 

Click the 

 

Image Settings

 

 button in the lower right corner of the recording 
window.

The image settings region of the recording window becomes visible. If your 
digitizing board supports these features, slider controls are active and allow you 
to adjust the black level, white level, hue, saturation, brightness, and contrast 
of the recorded image. These are the same settings as in the Video Settings 
dialog box.

 

2.

 

Adjust image settings.

 

Important:  

 

To see the effect of your changes to the image settings, turn on your 
recording device. A video image is displayed in the recording window; you can 
view the effects of the changes in image settings here.
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To record clips smaller than full screen:

 

1.

 

To begin recording, click the Record button in the recording window.

 

2.

 

The Record button toggles to a Stop button.

 

or

 

Press 

 

I 

 

on the keyboard.

 

or

 

Choose 

 

Start Recording

 

 from the 

 

Recording

 

 menu.

 

or

 

Press 

 

Enter

 

 on the keyboard.

 

3.

 

To stop recording, click the Stop button in the recording window.

 

or

 

Press 

 

O

 

 on the keyboard.

 

or

 

Click the mouse anywhere outside the recording window.

Your newly digitized clips appear in the recording folder.

 

To record full screen clips:

 

n

 

Click the zoom box on the top right corner of the recording window.

 

Caution:  

 

Full screen recording will not take place unless you have chosen 640 x 480 
from the Recording menu.
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4.

 

To begin recording, press 

 

I 

 

on the keyboard.

 

or

 

Press 

 

Enter

 

 on the keyboard.

 

5.

 

To stop recording, press 

 

O

 

 on the keyboard.

Your newly digitized clips are in the designated recording folder.

 

6.

 

Repeat for as many clips as you would like to record.

 

7.

 

Click the mouse to return from full screen to the recording window.

 

To record still frames:

 

n

 

Click the still frame icon in the recording window.

 

To open the recording folder:

 

n

 

Click the recording folder icon at the top of the recording folder.

Newly digitized clips appear in the folder.

 

or

 

n

 

Choose 

 

Open Folder - Recording Folder

 

 from the 

 

Desktop 

 

menu.

 

To record to RAM:

 

Recording to RAM captures video directly into your system’s memory. This is the 
fastest recording method, and allows you to achieve the highest frame rates. 
However, recording to RAM requires 8 MB or more of RAM. 

If you do not specify Record to RAM, clips are recorded directly to your hard disk.

 

n

 

Choose 

 

Record to RAM 

 

from the 

 

Recording

 

 menu.



 

229

 

C

 

H A P T E R

 

 1 1

 

   Capturing Video and Audio

 

Adjusting Video Parameters
This section describes the various video settings you can specify. You do not need 
to reset these parameters every time you record, VideoShop saves these settings. 

There are four categories of settings:

• VideoShop-specific settings

• Source selection

• Compression settings

• Image settings

To set video parameters:
1. Choose Video On from the Recording menu.

2. Choose Video Settings from the Recording menu.

This opens a dialog box. 
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3. Choose VideoShop settings from the pop-up menu.

VideoShop Recording Settings

Important:  VideoShop’s default settings adjust depending on your machine. 
VideoShop should select the proper settings; it may not be necessary to adjust the 
parameters discussed below.

Compress on the fly. Lets you record and compress video simultaneously. Best 
used with digitizing boards with built-in compression boards.

Post-Compress. First digitizes video without compression, then, in a second pass, 
compresses the digitized video. Best used with digitizing boards that do not have 
built-in boards or compression daughter cards.
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Capture depth. Determines the amount of color information captured per video 
image pixel. The more colors selected, the better the quality of the video image. 
However, a higher number of colors often requires more processing power and 
storage space. Active only for post-compression.

Automatically Create Micon. Creates a Micon for a newly recorded clip.

Preview Video While Recording. Lets you view video in the recording 
window as the video is being digitized. If your digitizing board does not have 
display capabilities, choosing this option may result in lower frame rates. 
Previewing when using digitizing boards with display capabilities does not affect 
frame rates.

Record at Current Size. Records your clip at the size of the video in the record-
ing window when you click the Recording button. (Compare with Record at:) 
Larger sizes require more processing power.

Record at. Lets you select the dimensions at which your clips will be digitized. 
When you click the Recording button, the video automatically resizes to this size. 
Larger sizes require more processing power from your Macintosh.

This command also causes the screen to go blank during recording.

Constrain Aspect Ratio. Applies only if you define your own recording size. If 
you customize recording size, constraining the aspect ratio forces you to conserve 
the dimensional ratio of your original clip.

4. From the pop-up menu in the Video dialog box, choose Source.
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Source Settings
Source settings allow you to tell VideoShop what type of digitizing hardware you 
are using and where you have connected your recording device.

To set source settings:

 

n Choose Source recording settings.

Source Recording Settings

Digitizer. Indicates the type of hardware used to digitize your image clips. All 
QuickTime-compatible boards installed in your Macintosh appear in this menu, as 
long as their VDIGs (Video Digitizing Components) are in your System folder. A 
VDIG is a system software file that enables your digitizing board to communicate 
with QuickTime and VideoShop. If your board is capable of compression, you need 
a QuickTime CODEC (Compression/decompression component), which also 
goes in your System folder.

Input. Tells VideoShop where you have connected your recording device. You need 
to have first connected your source to the video connector on the digitizing board. 
Choose Composite or S-video. For higher-quality input, choose S-video. 
However, not all digitizing boards support S-video.

Format. Lets you choose the video standard used to digitize your clip. Three 
common standards are NTSC (North America and Japan), PAL (Europe, except 
France), and SECAM (France).
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Filter. Adjusts color in digitized video to compensate for differences in different 
video sources. Choose the appropriate filter to compensate for color differences 
that are related to the source of your video.

5. Choose Compression from the pulldown menu in the Video dialog box.

The Compression menu allows you to select the QuickTime or hardware-
specific compression algorithm for compressing your digitized clips. 
Compressors improve performance during playout.

6. Choose Compression settings.

Compression Settings
The following are the standard QuickTime compression settings. Depending on 
the hardware you have installed, additional settings may be displayed on the 
Compression menu.

QuickTime Compression Settings

Apple Animation Best. Use for compressing 16-bit (thousands of colors) or 
24-bit (millions of colors) animated or still images that are computer-generated 
(rather than recorded from analog videotape).

Cinepak Best. Use for compressing highest quality final movies for CD-ROM 
distribution when processing time is not an issue. Saving and mixing down may 
take several hours with this compressor. Final file size is quite small. 



234

VideoShop User’s Guide

Apple Graphics Best. Use for compressing 8-bit (256 colors) computer-
generated animated or still images or video recorded from an analog source to be 
played using an 8-bit display (256 colors or grays).

Apple None. Does not compress the image. The image is left raw at the depth 
selected in the depth menu. 

Apple Photo JPEG. Use for compressing movies with picture quality high-
resolution (24-bit) still images.

Apple Video. Use for compressing motion video recorded from an analog source. 
The movie is stored at 16-bit color depth (thousands of colors).

Others. If you have additional CODECs in your System folder, they appear in this 
submenu.

The Depth Menu
The Depth menu is used to determine how many colors (256 colors, thousands of 
colors, 16 million, and so on) are available for each pixel. Each compression method 
has its own options for video color depth. VideoShop automatically assigns a color 
depth for each compression method, but you can specify a different choice for some 
of the compressors.

Slider Control
Use the slider control to set a movie’s image quality. The Most setting yields the 
best image quality. However, the higher the image quality, the more data required 
to describe each movie frame and the more disk space and processing power are 
needed. This can sometimes equate to lower frame rates.

As you move and release the slider, the effect on image quality is displayed in the 
preview square. 

Frames Per Second. Determines the number of actual samples (frames) that are 
captured and displayed per second. The frame rate value (in frames per second) 
represents a cap on the sequence’s frame rate. Specify frame rate value by entering a 
value in the Frames Per Second field or through the pop-up menu.

The higher the frame rate, the higher the processing power and storage space 
required by the computer. To tune a movie for optimal performance on a 
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particular class of Macintosh or to decrease a movie’s storage requirement, cap the 
movie’s frame rate.

If you want a captured clip to retain its native frame rate use an optimization frame 
rate of Best or 0 fps.

Key Frame Rate. Frame differencing is a type of compression available that stores 
only the differences between frames. Every time a complete frame is stored, it is 
called a key frame. By setting the Key Frame Rate, you can determine how often 
a complete key frame is saved. The lower the key frame rate, the more often a 
complete frame is saved. Broadly spaced key frames produce satisfactory results only 
if the movie being captured is meant primarily for linear playback.

If QuickTime falls behind in its audio-video synchronization during playout, it 
freezes a key frame until it reaches the next key frame. Extremely long intervals 
between key frames can result in choppy playout under low-memory conditions or 
on slower Macintoshes. Therefore, you generally want a low number for the key 
frame rate.

Image Settings
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To set video image parameters:
These are the same settings as in the Recording Window dialog box.

1. Choose Video On from the Recording menu.

2. Choose Video Settings from the Recording menu.

This opens a dialog box. 

3. Adjust the pop-up menu so that these Image parameters are displayed. If your 
digitizing board supports these features, slider controls are active and allow you 
to adjust the black level, white level, hue, saturation, brightness, and contrast of 
the recorded image.

If your digitizing board does not support these features, this panel is inactive. 

Once you record at certain levels, these levels become the norm for the 
recorded footage. If you lose certain image details because of your settings 
(such as if you set the brightness too high and you wash out certain light areas) 
that information will be lost. Preview the image settings first before moving 
ahead with these levels.

• Hue controls the tint of the image on a red-to-green spectrum.

• Saturation controls the color intensity of the video images.

• Brightness controls the amount of luminescence or light in the image.

• Contrast controls the intensity of the difference between dark and light 
areas.

• Sharpness controls the level of definition of the image.

• Black Level control the depth of blackness in the black pixels.

• White Level control the depth of whiteness in the white pixels.

4. Click OK to accept settings, or Cancel to discard changes.
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Adjusting Audio Parameters
There are three types of adjustments for audio settings: 

• Source

• Compression

• Sample

To set audio parameters:
1. Choose Sound On from the Recording menu.

2. Choose Sound Settings from the Recording menu.

A dialog box opens in which you can adjust how you record sound and its 
playback quality.

3. Select the Source parameters.

Source Parameter Settings

This section describes the settings you may want to adjust to improve audio quality. 

Device. Lets you select the hardware board or accessory to digitize audio 
(an internal/external microphone, Mac Recorder, or an additional hardware 
source). QuickTime-compatible audio digitizing devices automatically appear in 
this menu, if their drivers are in your computer’s System folder.
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Input. Indicates input source. Channel 1 is the default. With additional hardware, 
other input options appear.

Speaker. Turns the sound on or off during recording. Turning the speaker off 
reduces the chances of feedback problems.

Volume. Adjusts the audio level you hear during playout. (Or, you can do this in 
the recording window.)

Gain. Adjusts the sensitivity of the input signal. The higher the setting, the 
stronger the signal received.

Level. Shows the sound input level of the recording.

Audio Compression Settings

To set audio compression settings:
1. Choose Sound On from the Recording menu.

2. Choose Sound Settings from the Recording menu.

A Sound dialog box is displayed.

3. If compression settings are not displayed, use the pop-up menu to choose 
compression settings. 

The right side of this dialog does not change as you scroll through the pop up 
menu. Speaker, Volume, Gain, and Level settings are explained earlier in this 
section.
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4. Select audio Compression settings.

None. Does not compress recorded sound. Use this setting for the best sound 
quality. 

MACE. Digitize sound at reduced file sizes. MACE 3:1 reduces file size three 
times, MACE 6:1 reduces file size six times. The larger the reduction in file size, 
the lower the sound quality.

Sound Sample Settings

To set sound sample settings:
Sound sample settings let you determine the trade-offs between quality (fidelity) 
and storage (bandwidth).

1. Choose Sound On from the Recording menu.

2. Choose Sound Settings from the Recording menu.

A sound dialog box opens.

or

If sample settings are not displayed, choose Sample Settings from the pop-up 
menu on the upper left of the dialog box.

The right side of this dialog does not change as you scroll through the pop-up 
menu. Speaker, Volume, Gain, and Level settings are explained in earlier in 
this chapter.
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3. Set Sample parameters.

Rate. Lets you select the fidelity of digitized audio. Higher sampling rates yield 
higher sound quality, but require more processing power and disk space. 

Size. Lets you choose an 8-bit or 16-bit size for your audio sample. 16-bit samples 
record a greater tonal range and produce better quality audio, but require more 
processing power. 

Important:  Sound options vary depending on your available hardware. For example, 
Macintosh AV machines offer the 16 bit audio options, many other Macintoshes do 
not.

Mono or Stereo. Stereo recording enhances audio quality, but increases the 
performance requirements of your Macintosh. To play and record stereo audio, you 
need a Macintosh or hardware with stereo-out capabilities. Refer to the 
documentation for your digitizing board or Macintosh for details about stereo 
capabilities.
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Recording Scenarios
This section provides some guidelines for getting the best possible results in typical 
recording scenarios. These scenarios apply only to boards that do not use full-screen 
hardware compression.

Follow the instructions in this chapter, and choose the options recommended 
below for each scenario.

Scenario 1: Easy Recording
Use the following recording procedure if:

• Your Macintosh is configured with 8 MB of RAM or less.

• You have a minimum of 100 MB of empty space on the hard disk to be used 
for recording.

• You are not overly concerned with movie frame rate.

• You don’t want to bother experimenting with quality and frame 
differencing settings.

• You do not have a compression card.

Make sure that your recording settings and choices match the following:

Recording Menu
• Record to RAM (unchecked)

• Video On (checked)

• Sound On (checked)

• Video Settings command

• Sound Settings command

VideoShop
• Compression: Post-Compress 

• Automatically Create Micon (checked)

• Preview Video While Recording (checked)
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Compression
• Compressor: Apple Video

• Color: Color

• Quality: Most

• Frame Per Second: empty

Source
• Digitizer: name of the digitizing board in computer

• Device: Built-in or Other

Sample
• Size 160 x 120

• Sampling Rate: 11.1 kHz

Scenario 2: Recording with Limited Hard Disk Space and 
Limited Memory
Use the following recording procedure if:

• You have less than 8 MB of RAM.

• You have less than 100 MB of free space on the hard disk to be used for 
recording.

• You are not concerned with movie frame rate or image quality.

• You do not have a compression card.

Make sure that your recording settings and choices match the following:

Recording Menu
• Record to RAM (unchecked)

• Video On (checked)

• Sound On (checked)

• Video Settings command

• Sound Settings command
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VideoShop
• Compression: Post-Compress 

• Automatically Create Micon (checked)

• Preview Video While Recording (checked)

Compression
• Compressor: Apple Video

• Color: Color

• Quality: Normal

• Frame Per Second: empty

Source
• Digitizer: name of the digitizing board in computer

• Device: Built-in or MacRecorder

Sample
• Sampling Rate: 11.1 kHz

Scenario 3: Recording with Limited Hard Disk Space and 
Abundant Memory (RAM)
Use the following recording procedure if:

• You have more that 8 MB of RAM.

• You have less than 100 MB of free hard disk space.

• You want the best possible image quality and frame rates and you are recording 
short video clips.

• You do not have a compression card.

Make sure that your recording settings and choices match the following:

Recording Menu 
• Record to RAM (checked)

• Video On (checked)

• Sound On (checked)

• Video Settings command

• Sound Settings command
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VideoShop 
• Compression: Compress on-the-Fly 

• Automatically Create Micon (checked)

• Preview Video While Recording (checked)

Compression 
• Compressor: Apple Video

• Color: Color

• Quality: Normal

• Frame Per Second: empty

Source 
• Digitizer: name of the digitizing board in computer

• Device: Built-in or MacRecorder

Sample
• Sampling Rate: 11.1 kHz

Scenario 4: Maximizing Video Capture Rates When Recording 
to Hard Disk
To maximize video capture rates (to achieve higher frame rates) when recording to 
a hard disk, you must first record a clip without compression and then save and mix 
it down in VideoShop as a self-contained movie. During the mixdown process, you 
can apply higher compression and a higher frame rate than you can during 
recording. 

Use the following recording procedure if:

• You have more that 8 MB of RAM.

• Your hard disk capacity is 100 MB or more, of which 50 MB or more is 
empty

• You are concerned with achieving high movie frame rates for long clips.

• You do not have a compression card.

Before you begin the recording process, you must dedicate an empty hard disk for 
movie recording or establish an empty partition on your hard disk (at least 50 MB) 
strictly for recording. 
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To establish a partition for recording:
1. Create a new folder on the recording disk/partition.

2. Designate that folder as the recording folder. (Choose Set Recording Folder 
from the Folder menu.) This folder should be the only item in the recording 
disk/partition. 

3. Continue with the recording process.

Make sure that your recording settings and choices match the following:

Recording Menu
• Record to RAM (unchecked)

• Video On (checked)

• Sound On (checked)

• Video Settings command

VideoShop 
• Compression: None 

• Automatically Create Micon (unchecked)

• Preview Video While Recording (checked)

To maximize your movie frame rates, you must save the raw footage in a VideoShop 
sequencer as a self-contained movie. During the save process, mixdown the movie 
using the following settings. 

• Compressor: Apple Video

• Quality: Most

• Frames Per Second: enter desired frame rate

Scenario 5: Maximizing Video Capture Rates When Recording 
to Memory (RAM)
Use the following recording procedure if:

• You have more than 20 MB of RAM.

• You have more than 100 MB of free space on your hard disk.

• You are concerned with achieving the highest possible movie frame rates.

• You do not have a compression card.
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Make sure that your recording settings and choices match the following:

Recording Menu 
• Record to RAM (checked)

• Video On (checked)

• Sound On (checked)

• Video Settings command

• Sound Settings command

VideoShop 
• Compression: Compress on-the-Fly 

• Automatically Create Micon (checked)

• Preview Video While Recording (checked)

Compression
• Compressor: Apple Video

• Color: Color

• Quality: Most

• Frame Per Second: empty

Source 
• Digitizer: name of the digitizing board in computer

• Device: Built-in or MacRecorder

Sample 
• Sampling Rate: 11.1 kHz

Selecting Digitizing Hardware
Video and audio information recorded from a camera, or on videotapes and audio 
tapes, are in analog format. To store information on a computer’s hard disk, where it 
can be manipulated with VideoShop, the information must be converted into 
digital form. To do this, you need a digitizing board and/or audio input device. 
VideoShop works with all QuickTime-compatible video and audio digitizing 
hardware. Some Macintoshes (the Centris 660 AV and the Quadra 840 AV) have 
built-in video digitizing. 
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VideoShop can control video decks that support the Sony serial protocol via the 
RS-422 port. All that is required is a cable that connects from the Macintosh 
modem port to the Sony RS-422 port on the device (consult your device's manual 
to determine if it has a RS-422 port). This cable (#35) is available directly from 
Avid and can be purchased by calling Avid at 800-949-AVID (2843) option 5.

Video Digitizing Boards
Video digitizing boards are often referred to as video-in boards or capture cards. 
A video digitizing board takes the video signal from an analog format (for example, 
a VCR or camcorder) and converts it into a digital format that the computer can 
understand. When you buy a digitizing board, evaluate it based on the following 
features:

• QuickTime compatibility.

• Capture speed (frame rate) should be a minimum of 8 frames per second; the 
highest quality digitizing boards (also the most demanding on your computer) 
offer frame rates of 30 frames per second.

• Color depth (16-bit capability recommended).

• Full-screen still capture capability.

• Hardware compression options––some boards offer compression of the video 
information, which makes a higher frame rate possible.

• Graphics acceleration.

• Audio input capabilities.

• PAL/SECAM (European) video standards support.

Sound Input Devices
Some Macintoshes, such as Quadras (700, 900, and 950), IIsi, LC and LC II, and 
the Classic, come equipped with an external microphone and built-in audio 
digitizing circuitry. For other Macintosh models, you need an audio input device or 
digitizing board. Standard video cameras usually come equipped with a micro-
phone, which you can connect to an audio input device or digitizing board. 
Features to look for in an audio input device or digitizing board include:

• Audio quality—should be a minimum of 11 kHz. Standard Macintosh quality 
(22 kHz) is recommended. The best quality audio available is 44 kHz, CD 
quality.
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• 8-bit or 16-bit—16-bit is higher quality.

• Internal or external device—if you do not have enough slots in your 
Macintosh to support another board, you may want to consider using an 
external device that connects to your Macintosh via one of the serial ports.

• Volume control—hardware or software controlled.

• Built-in microphone or input line for microphone—be sure to get whichever 
better suits your overall needs; if you opt for an input line, you will need a 
microphone



 

Chapter 12

 

The Logger

 

This chapter describes the VideoShop Logger. It covers the first steps toward 
logging clips and includes discussions on:

• The Logger Basics 

• Device Control Basics

• Using Device Control

• Logging Basics

• Using Tape Logs

• Creating Logs

• Saving Your Work

• Preparing to Log Material

• Logging

• Clip Information

• Batch Digitizing

• Digitizing clips

• Using Time Code

 

 

This document was created with FrameMaker 4.0.4
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The Logger Basics

 

The Logger is a VideoShop tool that helps you select and log clips before an edit 
session. The Macintosh must be connected to a single deck that has ViSCA or Sony 
serial deck protocol; the Logger supports remote control through ViSCA or Sony 
serial protocols. 

The Logger is comprised of three components, the recording window, the 

 

logging window

 

, and the 

 

Device Control window

 

. Used together, these three 
windows allow you to control the deck to view your source tapes and select shots 
for your log. 

For each shot that you log, the Logger automatically saves the start and end time-
codes, duration, and clip name.

The Logger’s 

 

Clip Information dialog

 

 lets you add new categories of 
information to your log, so that you can record the scene, take, location, or any 
comments that can help you identify the footage.

After logging shots, use the VideoShop recording window to digitize and edit the 
footage. 

Before you begin using the Logger, you need to understand how the system uses 
clips and logs to organize your work.

The Logger’s clips and logs are a lot like their film counterparts. Just as film editors 
pull clips from raw footage and store the clips in logs for the editing session, the 
Logger lets you select shots from your tapes and store information about the shots 
in digital logs.

Each time you log clips, you open a log and then use the deck controls to play your 
tapes, mark your in and out points, and add the entry to the open log. 

 

Important:  

 

A hard disk is recommended, but not required.
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To Start the System with a deck that supports the Sony Serial Protocol:

 

1.

 

Power on the deck.

 

2.

 

Set the deck’s REMOTE/LOCAL switch to REMOTE.

 

3.

 

Turn on the Macintosh computer.

 

4.

 

Launch

 

 VideoShop

 

.

 

5.

 

Select 

 

Logging

 

 from the 

 

Windows 

 

menu.

The logging window opens.

 

6.

 

Select 

 

Device Control 

 

from the 

 

Windows 

 

menu.

The Device Control window opens.

 

7.

 

Select 

 

Recording 

 

from the 

 

Windows 

 

menu.

The recording window opens.

When you install VideoShop, the ViSCA Driver is placed in the Avid VideoShop 
folder. If you are using the Logger with a ViSCA deck, move the contents of the 

 

ViSCA Driver 1.2 folder

 

 to the System folder on your startup volume. The Mac-
intosh will bring up a dialog asking whether you want to place it in the Control 
Panels folder. Click 

 

OK

 

 or press 

 

Return

 

.
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To Start the System with a deck supporting the ViSCA Protocol:

 

1.

 

Power on the deck.

 

2.

 

Turn on the Macintosh computer.

 

3.

 

Select 

 

ViSCA

 

 from the Macintosh Control Panels found in the System Folder.

 

4.

 

Set the ViSCA driver to the appropriate port (Printer or Modem)

 

5.

 

Launch

 

 VideoShop

 

.

 

6.

 

Select 

 

Logging

 

 from the 

 

Windows 

 

menu.

The logging window opens.

 

7.

 

Select 

 

Device Control 

 

from the 

 

Windows 

 

menu.

The Device Control window opens.

 

8.

 

Select 

 

Recording 

 

from the 

 

Windows 

 

menu.

The recording window opens.

 

Important:  

 

The VideoShop recording window does not need to be open to use the 
Logger. For example, if you do not have a digitizing card on your system or you are 
using a Macintosh PowerBook, you can just use a monitor or television connected 
directly to the deck to view the content of the tape.
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Configure the Logger for Your Video Device

 

Before you can use the Logger, you must tell it about your video device. 

 

To configure the Logger:

 

1.

 

Launch VideoShop

 

2.

 

Choose 

 

Device Control

 

 from the 

 

Windows

 

 menu

 

3.

 

Press the 

 

Setup

 

 button on the tool strip.

A dialog box appears.

 

4.

 

Set the Protocol to correspond to your video device or device controller. 
Sony V Deck 1000 or 500 or LANC devices with a Sony VBox Controller 
need to be set up with ViSCA protocol driver.

 

5.

 

If your device supports time code and you are using tapes which contain time 
code, select 

 

Time Code

 

 as the 

 

Time Source

 

. Otherwise ensure that the 

 

Time 
Source

 

 is set to 

 

Counter. 

 

(See “Using Time Code” later in this chapter for 
more information)

 

 

 

6.

 

Enter the number of 

 

Preroll Frames

 

.

 

Preroll Frames

 

 tells the VideoShop Logger how many frames your video 
device needs to play before the image is stable. Ten frames is 
sufficient for most video devices. If the first few frames of each digitized clip 
are not clear, you should increase the number of preroll frames.
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7.

 

Enter the number of 

 

Slack Frames.

Slack Frames

 

 specifies the number of additional frames to be automatically 
added to the beginning and end of each clip when the clip is digitized. Slack 
frames can be used to give you flexibility to make final trims in VideoShop to 
compensate for non-frame accurate video devices.

 

Device Control Basics

 

The on-screen remote control functions much like its physical equivalent. The 
Device Control window has the standard functionality of a remote control, a jog 
shuttle, a time code display, and the ability to go to a specific frame.

 

Preparing the Video Device

 

To begin working with the Logger’s Device Control feature, be sure your hardware 
is connected properly.

 

To prepare a device:

 

1.

 

Set the device to remote.

 

2.

 

Insert the source media in the device.

 

Opening the Device Control Window

 

Device control can be turned on at any time once the Logger is activated. If device 
control was in use the last time the recording window was closed, and the recording 
window was closed first, the Device Control window automatically opens when 
the recording window is next opened.
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To open device control:

 

n

 

Choose 

 

Device Control

 

 from the 

 

Windows 

 

menu.

 

or

 

n

 

Choose 

 

Recording

 

 from the 

 

Windows 

 

menu if device control was in use in 
the most recent recording session.

The Device Control window opens. A dialog box also opens, in which you are 
required to type the name of the tape you are working from. 

 

Caution:  

 

The Logger does not permit the use of multiple tapes for a single log. In 
order to open a log with source reference different from the current tape in the 
deck, you need to eject the tape.

 

To turn of f device control:

 

1.

 

Click to activate the Device Control window

 

n

 

Choose 

 

Close

 

 from the 

 

File 

 

menu.

 

or

 

n

 

Press 

 

E

 

-W.

 

or

 

n

 

Click the close box on the Device Control window.
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Resetting the Counter

 

If your device does not support time code or your tape does not contain time code, 
you must rely on the device’s internal counter to determine the current tape 
position. While in counter mode, each time you put a new tape in the deck, you 
need to reset the counter. Resetting the counter ensures that your log is consistent 
if you want to return to the log later to digitize.

 

To reset the counter:

 

1.

 

Put a tape in the deck.

 

2.

 

Press the Reset button on the Device Control window toolstrip.

This rewinds the tape to the beginning and sets the counter to zero.

Recalibrating the Counter
Tape counters work reasonably well when playing straight through the tape. How-
ever, starting, stopping, and searching causes the counter to drift. To prevent this 
from interfering with clip logging and batch digitization, you should periodically 
recalibrate the counter.

To recalibrate the counter:

 

n Press the Recalibrate button on the Device Control window toolstrip.

This rewinds the tape to the beginning and then fast forwards back to where 
you were, recalibrating the counter from zero to your current point.

Important:  If you are not using time code, you should recalibrate the tape every so 
often.

Entering Time Code
Frames are represented by a number in the form HH:MM:SS:FF. The first two 
digits give the hour, the next two the minute, the next two the second, and the last 
two the frame number. Since there are a maximum of thirty frames per second, the 
maximum time code is 23:59:59:29. The hours portion of the time code is not 
important when working with footage that is shorter than one hour.
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To enter the frame number 00:01:05:10:
1. Type 10510 on the keyboard.

2. Press Enter or the Tab key on the keyboard.

The Device Control automatically adds the colons and initial zeros.

Using Device Control
The on-screen remote control functions much like its physical equivalent. The 
Device Control window has the standard functionality of a remote control, a jog 
shuttle, a time code display, and the ability to set marks and to go to a specific 
frame.

Using Device Control to Search for a Specific Frame
The Device Control window lets you search for a specific frame on the tape, 
provided that you know the time code or counter position of the frame. The time 
code or counter position is found in the upper left corner of the Device Control 
window when the frame is played.

To go to a specific frame:
1. Enter the time code (or counter position) in either of the position boxes 

(found in the lower left and right corners of the Device Control window).

Either type in the time code or click the In or Out button to store tape 
position in these fields.

2. Press the appropriate Go To button.

The deck moves the tape to the specified position. The deck locates the spe-
cific frame.

To cancel a search:

 

n Click the Pause/Stop button.

or

 

n Press E-period.



258

VideoShop User’s Guide

Using Device Control While Recording
The Device Control window can be used to facilitate the recording process while 
recording individual clips or, with the logging window open, to create a log of clips 
to batch digitize.

Using the Device Control window to record individual clips is much like using a 
hand-held remote control.

To record individual clips.
1. Choose Recording from the Windows menu.

Setup VideoShop for video capture (refer to Chapter 11, “Capturing Video and 
Audio”).

2. Choose Device Control from the Windows menu.

Make sure the logging window is closed. If the logging window is open, press-
ing the Record button on the recording window batch digitizes the log.

3. Use the Device Control window to locate the footage to record.

4. Click the Record button in the recording window twice, once to activate the 
window and once to start recording.

Caution:  As with a VCR (Video Cassette Recorder), any time you record, be sure 
to press Stop in the recording window before you press the Pause/Stop button in 
the Device Control window. If you stop the tape before you stop recording, a 
frozen frame will appear at the end of the clip.

Using Device Control During Print to Video
Without the device control of the Logger, it is difficult to begin recording to a tape 
at exactly the same instant as VideoShop begins printing. Failure to synchronize 
these two operations can result in either a blank spot at the beginning of the tape or 
loss of a portion of the movie. With device control, you can consistently ensure 
perfect timing.
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Logging Basics
You may already be familiar with the process of logging clips from source tapes. 
As you would expect, the Logger also lets you log clips with their names, their start 
and end timecodes, and their durations.

The Logging Window
The toolstrip across the top of the logging window helps you to organize the 
contents of the log. You can choose between two different ways of looking at the 
log, poster view or by list, and you can sort the log alphabetically, by In point, by 
Out point, or by Duration. In the space to the left of each clip name (or to the 
right of the Out point poster frame if you are in poster view) a Hard Disk icon 
indicates that the clip has been digitized. A check mark indicates that the clip is 
selected for batch digitization.

Creating Logs

Only one log can be open at a time. If you want to switch logs you must close the 
current log before opening another log. 

Opening a New Log
A log is opened whenever the logging window is opened. Since only on tape log 
can be open at a time, you cannot open a new log until you close the original log.

To open a log:

 

n Choose Logging from the Windows menu.

or

 

n Double-click an existing log in a desktop window.

or 
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n Choose Open from the File menu.

A new logging window appears entitled “Untitled Source”.

To open an existing log:
1. Select Open from the File menu.

or 

Double click the log in a desktop window.

2. In the Open dialog box, select the folder that contains the log to open.

3. Select the name of the log 

4. Click Open.

or 

Press Return. 

or 

Double-click the log name.
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To close a log:
1. Click the log to activate it.

2. Choose Close from the File menu.

or

Press E-W.

or

Click the close box on the logging window.

or

Choose Logging from the Windows menu.

A dialog box opens and asks if you want to save the current log before closing.

Using Tape Logs
Tape logs are used for a variety of purposes to make working with your source 
material easier by saving time and disk space.

For Batch Digitization
Clips which you want to batch digitize are selected in the tape log. The tape log 
determines the file names of the digitized clips; the file names of the digitized clips 
are the clip names in the log.

Saving Your Work
By default, your current logs are stored in the Macintosh’s volatile, random access 
memory (RAM); if necessary, save the information to a hard disk.
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Should the power fail or the system shut down unexpectedly, as with any other 
document in progress, the logs stored in RAM are lost. However, you may restart 
the editing session by opening the logs saved on disk. 

Warning:  Save your work frequently to hard disk to avoid losing your work.

To save a log:
1. Click the log to activate it.

2. Choose Save from the File menu, or type E-S.

The Save command is dimmed if the current log has already been saved.

To save a copy of a log:
1. Click the log to activate it.

2. Choose Save As from the File menu.

A dialog box appears.

3. Move to the disk and folder where you want to save the copy.

4. Type a name for the copy and press Return.

or

1. Select a log in a desktop window.

2. Select Duplicate from the Edit menu on the VideoShop Desktop.
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To delete a log:
1. In a Desktop window, click to select the log you want to delete.

2. Press the Trash Can button on the toolstrip.

or

Press E-K.

A warning dialog appears.

3. Click OK or press Return.

Preparing to Log Material
Once you have opened a log, open the Logger to access deck and logging controls, 
and enter the name of the tape you are logging.

This section explains how to access and use tools that provide the information to 
log your material.

Inserting Source Tapes
You must use unique names for logs and clips. The system cannot distinguish 
between two logs or clips with the same name. Since the clip names are used as file 
names for digitized clips, clip names within one log need to be different. The 
Logger checks for repeated names and displays a warning dialog box if two clips in a 
log are inadvertently named the same.
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To insert a source tape in a deck for logging:
Sony serial decks need to be set to remote. ViSCA decks automatically recognize 
remote settings. 

1. Insert a source tape in your deck.

2. Choose Device Control from the Windows menu.

The Device Control window and the Tape Name dialog box opens. If there is 
an open log, the name will appear in the current log. If the tape does not relate 
to the current opened log, click Open Log to open an existing log or click the 
New Log to create a new log.

Caution:  Be sure to give your tape a unique name. The Logger cannot distinguish 
between tapes or clips with the same name. Plan your tape naming scheme to avoid 
duplicate tape names.

If you do not want to open a log file, click OK, and the open log is closed. 
Click Cancel to eject the tape.

Important:  A log with a different source name from the current tape in the deck 
cannot be kept open.

3. Choose Logging from the Windows menu.

The logging window opens.

4. Choose Recording from the Windows menu.

The recording window opens.
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Choosing the Video Capture Rate Compression Setting
Logging your material at lower capture rates (frames per second) saves space on 
your disks, but results in playback that is not smooth.

 

n Select Video Settings from the Recording menu.

The Compression Settings dialog box opens. Refer to Chapter 11 to learn 
about the appropriate settings.

Adjusting the Audio Compression Settings
Audio compression is made up of two aspects that determine your overall audio 
sample rate:

• Rate

• Compression

Choosing the Audio Rate Setting
Your audio rate setting is determined by your system’s audio card. The audio 
capture rate is set by the card; the Compression tool only reflects that setting. If the 
logged clips are going to be digitized on a system that uses a different audio rate 
setting, the audio rate that you choose now with the Logger Compression tool can 
be adjusted at that time.

You can choose one of the following audio capture rate settings

• 44100 Hz

• 48000 Hz

To choose the audio rate settings: 

 

n Choose Sound Settings from the Recording menu.

The Compression Settings dialog box opens. Refer to Chapter 11 to learn 
about the appropriate settings.

Choosing Audio Compression Setting
You can select one of the following audio compression settings:

• 1:1

• 4:1
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The 1:1 setting provides a full audio frequency response. The 4:1 setting provides 
the frequency used for the full range of speech, but does not capture the full 
frequency range of music.

To choose the audio compression settings: 

 

n Choose Sound Settings from the Recording menu.

The Compression Settings dialog box opens. Refer to Chapter 11 to learn to 
define the appropriate settings.

The sound volume and video image settings defined while logging are remembered 
during batch digitization. Each clip retains the established settings; during batch 
digitization, the Logger utilizes the clips’ saved settings.

Assume a logging window is full of clips with unknown and miscellaneous settings. 
Because you can neither see nor adjust video and audio settings in the logging win-
dow, you must set the settings in the recording window. You can then set the 
adjusted settings to the Logger to update that one clip (if it is still selected), or 
update multiple clips to the new settings (if there are a number of selected clips in 
the log).

To change the setting of a clip:
1. Select the entry in the logging window.

If multiple entries are selected, the first clip’s settings are used.

2. Press the Set button.

The selected clip’s video and audio settings are set to the recording window.

3. Adjust the settings as desired.

To grab the new setting in the logging window:
1. Select the entries in the logging window.

2. Press the Get button.

The clips selected in the logging window are updated to the new settings.
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Logging
Once the Logger is open and all settings are in place, you can add entries to the clip 
log. Many editors prefer to log all entries (shots) first, then digitize their material 
later. 

The Logger automates the process of recording each entry’s start and end time-
codes, so the information does not need to be entered manually. 

To add an entry to the log:
Make sure the recording window, the logging window, and the Device Control 
window are open.

1. Load your tape in the deck.

2. Use the remote control portion of the Device Control window to move the 
tape to the beginning of the clip you want to create.

3. At the beginning point, click the In button or press the Control - I or the 
Option and Up Arrow keys on the keyboard.

Continue playing the tape until you reach the end of the clip you want to 
create. You can advance the tape to the end point using any method you 
choose (single step, play, scan, or fast forward). Since you are not recording, 
you can even go past the end point and then back up before defining the Out 
point.

4. Click the Out button or press the Control - O or the Option and Down 
Arrow keys on the keyboard.

5. Name the clip by typing a name in the Clip Name box. 

6. Press Return or Enter.

The clip name appears in the logging window with its In point, Out point, 
Duration, and Clip name.

Important:  It is not necessary to pause the tape before pressing the In or 
Out buttons. The most efficient way of logging clips is to use scan and fast forward 
to get close to the target footage and then switch to play to mark the In point. 

You can easily edit the clip later; it is better to err on the side of too much footage 
than too little.
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Caution:  The Logger rejects clips which have Out points before their In points and 
clips which have the same name as a clip already in the log.

7. Repeat these steps until you have logged all your clips.

Important:  You can also expand the Device Control window to enter the 
description of the clip you are logging while you are watching the footage.

To select an entry in a log:

 

n Click the entry name

or

 

n Select multiple entries by Shift-clicking additional items.

To delete a clip from the log:
1. Select the entry (entries) in the log.

2. Press the Delete key on the keyboard.

or

Choose Delete from the Edit menu

or

Press E-K.

The entry is deleted.

Caution:  If the entry has been digitized, deleting the entry in the log only removes 
the entry. The digitized clip still resides in the recording folder.
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Clip Information
When a clip is logged with the recording window open, the head poster frame, 
the tail poster frame, and the current video and audio settings are recorded with the 
clip. 

If you are logging clips without using the recording window (watching the video 
through a monitor directly from the deck) or if your digitizing card does not allow 
you to grab PICTs, an invalid poster frame is attached to the clip. You can later 
update the poster frame by selecting the Update button in the logging window. 
The Logger captures the head and tail frames of the in and out points of each clip 
by scanning (navigating) through the video.

To update poster frames:
1. Select Recording from the Windows menu to open the recording window.

1. Click to activate the logging window.

2. Press the Update button on the logging window toolstrip.

New head and tail poster frames are created for the clip.

To add or modify data in the Clip Information dialog:
The Logger allows you to add information to each clip with the Clip Information 
dialog.

1. Double-click the clip in the logging window.

or

 

n Press the Clip Information button on the logging window toolstrip.

The Clip Information dialog opens.
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2. Add the desired information.

To navigate between fields, press Tab on the keyboard.

3. Select the data you want to change.

4. Type in new data.

5. Click OK, press Enter. 

The information is added.

To preview an entry from the analog source:

 

n Double-click the entry in the Duration column.

or

 

n Press the Go To button in the Device Control window toolstrip.
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To move directly to the In or Out point of a clip:

 

n Double-click the entry in the In or Out column of the logging window.

or

 

n Press the Go To In or Go To Out button in the Device Control window 
toolstrip

To cancel the search:

 

n Press E- period.

or

 

n Press the Pause/Stop button on the Device Control window.

To copy a clip:
1. Select the clip in the desktop window by clicking the clip’s icon.

2. Choose Duplicate from the Edit menu.

or 

Press E-D.

A copy of the clip appears in the Desktop folder.

To print a log:
Click to activate the logging window.

1. Chose Print from the File menu of press E-P.

The familiar Macintosh Print Dialog box appears.

2. Click OK or press Return.

The log is printed in the current view format (either text or poster view).
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Batch Digitizing
Batch digitization is the process by which clips in a tape log are automatically 
recorded and stored on your hard disk so you can use them to make movies in 
VideoShop.

Before you can begin batch digitizing you must have VideoShop and your hardware 
set up to capture video and/or audio. For information on how to set up VideoShop 
or your hardware, please consult Chapter 11, “Capturing Video and Audio.” 

The Batch Digitization Process
1. Set up VideoShop and your hardware for Recording

2. Set up your device for device control

3. Choose Recording, Device Control, and Logging from the Windows menu

4. Find the sections of footage you want to digitize

5. Create log entries for each clip you want to digitize

6. Mark the clips in the logging window you want to digitize

7. Click the Record button in the recording window, or the Record button in 
the logging window, to start batch digitization

Digitizing Clips
Once you have created a log, the process of digitizing is simple. Select the clips you 
want to digitize and click the appropriate button. 

To select entries in the log for digitization:

 

n In list view, click to the left of the entry to make a check mark.

 

n In poster view, click to the right of the poster frame to make a check mark.
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To switch views:
1. Click the logging window to activate it.

2. Either:

Press the List View button.

or

Press the Poster View button.

To deselect entries in the log:

 

n In list view, click the check mark to the left of the entry to deselect.

 

n In poster view, click the check mark to the right of the poster frame to 
deselect.

To digitize clips in the log:
1. Click the Setup button in the Device Control window.

The configuration dialog appears:

The clips are digitized using a One Pass Digitization process. One pass 
digitization yields frame rates equivalent to those you would obtain if you 
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digitized clips individually without the Logger. The tape plays at normal speed 
during digitization and digitizes at a rate of one minute per minute of footage. 

2. Enter the number of slack frames. 

Slack Frames indicates the number of extra frames to be automatically added 
to the beginning and end of each clip when it is digitized. If you are not using 
time code, you should specify at least thirty slack frames.

3. Select Video Settings from the Recording menu.

The Compression Settings dialog box appears.

4. Turn on Preview While Recording to see the clips as they are digitized.

5. Choose the clips you want to digitize by clicking to the left of their names in 
the logging window. 

A check mark appears next to each clip which is selected for digitization. To 
remove the check mark and deselect the clip, single click on the check mark 
next to a clip.

or

Choose Select All (E-A) from the Edit menu

6. When you have checked all the clips you want to digitize, activate the record-
ing window and press the Record button

or

Press the Record button on the logging window.

The Logger plays and digitizes each of the clips in the log. When digitizing a 
clip, the counter in the device control window stops to ensure the maximum 
possible performance during digitization.

As clips are digitized, a Hard Disk icon replaces the check mark indicating 
which clips have been digitized.

Digitized clips are stored in a new folder in the Recording folder that has the 
same name as the tape log.
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Caution:  If a file already exists in the tape log folder with the same name as one 
being digitized, a number is appended to the new digitized clip’s name.

To interrupt the batch digitization process:

 

n Click Stop in the recording window.

or 

 

n Press E-period.

Using Time Code
Time code allows a video deck to uniquely identify each frame of video by time 
stamping the video. This allows the video device to know exactly where it is at all 
times and greatly improves the accuracy of searching, logging, and batch 
digitization. 

Without time code, the device can only count frames as they are passed by the 
heads. If it misses few frames (which it often does when switching between modes 
or during fast forward and rewind), the device has no way of checking its absolute 
position without rewinding the entire tape, zeroing the counter, and starting over. 
This action causes errors accumulate. In short, if your device has the capability to 
use time code, it is best to use it. 
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Time Code Formats
Different time code formats store this information in different places on the tape 
such as in an audio track (LTC), in an off-screen portion of the video signal (VITC, 
Vertical Interval Time Code) or in separate area (Hi8). The storage location of the 
time code should not matter much to you or the VideoShop Logger as long as the 
device you are using can read it. There is one important catch, both Hi8 and LTC 
time code can be added after the video is shot. However, VITC time code must be 
added while shooting the video since it is actually part of the video signal. If you 
plan on using VITC, make sure your camcorder writes time code while you are 
taping.

Adding Time Code
The easiest and fastest way to add time code to your tapes is to add it while you are 
taping. Unfortunately, many consumer camcorders do not write time code. If this is 
the case, you will need to add time code to your tapes using your video deck in a 
process called time code dubbing. 

Caution:  If your deck can only read VITC (Vertical Interval Time Code) you must 
add the time code while taping.

The documentation for your video devices should contain information on how to 
add time code to your tapes. To supplement, we have included instructions for 
some of the more popular devices below:

Sony VDeck 1000 or VDeck 500
1. If the Device Control is active in VideoShop, close it. The device should not be 

under computer control and the ViSCA light should be off. 

2. Insert the tape and press Play (on the remote control or the front panel of the 
device).

3. Position the tape where you want to begin adding time code, and press Pause.

4. On the VDeck 1000, press Time Code Dub on the remote control (you will 
need to slide the protective cover down to access this button)
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or

On the VDeck 500, press Time Code Write on the front panel.

5. Press Pause to execute time code dubbing – the red REC light illuminates.

6. Press Stop to stop time code dubbing. 
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Appendix A

 

Memory Management

 

When you install VideoShop, the installer software automatically allocates 4 MB 
(4000 K bytes) of memory for the program. Depending on the amount of memory 
on your system and the complexity of the particular operation you want to perform 
with VideoShop, you may want to increase this amount. 

This appendix provides some guidelines for getting the most out of your system 
memory.

 

VideoShop Memory Allocation

 

When a program is launched, it reserves an area of memory (RAM) for its 
operation. This is known as the program’s memory allocation. 

Before changing the memory allocation for VideoShop, check how much memory 
is available on your system—choose 

 

About this Macintosh

 

 from the 

 

Apple

 

 menu. 
Note the number labeled 

 

Largest Unused Block

 

—the Largest Unused Block 
represents the amount of free memory available on your system. 

To enhance performance, we recommend that you allocate at least 4000 K to 
VideoShop. If the Largest Unused Block is less than 3500 K, you may use the 
minimum memory allocation, 2500 K. Remember, QuickTime uses free memory 
while playing back movies, so deduct 600-750 K of free (temporary) memory to 
QuickTime when making memory allocation decisions. For example, if your 
system has 5 MB of RAM and the Largest Unused Block is 3750 K, set the 
VideoShop partition to 300-3150 K to accommodate QuickTime.

 

 

This document was created with FrameMaker 4.0.4
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Memory Allocation Guidelines

 

To change VideoShop memory allocation:

 

1.

 

Select the VideoShop icon.

 

2.

 

Choose 

 

Get Info

 

 from the 

 

File

 

 menu.

A dialog box is displayed.

 

Total Memory VideoShop Allocation

 

Less than 4 MB Insufficient memory

4 MB 2.5 MB

5 MB 2.5 MB

8 MB 3-4 MB

More than 8 MB 8 MB or more
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3.

 

Enter a new value for the memory allocation in the 

 

Current Size

 

 box in the 
bottom right of the dialog box.

 

Working under Low Memory Conditions

 

Although the preferred memory allocation for VideoShop is 4 MB, you can get by 
with allocating as little as 2.5 MB, if you make some other adjustments. The 
following guidelines can help you maximize VideoShop 3.0’s performance when 
operating under low memory conditions. 

 

To save memory space and prevent degradation of system performance:

 

• Turn off File Sharing from 

 

Sharing Setup

 

 in the Control Panels folder.

• Turn off electronic mail; consult the documentation for your electronic mail 
program.

• Turn off as many system extensions (INITs) as possible. To turn off a system 
extensions, use an extensions management utility or drag the extension out of 
your Extensions folder or System folder and restart the Macintosh. 
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• Avoid running VideoShop 3.0 while other applications are running. 

• Make sure that virtual memory is turned off. Virtual memory, a capability of 
System 7, tricks your computer into believing it has more memory than the 
actual on-board memory (RAM). However, QuickTime does not always 
function properly when significant amounts of virtual memory are used. To 
turn virtual memory off, double-click 

 

Memory

 

 in your Control Panels folder 
and change the setting. After making these adjustments, restart your 
Macintosh.

• Leave some temporary memory available. When determining how large the 
VideoShop partition should be, don’t use all of the possible free memory.

• While running VideoShop:

• Keep the number of windows open at a time to a minimum.

• Keep the recording window closed unless it is in use.

• Avoid adding unnecessary edits or tracks in an open sequencer, as they use 
up memory.

• Close the info palette when it’s not needed, especially during playback.

• Choose effects from the Transition button pop-up menu and the Filter 
button pop-up menu rather than from the effects dialog boxes.



 

Appendix B

 

File Formats

 

You can automatically convert and incorporate files of various file formats into your 
VideoShop movie. VideoShop supports PICT, PhotoCD, PICS graphic, Text files, 
and AIFF, MIDI, and SND audio formats. You can bring files with these 
formats directly into your sequencer as simply as you drag and drop video clips—
you don’t have to import them specially.

 

Recognizing File Types by Their Icons

 

File formats that VideoShop recognizes are visible in your desktop windows; files of 
unrecognized formats are not visible.

 

PICT PICS AIFF & SND PhotoCD AudioCD Text MIDI

 

 

This document was created with FrameMaker 4.0.4
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Using the Compression Settings

 

When you move a PICT or PICS file from a desktop window into a video track of 
your sequencer, VideoShop automatically displays the compression settings window. 
Compression reduces the storage requirements and improves the playback of your 
movie. 

By default, VideoShop selects what it deems to be the best compressor for your 
image. You can, of course, modify the compressor and compression settings. You 
need to consider the different file formats when you save, mixdown, or compress 
your movie. For more information on compression settings, see Chapter 9.
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PhotoCD Files

 

VideoShop recognizes PhotoCD files and lets you use them in your movie like any 
other clip. 

When you move a PhotoCD icon from a desktop window to the sequencer, a 
compression settings window is displayed, with a PICT or PICS file. PICT and 
PhotoCD files, when dragged and dropped into the sequencer, default to a 
duration of one second.

 

Text Files

 

You can add Text files from word processing programs to a title track of your 
sequencer. Text files are files which do not include format or style. Save the file as 
Text in your word processing program. (Choose 

 

Save

 

 

 

As 

 

from the 

 

File

 

 menu and 
choose 

 

Text

 

 or 

 

Text only

 

. See the documentation for your word processing 
program for instructions.)

You manipulate Text files just as you edit titles you created in VideoShop, in the title 
window. Open the Text file in the word processing application and copy the 
contents onto the clipboard. Then simply paste the contents into the titling window 
of VideoShop. Text files can also be dragged into a title track of the sequencer, at a 
default duration of two seconds. Text files default to white text on a black back-
ground. 
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To incorporate and scroll a Text file:

 

1.

 

Open the Text file. 

 

2.

 

Select the portions of text to include in your movie.

 

3.

 

Copy

 

 

 

the portion to the clipboard by choosing 

 

Copy

 

 from the 

 

Edit

 

 menu.

 

4.

 

Launch VideoShop again.

 

5.

 

Click the Text

 

 

 

tool.

 

6.

 

Choose scrolling options and direction from the 

 

Scroll

 

 and 

 

Direction

 

 pop-up 
menus.

 

7.

 

Press 

 

E

 

-V to paste the clipboard media into the titling window.

 

8.

 

Choose 

 

Insert Into Sequencer

 

 from the 

 

Title 

 

menu, or click the Insert Text

 

 

 

button from the titling window toolstrip.

 

Audio Files

 

VideoShop recognizes SND and AIFF audio files. You can use audio files in these 
formats without importing them. 

 

To incorporate an AIFF or SND file in your movie:

 

n

 

Drag and drop the file into an audio track of your sequencer.

Double-click an AIFF file to open a clip window. You can trim the AIFF file with 
the In and Out handles just like a video clip. When you want to drop it into your 
movie, hold down the 

 

Shift 

 

key to change the Double Arrow Hand tool to the 
Hand tool to grab and drag and drop the file into your sequencer.

 

AudioCD Files

 

VideoShop recognizes AudioCD files (standalone CDs used for music) and lets you 
use them in your movie like any other sound clip. Using AudioCDs brings better 
sound fidelity to your movie. There is less loss of data, as you are making a direct 
digital copy from the disk, without redigitizing.

 

To drop AudioCD tracks into a sequencer:

 

1.

 

Click the AudioCD icon in the volumes window to open a desktop window 
containing the AudioCD tracks.
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2.

 

Drag the track from an AudioCD into an audio track of the sequencer.

An AudioCD Import Options dialog box is displayed.
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3.

 

Set the In and Out points for the selection of audio you want to include.

 

4.

 

Establish the settings. (See Chapter 9 for a discussion of audio settings.)

 

5.

 

Click 

 

OK

 

, or press 

 

Return

 

 to begin importing the AudioCD to your movie.

 

Editing Frames in Graphics Applications

 

You can easily transfer a selection of frames from VideoShop to a graphics 
application, such as Fractal Design Painter

 



 

 to use that program’s painting, erasing, 
and duplicating tools. Then, when you’ve finished editing each frame, you can 
bring the entire selection back into VideoShop and paste it in its original location. 

 

To edit frames with a graphics application:

 

1.

 

In the Finder, launch the graphics application and open a new document.

 

Important:  

 

Make sure that the VideoShop plug-in module for Fractal Design Painter 
(or other applications) is installed. See Chapter 7 for details. 

 

2.

 

In the sequencer, in time view, select the range of frames you want to edit in 
the graphics application.

 

Important:  

 

Click the sequencer’s time scale selector closer to the right for an 
expanded view of the frames. You can more accurately select the frames you want in 
an expanded view. 

 

3.

 

Choose 

 

Copy

 

 from the 

 

Edit

 

 menu to place a copy of the frames in the 
clipboard. Do not remove the selection marquee from the sequencer.

 

4.

 

Click the new document of the graphics application to make it active. 

 

5.

 

Use the graphic application’s import commands to paste the selection into the 
application as a QuickTime movie. (See the documentation for the graphics 
application for instructions.)
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6.

 

Use the application’s tools to edit the frames. 

 

7.

 

After editing, select the frames and copy them to the clipboard.

 

8.

 

Switch back to VideoShop. 

If you have not made changes in VideoShop, the selection marquee should still 
be visible around the original frames. You can paste the edited selection directly 
into the marquee to replace the original frames.

 

9.

 

Choose 

 

Paste

 

 from the 

 

Edit

 

 menu. 

The edited frames fit exactly into the same location on the track.

 

Importing Still Images as Video Clips

 

A still image, such as a graph, photograph, or drawing created in another 
application makes an interesting addition to a movie. VideoShop lets you import 
graphic images as long as they are in the PICT format. To save a graphic as a PICT 
file, see the documentation for the graphics program for instructions. 

You can save PICT files in or move them to a desktop window. From the folder, 
drop them directly into a sequencer. VideoShop automatically converts the image to 
a video clip of one second duration. 

 

To bring a still image into the sequencer:

 

1.

 

Be sure the image is in PICT format.

If it is not, most graphics applications allow you to save the image in PICT 
format with the 

 

Save As

 

 command. See the documentation for your graphics 
application.

 

2.

 

Move the image into a folder.

 

3.

 

Switch to VideoShop. 

 

4.

 

Locate the image. (Use the 

 

Find

 

 command from the Macintosh 

 

File

 

 menu if 
you can’t locate it.) 

In a folder window, the image has a characteristic icon used by VideoShop to 
identify PICT files.

 

5.

 

 Drag and drop the image file into the sequencer.

VideoShop automatically converts the file into a QuickTime movie of one 
second duration. VideoShop displays the Compression Settings dialog box for 
PICT files. In the dialog box, set the movie’s quality and frame rate. 
(See Chapter 9 for more information.)
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6.

 

Choose the compressor, color depth, and image quality, and a duration value in 
seconds. (See Chapter 9 if you are unsure about which choices to make.) 

 

7.

 

Click 

 

OK 

 

to accept your compression settings.

The image becomes a QuickTime video clip in the sequencer.



 

Appendix C

 

Finding and Organizing Clips with 
Catalogs

 

VideoShop gives you the ability to integrate with database applications. When 
editing projects, having access to keyword searches and archiving is very powerful. 
The Avid Cataloger is a sample database developed in HyperCard and included 
with VideoShop. As it is 

 

only a sample

 

, we do not recommend that you use it to 
archive large libraries.

Each clip in the catalog has a card, or entry, in which you can enter information 
about the clip; there are fields for description, copyright information, keywords, file 
type, duration of the clip, dates created and modified, as well as a Micon or still 
image representing the clip. After an entry has been made for your clips, you can 
use the catalog for organization and retrieval. This appendix covers:

• Opening the catalog

• Entering clips in the Avid Cataloger

• Navigating in the Avid Cataloger

• Displaying information about a selected clip

• Finding a clip with the Avid Cataloger

• Printing Avid Cataloger entries

• Using other cataloging programs

• Choosing a catalog document

• Creating a new catalog stack

 

 

This document was created with FrameMaker 4.0.4
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Opening the Catalog

 

The catalog must reside in the same folder as the VideoShop application.

 

To open the Avid Cataloger:

 

1.

 

Select a clip in a desktop window.

 

2.

 

Choose 

 

Get Catalog Info

 

 from the 

 

File

 

 menu.

VideoShop launches the application and opens your designated Avid Cataloger 
card. 

You can automatically forward clip searches and selections directly to VideoShop—
in folders or dropped into the current sequencer. 

You can customize performance of the catalog in the 

 

Catalog Preferences 

 

dialog 
box, accessed from the 

 

File 

 

menu.

 

Entering Clips in the Avid Cataloger

 

Once you open your Avid Cataloger stack, you can create cards for each of your 
video and audio clips. (You can also create cards for graphics, images, and titles.) 
Each card is called an entry, and has a variety of information fields. There is a space 
for a Micon of the clip, which is added automatically when you create an entry. 

It is important to make an entry for each of the clips you intend to use and store. 
Once you have made an entry for a clip, add keywords to aid in searching for the 
clip and add notes to provide background information. 
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To enter a clip in the Avid Cataloger:

 

1.

 

Select the clip(s) in a desktop window. 

 

2.

 

Choose 

 

Update Catalog

 

 

 

Info 

 

from the 

 

File

 

 menu.

A dialog box opens to ask if you would like to create a new entry.

A new card is created for each selected clip. Each card automatically takes the 
title of the clip as its name. A Micon for video clips or an audio icon for audio 
clips is entered automatically in the card’s Micon field. 

As with clips in a desktop window, clicking the Micon displays a clip window 
where you can view the entire clip. Clicking an audio clip plays that clip.

 

or

 

Instead of selecting a clip and choosing 

 

Update Selected Clips

 

, you may 
choose 

 

Update Catalog Info

 

 without having any clips selected. This creates a 
new card for the last 20 clips created since you last updated the Avid Cataloger. 

 

3.

 

Enter your keywords and descriptive text into the various fields.

The clip is now a part of the Avid Cataloger.

 

or
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1.

 

Select a clip in a desktop window.

 

2.

 

Choose 

 

Get Catalog Info

 

 from the 

 

File

 

 menu, or press 

 

E

 

-I.

A dialog box appears, stating the clip was not found, and asks if you want to 
create a new entry.

 

3.

 

Click 

 

OK 

 

or press 

 

Return

 

.

A new card is created in the index. You can now fill in the description fields.
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Navigating in the Avid Cataloger

 

When you open the Avid Cataloger, you can search for and display other entries. 
The cards are organized in the catalog alphabetically, by clip name. You can see the 
list of all entries in the Avid Cataloger by clicking the 

 

Index

 

 button.

Each card in the Avid Cataloger has a toolstrip along the left that helps you navigate 
through the catalog and search for other clips and entries. Since the catalog is a 
HyperCard stack, it relies on familiar HyperCard conventions. 

 

 

Go To Next

 

Go To Next

 

 displays the next card in the Avid Cataloger index.

 

Go To Previous

 

Go To Previous 

 

displays the previous card in the Avid Cataloger index.

 

Query

 

Query

 

 opens a dialog box that helps you search for a clip entry. You may enter a 
keyword or phrase.

 

Index

 

Index

 

 opens the index card, which contains the alphabetical list of all catalog 
entries.

Index Card
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Expand/Collapse

 

Expand/Collapse

 

 displays the catalog cards in full or half size, to adjust the view to 
the amount of screen space you have.

 

Print 

 

Print

 

 displays a dialog box in which you can identify specific cards for printing on a 
hardcopy printer. To mark a card for printing, click on the flag in the upper left 
corner. (A raised flag indicates a “marked” card.) It can take a long time to print a 
large stack.

 

Delete

 

Delete

 

 removes the currently displayed catalog entry, but does not delete the clip 
from your hard disk. To delete 

 

all

 

 entries in the Avid Cataloger, display the index 
card, then click the Delete tool.

 

Open in VideoShop 

 

Open in VideoShop

 

 opens the clip in VideoShop. You can opt to open the clip in 
the desktop window, open the clip window, or open the found clip in an open 
sequencer. Determine how you want the clip to open in the Catalog Preferences 
dialog box.

 

Next Match

 

Next Match

 

 appears in the lower right corner of a card when a query finds more 
than one clip entry that matches the search string you typed.

 

Enter descriptive words to find a clip in the Query dialog box.
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Displaying Information about a Selected Clip

 

While you are working in VideoShop, with desktop windows open and Micons 
displayed, you will often find it useful to obtain information about a clip, such as 
the last time it was modified. If you include this information with the clip entry in 
the Avid Cataloger, you can quickly retrieve this 
information. 

 

To display clip information:

 

1.

 

Select a clip in a desktop window.

 

2.

 

Choose 

 

Get Catalog Info

 

 from the 

 

File

 

 menu.

If an entry exists for the selected clip, the Avid Cataloger displays the clip’s card. 
If no entry is found, you are asked to create an entry for the clip.

 

Finding a Clip with the Avid Cataloger

 

The Avid Cataloger can find a clip entry just as the 

 

Find

 

 command can locate a 
document. After you find the clip entry, you can display its desktop 
window and drag and drop the clip into a sequencer. You can search for clips by 
name, keyword, text from descriptive notes, date, size, and file type.

 

To find a clip with the Avid Cataloger:

 

1.

 

Choose 

 

Get Catalog Info

 

 from the 

 

File

 

 menu.

The Avid Cataloger’s index card is displayed. 

 

2.

 

If you know the name of the clip, select the name to display the card.

 

or

 

If you do not know the name of the clip, select the Query tool. This displays 
the Query dialog box with search options.

 

3.

 

In the Query dialog box, enter the keywords or descriptive text for finding the 
clip.
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You can restrict the search to a particular card field, and you can specify a 
partial, or exact match in wording. 

 

4.

 

Click 

 

OK

 

, or press 

 

Return

 

.

The Avid Cataloger locates the first entry that matches your query. If more 
than one entry matches your query, the Next Match button will be darkened. 
Click the Next Match button to display the next entry. 

 

5.

 

To display the desktop window containing the clip, click the Open in 
VideoShop button on the Avid Cataloger’s toolstrip.

VideoShop opens the desktop window containing the found clip, with the clip 
selected.

You can have entries found in the Avid Cataloger automatically drop into the active 
sequencer. The 

 

Preferences

 

 command on the 

 

File

 

 menu, in the 

 

Catalog

 

 submenu, 
contains an option that performs this drop for you whenever you find an entry. The 
clip is dropped into the beginning of the active sequencer.
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In addition, you can drag the preview of a clip in the Avid Cataloger directly to an 
active sequencer without leaving the cataloger.

 

To clear all entries in the Avid Cataloger:

 

1.

 

Display the index card.

 

2.

 

Click the Delete tool.

 

Printing Avid Cataloger Entries

 

You can print individual card entries or entire Avid Catalogers. A hardcopy version 
of the catalog is useful for annotating cards or for seeing several card entries simul-
taneously. You must mark clip entries for printing. 

 

To print Avid Cataloger entries:

 

Before you begin, display the Avid Cataloger by choosing the 

 

Get Catalog Info

 

 
command from the 

 

File

 

 menu.

 

1.

 

Display the first clip entry you want to print.

 

2.

 

Click on the card’s marker flag (upper right corner) to raise it.

Mark any other cards for printing in the same way. 

 

3.

 

Click the 

 

Print

 

 button on any card’s toolstrip.

The 

 

Print

 

 dialog box displays several print options.
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4.

 

Select your print options.

 

5.

 

Click 

 

Print, or press Return to print the marked card(s).

Before printing begins, the Avid Cataloger offers you the chance to unmark the 
flagged entries when printing is completed. It is a good idea to unflag your entries 
otherwise you will not know which entries are flagged for printing the next time 
you print. 

Using Other Cataloging Programs
HyperCard and Aldus Fetch can also be used as catalog programs. Working with 
these other programs is very similar to working with the Avid Cataloger, with one 
difference. With these other programs, you can maintain multiple catalogs. For 
example, you can construct a catalog for each of your projects in progress. 

Choosing a Catalog Document
VideoShop can only use one catalog at a time, although you may maintain any 
number of catalogs in various programs (such as HyperCard and Aldus Fetch). 

To choose a catalog:
1. Choose Catalog Preferences from the File menu.

A dialog box is displayed, with a set of program options and options for using 
the catalog. 
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2. Choose a catalog application from the Catalog Application menu.

If you select an application other than the Avid Cataloger, click Select 
Catalog.

3. Select the name of the catalog stack you want to use.

4. Click Open or double-click the stack name. 

Creating a New Catalog Stack
You can store any number of catalog stacks in the VideoShop application folder. To 
create a new catalog, you need a blank stack to use as a template. You can obtain 
blank copies of catalog stacks from the VideoShop Installer disk. 

If, for some reason you cannot locate a catalog stack or the original Installer disk, 
you can create a blank stack by making a duplicate of an older one and clearing all 
its entries.

To create a new catalog stack:
1. In the Macintosh Finder, select the catalog stack.

2. Make a duplicate of the stack by choosing Duplicate from the File menu.

3. Rename the duplicate copy of the stack.

4. Switch back to VideoShop (or launch the application). 

5. Choose Catalog Preferences from the Preferences submenu of the File 
menu.

A dialog box with options for setting catalog parameters appears.



302

VideoShop User’s Guide

6. From the Catalog Application menu, choose a catalog other than the Avid 
Cataloger.

Select Catalog becomes active.

7. Click Select Catalog.

The standard Macintosh Open File dialog box is displayed. 

8. Select the name of the new catalog stack.

9. Click Open or double-click the stack name. 

This redisplays the Catalog Preferences dialog box. 

10. Click OK to accept your changes and close the Catalog Preferences dialog box.

11. Choose Get Catalog Info from the File menu.

The application is launched (if it was not already open) and displays the initial 
entry in your catalog.

This gives you a new catalog stack for entering new entries.
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Appendix D

 

Troubleshooting Guide

 

The following problems are frequently encountered and are easily solved. Consult 
this chapter if you are having difficulties. 

If your problem persists after double-checking everything on this list, please contact 
the Avid Technical Support Staff at (508) 640-3070. Before you call, see “When 
You Contact Technical Support” in Chapter 1.

 

VDIG (Video Digitizing Component)

 

• Make certain the software associated with your digitizing hardware is correctly 
installed; reference the manufacturer instructions.

• Confirm that you have an up-to-date version of the VDIG (Video Digitizing 
Component).

 

Anti-Virus Software

 

• Disable your virus detection software before installing VideoShop. 

• You may scan the disks before disabling the anti-virus software.

 

QuickTime

 

• Make sure you have installed a supported version of QuickTime—use the 
version included with VideoShop.

 

Monitors

 

• Check the monitor settings from the Control Panel folder. Make sure the 
correct monitor is attached with the correct settings (color, depth).

 

 

This document was created with FrameMaker 4.0.4
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INITs

 

• Disable as many INITs as possible to avoid any software conflicts and to 
conserve memory.

 

Connections

 

• Check all cables connected to the digitizing board and to the computer. Loose 
cables may cause unreliable results in your video and audio.

 

Hard Disk

 

• Defragment your hard drive to ensure maximum performance. There are many 
software utility programs you can use to do this.

 

Memory

 

• Turn off virtual memory and reduce disk cache size. VideoShop and Quick-
Time manage available memory.

• Confirm that 32-bit addressing is on to ensure you are using all installed 
memory.

 

Logger 

 

Symptom: No video appears when you press Play. 

 

Possible solutions:

 

1.

 

Make sure the Recording window is open. The video plays in the recording 
window not in the Canvas window.

 

2.

 

Make sure that there is a cable running from the 

 

Video Out

 

 on your device to 
the 

 

Video In

 

 on your digitizing card.

 

3.

 

Make sure that the 

 

Source

 

 under Video Setting on the Recording

 

 

 

menu is set 
to the appropriate input (S-Video or Composite).

 

4.

 

Close the Device Control and Logging windows and press play on the video 
device. If you still do not see video, refer to the 

 

VideoShop User’s Guide

 

 and set 
up your system according to the instructions in the “Capturing Audio and 
Video” section . If you see video, the problem is with your device control 
setup. Refer to “The device control panel is dimmed and won’t respond” 
discussion below.
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Symptom: The device control panel is dimmed and will not 
respond

 

Possible solutions:

 

1.

 

Make sure there is a tape in the deck and video device is turned on.

 

2.

 

Press the 

 

Setup 

 

button on the Device Control window toolstrip.

 

3.

 

The 

 

VideoShop Logger Configuration

 

 dialog box appears.

 

4.

 

Check that the correct device is selected.

 

For ViSCA Users:

 

1.

 

Make sure there is a serial cable running from the 

 

Modem Port

 

 of your 
Macintosh to the 

 

ViSCA In

 

 (not the 

 

ViSCA Out

 

) port of your VDeck or 
VBox.

 

2.

 

If you have a VBox:

 

a.

 

Make sure the VBox is plugged in and turned on. The power light on the 
front of the VBox should be illuminated.

 

b.

 

Make sure the Control-L cable runs from the Control-L port on the VBox 
to the Control-L port of the video device.

 

3.

 

Close the Device Control window and choose 

 

ViSCA 

 

from the 

 

Control 
Panels 

 

option on the 

 

Apple 

 

menu. If ViSCA is not present, quit VideoShop 
and reinstall the ViSCA Control Panel as detailed in Chapter 12.

 

4.

 

If ViSCA is present, choose 

 

No ViSCA

 

 from the pop-up menu. Then choose, 
Modem Port (or 

 

Printer Port

 

 if your device is connected to the printer port). 
ViSCA should report that the “Number of devices found = 1.” If it does not, 
the problem is with the serial cable connection or the device itself.
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Symptom: Frames are missing at the beginning or end of 
digitized footage

 

Possible Solution:

 

1.

 

This is more likely to occur when you are using the counter rather than the 
time code as your time source. If possible, dub time code onto your tape and 
use time code (don’t forget to change the time source to time code in the 
VideoShop Logger Configuration

 

 

 

window).

 

2.

 

If you are using the counter as the time source, you should specify a liberal 
number of slack frames (at least 30) in the VideoShop Logger Configuration 
window. You should also 

 

Reset

 

 the device immediately before digitization and 
periodically while you are logging footage. (See “Resetting the Counter” in 
Chapter 12). 

 

Symptom: The first few frames of video are garbled

 

Possible Solution:

 

1.

 

Increase the number of 

 

Preroll

 

 frames in the VideoShop Logger Configuration 
window. 

This problem usually occurs because the picture has not yet become stable after 
the device searches for the footage.

 

2.

 

If this does not help, increase the number of slack frames in the VideoShop 
Logger Configuration dialog and trim the unwanted footage in VideoShop. 
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Symptom: The keyboard shortcuts for controlling the video 
device do not work

 

Possible Solution:

 

n

 

Activate the Device Control

 

 

 

window or the Recording window. Either the 
Device Control

 

 

 

window or the Recording window must be active for the 
keyboard shortcuts to work. 

 

Setup for using ViSCA deck control and the Quadra 840 AV

 

There are some peculiarities using ViSCA deck control with the Quadra 840 AV 
due to the Macintosh’s Geoport hardware on the modem port. 

 

To compensate:

 

• Plug the ViSCA cable into the Printer Port.

• Disable AppleTalk.

• Switch to 

 

Printer

 

 in the ViSCA Control Panel
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Appendix E

 

Tips and Techniques

 

The following techniques and tricks of the trade may help you create your movie 
with the most professional and polished results from VideoShop. 

This chapter covers the following topics:

• Shooting video

• Lighting for video

• Editing techniques

• Synchronizing

• Rotoscoping

• Blue screen

• Alpha Map

• Video in a title

• Mesh warp

• Morph

• Exporting backgrounds

• Transcript tracks

• Delayed video wall

 

 

This document was created with FrameMaker 4.0.4
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Shooting Video

 

Close-ups and medium shots are best for video and digitized video. Both extreme 
close-ups and long shots are best used in small doses, as fine detail and subtle color 
differences are often blurred on television and computer screens.

Also, it is important to note that the visible area on a computer or television screen 
differs from the visible area on videotape and in a camcorder viewfinder. Be sure 
that the bulk of the action takes place within the 

 

Safe Action Area

 

—approxi-
mately the inner 80% of the monitor—the NTSC standard.

 

Lighting for Video

 

Be sure to consider the difference in resolution between film and video when light-
ing for video and digitized video. The brightest and the darkest areas tend to wash 
out; what looks like strong contrast with the eye often looks muddy on video. Be 
advised, strongly backlit scenes tend to become silhouettes on video. For video, 
low contrast lighting is your best bet.

 

Editing Techniques

 

The following are advanced digital effects and techniques you can use in 
VideoShop. Each procedure is spelled out to help you achieve professional quality 
results. The techniques described assume a familiarity with the basics of VideoShop.

 

Synchronizing

 

The following are more advanced techniques for precision cutting to music and for 
adding cut-away shots to pre-synchronized video and audio. Use these techniques 
after you have mastered basic synchronization. (For information on synchronizing, 
see Chapter 4.) 

 

To cut to the beat:

 

First, make sure you are working in a sequencer in time view, with video and audio 
in the tracks.

 

1.

 

Use the scrub in the canvas window to move slowly back and forth until you 
hear and see the precise point for the cut in the canvas window.

When you release the scrub, a playout point marks the point for the cut.

 

2.

 

Press 

 

Enter

 

 to set an insertion point and to automatically scroll to that point in 
the sequencer.
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3.

 

Use the time selector or the Magnify tool to zoom in at the playout point.

 

4.

 

Trim the clip back or slide to match up with the insertion point.

 

5.

 

Move subsequent clips back to meet the trimmed clip by grabbing the orange 
slide bar with the Hand tool.

 

or

 

Use the In and Out flags to trim to that point.

 

or

 

Double-click the Cut tool to cut at the playout point.

 

or

 

Press 

 

I

 

 and 

 

O

 

 in the sequencer while listening to the audio to set In and Out 
points, respectively, at the appropriate audio cue.

 

6.

 

Press 

 

Return

 

 to play from the In point to the Out point before making edits.

 

Important:  

 

For improved playout performance, store audio and video material on 
separate hard drives while editing.

 

Rotoscoping

 

Rotoscoping is a technique for painting or drawing on individual frames of a 
movie. Portions of clips can be exported to painting applications (such as Fractal 
Design Painter

 



 

) for customized effects and detailing. When these clips are read 
into a painting application, they appear as 

 

filmstrips

 

.

 

To rotoscope:

 

You must have the appropriate painting application installed on your computer to 
proceed.

Make sure the VideoShop plug-in for the painting application is installed in the 
painting application’s folder.

 

1.

 

In a video track of a sequencer in time view, select a portion of a clip.

 

2.

 

Choose 

 

Copy

 

 from the 

 

Edit

 

 menu (or press 

 

E

 

-C).

 

3.

 

Choose your painting application from the 

 

Open Other

 

 submenu of the 

 

File

 

 
menu.

Your selected program launches.
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4.

 

In the painting application, choose 

 

Acquire

 

 from the 

 

File

 

 menu.

An Import QuickTime dialog box opens. Select to import frames from the 
clipboard.

A filmstrip of your frames opens in the painting application. Use the features of 
the painting application to edit the individual frames as you desire. 

 

5.

 

When you are done, choose 

 

Export

 

 from the 

 

File

 

 menu.

The Compression Settings dialog box appears (for more information on these 
settings, please see Chapter 9) in which you set compression parameters, and 
click 

 

OK

 

.
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A dialog box appears in which you can name the filmstrip and determine to 
what folder and drive it should be saved.

 

6.

 

Return to VideoShop.

 

7.

 

Choose 

 

Paste

 

 from the 

 

Edit

 

 menu (or press 

 

E

 

-V) to paste the rotoscoped 
filmstrip from the clipboard to a selection in the sequencer.

The rotoscoped portion appears as a separate clip in the sequencer, with a dog-
eared corner.

 

Blue Screen

 

You use a blue screen in shooting video when you plan to chroma/luma key one 
video over another. Essentially, you shoot a subject in front of a blue background 
and “key” out the blue with a chroma key.

Chroma key is a multi-track filter effect in which a specific color on one track is 
made transparent to expose the video track beneath it. Chroma key works on one 
color only, everywhere it appears in the frame. The color blue is used because of its 
uniform color intensity and because there is no blue in skin tones, so there is very 
little chance of turning your subject’s face transparent. Blue screen effects are often 
seen in the nightly news, whenever a map appears behind the weatherperson.
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Shooting Against a Blue Screen

 

When using a blue screen, be sure to use adequate lighting. There should be only a 
slight difference in intensities between the key light and the fill light. In film, key 
light is the primary source of light; fill light is light that rounds out the scene and 
balances the amount of bright spots and shadows.

While skin tones are not blue, shadows are. Medium tone shadows contain blue 
tones, and can become transparent when chroma keyed. 

It is also a good idea to have your subject wear something other than white. Colors 
reflect on white, which may cause portions of a white shirt or object to disappear 
when chroma keyed.

 

Chroma Keying with a Blue Screen

 

Once your subject has been shot in front of the uniform color of a blue screen (and 
your video has been digitized), you are ready to apply a chroma key.

 

To apply a chroma key filter:

 

1.

 

Add an empty track to your sequencer and insert the foreground (blue screen 
video) of the chroma key filter. (Refer to Chapter 5.)

 

2.

 

Add another empty track and insert the background of the chroma key filter.

 

3.

 

Position the track containing the foreground media directly above the track 
containing the background. (Refer to Chapter 5.)

 

4.

 

Select a region over both tracks to which to apply the effect.
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5.

 

Click the Filter button.

 

or

 

Choose 

 

Apply Filter

 

 from the 

 

Sequence

 

 menu, then 

 

Apply Filter

 

 from the 
submenu.

An Apply Filter dialog box is displayed. Only filters appropriate for the 
number of tracks selected appear. Since you have selected a region over two 
tracks, only two-track filters are available.

 

6.

 

Choose 

 

Chroma Key

 

, then click 

 

Apply

 

.

 

7.

 

Use the Eye Dropper tool to select a color to chroma key. Adjust color 
tolerance and color smoothing as necessary.
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8.

 

Build and apply the effect to your movie sequence in the same way that you 
build and apply single-track filters.

When the effect is created, the text and video are blended together. The 
resulting effect appears in the upper video track.
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Alpha Map

 

VideoShop currently supports a three-track Alpha Map filter. An Alpha Map uses 
alpha channels to give a very high-quality multi-track blending effect. This filter is 
useful for creating complex transparency effects in your movies. The Alpha Map 
filter takes the middle track and uses it to create a dynamic alpha channel. The third 
track is revealed through the first by using the second to set the alpha values.

 

To apply an Alpha Map filter:

 

1.

 

Add two video tracks to your movie and insert media (video or text). 

 

2.

 

Add either a video or text track to your movie. 

The media that you place in this track should be in black and white, or in 
shades of gray. This is used as the Alpha Map.

 

3.

 

Position the Alpha Map track containing black and white media between the 
two other tracks. (Refer to Chapter 5.)

 

4.

 

Select a region over the three tracks. The Alpha Map filter is applied over this 
region.
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5.

 

Click the Filter button.

or

Choose 

 

Apply Filter

 

 from the 

 

Sequence

 

 menu, then 

 

Apply Filter

 

 from the 
submenu.

An Apply Filter dialog box is displayed. Only filters appropriate for the 
number of tracks selected appear. Since you have selected a region over three 
tracks, only three-track filters are available.

 

6.

 

Choose 

 

Alpha Map

 

, then click 

 

Apply

 

.

An Alpha Map filter is applied. Media on the top video track is substituted into 
the black regions of the middle track, and media on the lower video track is 
substituted into the white regions of the middle track.

When the filter is created, the text and video are blended together. 

 

Video in a Title

 

You can create the effect of video in a moving title by combining scrolling text and 
an Alpha Map filter.

 

To key video through a moving title:

 

1.

 

Add two video tracks and a title track.

 

2.

 

Position the title track between the two video tracks.

 

3.

 

Insert a title with scrolling text to the title track, or use the path editor to move 
a title. Refer to Chapter 8 for titles, Chapter 6 for motion control.
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4. Select across all three tracks and apply the Alpha Map filter.

The video from the bottom track appears through the top track in the shape of 
the title.

Mesh Warp
Mesh warp is a one-track filter that allows you to warp an image (stretch, shrink, 
twist, etc.) based on a modifiable mesh. You can think of the image as a sheet of 
rubber.

To apply a mesh warp:
1. Select an area across one track in the sequencer.

2. Choose Mesh Warp from the Apply Filter menu on the Sequence menu. 

This displays a window. 
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Mesh Warp Window Tools
The window has three main parts: the control mesh, the warp mesh, and the key 
frames display. Each point in the control mesh maps to a point in the warp mesh. 
You can think of these meshes as before (control mesh) and after (warp mesh). 
When you click a point in either mesh (an intersection of lines), the corresponding 
point highlights in the other mesh.

Click key points of the image in the control mesh to define the points you want to 
stretch. Then move the corresponding point in the warp mesh to the new 
destination. The filter stretches the point from its origin in the control mesh to its 
destination in the warp mesh.

Apply the control and warp mesh to each key frame. The filter automatically 
considers the first and last frames as key frames. Add key frames by using the slider 
to go to a frame and then click either mesh. When you animate or build, the filter 
automatically interpolates between the key frames to make the image warp over 
time.
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Control Mesh. Uses the control mesh to define the key points in the image that 
you want to move.

Warp Mesh. Defines the destination of each point in the image. Points defined in 
the control mesh are stretched to their new destination in the warp mesh.

Key Frames Display. Indicates key frames included in the mesh. The first and 
last frames of the selection are always key frames. To add more key frames, move 
the slider to a point in the selection and click in either the control mesh or warp 
mesh window. A red border surrounds the frame to indicate that it is a key frame. 

Load. Allows you to load predefined meshes.

Save. Allows you to save your own meshes.

Options. Displays a dialog box.

Use Smooth Mesh. Uses a smooth instead of a linear mesh.

HiQ. Produces a better looking image but takes three times as long.

# Vert Lines. Sets the number of vertical lines in the grid.

# Horiz Lines. Sets the number of horizontal lines in the grid.

Line Width. Sets the thickness of the lines on the mesh.

Special Keys
Pressing the Option key while the cursor is over the image changes the Crosshair 
into the Magnify tool to zoom in. To zoom out, press both the Option and Shift 
keys. The Control key activates the Hand tool for moving around the zoomed 
image.

Pressing the Option key while dragging a point releases the mesh movement 
constraints and allows you to cross over other points in the mesh.

You can use keyboard shortcuts (E-X, E-C, and E-V) to cut, copy, and paste 
key frames, respectively.
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3. Select an area across one track in the sequencer, and choose Mesh Warp from 
the Apply Filter menu on the Sequence menu. 

This displays the mesh effect dialog box.

4. Move the mouse over the Control Mesh image. 

The Selection tool becomes a Crosshair. 

5. Click and drag points of the control mesh to identify key points in the image.

Important:  Click on the intersection of two lines in the control mesh and notice 
how the corresponding point is highlighted in the warp mesh. Whatever part of the 
image lies under that point in the control mesh appears under the corresponding 
point in the warp mesh.

A line intersection can be moved anywhere so that it doesn’t cross any other lines, 
and so that no lines are twisted more than 90º. 

Press the Option key while dragging a point to release these constraints. The 
resultant image, however, may have discontinuities.The first key frame is high-
lighted, meaning that you have been modifying the first frame.

6. Click the corresponding points in the mesh warp and move them to their new 
destination.

7. Click Preview (located between the two images).

Points defined in the control mesh move to their new location in the warp 
mesh.
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8. Click the last key frame to modify it, or use the arrow keys on the keyboard to 
move the highlighted square over the appropriate key frame. 

You can now modify the mesh of the last key frame.

9. Click OK, or press Return to accept the warp.

The affected area appears in the sequencer with a blue effects bar across the 
top. 

To see a small preview of the whole sequence:
1. Click the Animate button.

2. Use the slide control to shuttle through the frames. Notice that the mesh 
changes smoothly from the first key frame to the last key frame. 
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To add a key frame: 
1. Move to the frame with the slider.

2. Click either the control or warp mesh. 

A red border appears around the images, signifying a key frame. You can add 
up to 100 key frames in the sequence.

To delete a key frame: 
1. Select the key frame.

2. Press Delete.

Mesh warp does not currently support Undo so make sure you don’t delete 
something you want to keep.

To copy the mesh from a key frame:
1. Select the key frame.

2. Click Copy (between the two meshes).

3. Select a new key frame.

4. Press E-V to paste the mesh.

Morph
A morph is a two-track filter that allows for a metamorphosis from one image in 
the top track to another in the bottom track. The two images can be either still 
images or moving images. A morph between moving images is known as a 
dynamic motion morph.

You apply a morph essentially the same as a mesh warp. Before working with 
morph, familiarize yourself with mesh warp. The effect is a combination of a warp 
and a fade. As such, you have controls for each.

To apply a morph ef fect:
The first step in producing a morph is to acquire images that will produce a good 
morph effect. The images should be on a similar background (preferably a solid 
color) and should be similar in shape, positioning, and motion.
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1. Create a new video track in the sequencer by clicking the Add Track button 
and selecting Video Track. 

2. Position the first clip in the top track and the second in the bottom track so the 
frames that you want to morph overlap.

It may help to temporarily set the top track transparent so that you can see how 
your images line up.

3. Make a selection across the overlapping frames in the two tracks.

4. Click the Filter button and choose Morph from the submenu.

A morph window opens that looks similar to mesh warp. For a description of 
this dialog box, refer to the discussion of mesh warp earlier in this appendix.

5. Click Options and set the grid density in the Options dialog box so that there 
are enough points to line up with all the important points in your images (eyes, 
chin, mouth, nose, hairline).
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6. Start with the first key frame and align the points in the grid to the important 
points in the first (top track) image.

Caution:  Setting the key points is the critical step in the morphing process. Place 
the points in the start image over the important features that will move to a 
specified location in the end image.

You can set points either with a visible mesh or with only the points showing. 
To show only the points, click Hide Mesh.

7. When the points are aligned in the top track image, align the points to the 
corresponding important points on the bottom track image.

8. Press E-C to copy the mesh from the first key frame. 

9. Click the last key frame and press E-V to paste the copied mesh onto the last 
key frame.

If the images have moved over the sequence, re-align the points.

10. Move to the middle frame and click Preview.

A representation of the morph halfway through is displayed. If the images have 
moved over the sequence, set more key frames and re-align the points.

Shuttle through the frames and watch the points on the images. Wherever the 
image moves from under the points, click the image to create a new key frame 
and re-align the points. Preview the image often to ensure good alignment.

Important:  Before clicking OK to build the effect, save the mesh in case you want 
to redo the morph with a slight change.

11. Click OK, or press Return to build the effect.
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Key Morph Controls

Warp Interval Control. Adjusts the start and finish warp time.

Fade Interval Control. Adjusts when the image starts and finishes fading the 
colors from the first image to the second.

Important:  If you do not have a video compression card, better results can be 
obtained if you change the effect quality in the Filter dialog box to Other, then 
select Apple None for the compression type.

Exporting Backgrounds
There are many options for canvas backgrounds, from both solid colors and 
patterns. Canvas backgrounds are PixPat patterns or solid colors. Each movie can 
have only one canvas background. If you want to use the background patterns to 
quickly change background images, use the Export Picture to Clipboard 
command on the File menu. 

The basic settings for the canvas window are static. You can also manipulate the 
background to change images over time to create a dynamic backdrop to your 
movie. After a background is exported, it is a PICT file which you can incorporate 
into your sequencer. You can apply any effect or transition to a PICT image in the 
sequence. For information on basic setting and changing the background of the 
canvas, see Chapter 3.

To export a canvas background:
Open a new sequencer and select a background pattern. Do not add any clips.

1. Click in the sequencer in time view to set an insertion point.

2. Choose Export Picture to Clipboard from the File menu.

A snapshot of the canvas is taken and placed on the clipboard.

3. Choose Paste Picture from the Edit menu to paste one frame, or select a 
duration in the track and choose Paste Scale from the Edit menu.

The image of the canvas from the clipboard is pasted into a video track of the 
sequencer.
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4. Change the background pattern. Repeat to change the image.

Alternately, make a selection in a video track of a sequencer and use one of the 
other methods of paste, such as Paste Stretch (to extend the duration of the 
PICT image to fit the selection), Paste Overwrite (to paste over other media 
in a selection), or Paste Truncate (to crop the image to a selection shorter 
than the image).

Transcript Tracks
Transcript tracks are titles that have not been mixed down or interleaved with 
other video and audio. You can use transcript tracks to maintain running subtitles 
with the movie (even in foreign languages) that can be searched with an authoring 
program or in a standalone run-time movie. Use the Find command to find a word 
on a transcript track and to display the word and its corresponding video frame. 
Transcript tracks are particularly useful in interactive presentations and CD 
authoring.

To create a transcript track:
Make sure the title track in the sequencer is not collapsed.

1. Add titles to your movie in the usual way (see Chapter 8).

Important:  You may choose to display the transcript, or you may place it in the 
workspace, outside the canvas to create an invisible and searchable transcript track.

2. Click the lower half of the track icon to the left of the sequencer.

The Track Settings dialog box appears.
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3. Check the Transcript Track checkbox.

4. Click OK, or press Return.

5. When you are done composing your movie, choose Save As Movie from the 
File menu.

6. Check Standalone Player.

7. Click OK, or press Return.

The transcript track is not included in the mixdown process.

To search on a transcript in a standalone player:
1. Double-click the icon of the player to open movie.

2. Choose Movie Search or press E-T.

3. Enter the keyword for the search.

4. Click OK, or press Return.

The movie advances to the point where the keyword is found in the transcript 
track.

To use a Text file as a transcript:
1. Add a title track and set it as the transcript track.

2. Drop the Text file into the track.

Important:  VideoShop automatically looks for carriage returns and breaks the text 
into separate screens. To change the synchronization of the text, you must use the 
Cut tool. Do not apply scrolling to this file, as only the first screen is recognized for 
scrolling.
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To synchronize transcripts from a Text file:
1. Add a Text file to the title track.

2. Select the Cut tool.

3. Click and hold the Cut tool in the title track until the words change in the 
canvas window.

4. Release the mouse when you see the words change in the canvas window.

The text clip is snipped.

5. Repeat for the entire transcript.

6. Synchronize text clips by stretching and sliding. (See Chapter 4.)

Delayed Video Wall
A video wall is a group of clips, positioned in rows and columns in the canvas 
window. A delayed video wall is a series of the same clip, where the timing of the 
clips is adjusted so that the action in the clips occur sequentially, as when fans in a 
football stadium do “the wave.”
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To create a delayed video wall:
1. Place a clip in the sequencer in time view.

2. Add as many tracks as you want clips in the video wall.

3. Add the same clip to each additional track.

Make sure each clip is at the very beginning of each track.

4. Choose Canvas Size from the Canvas menu.

Change the dimension of the canvas to a size that fits the number of clips 
across and down. For example, if your video wall is to be 4 clips by 4 clips and 
the clip you have selected is 80 x 60 pixels, change the canvas size to 320 x 
240.

5. Click to select a clip in the canvas window, and move it to a quadrant.

6. Repeat for all clips until they are placed across and down on the canvas (like a 
checkerboard).

Consider the layering order of clips in the sequencer when you place clips in 
the canvas window. The first clip you select and move relates to the top video 
track, and the bottom clip in the canvas window is the lowest track in the 
sequencer.

7. Click the beginning of the first track in the sequencer to set an insertion point.

8. Select and delete the first few frames on the track (E-X).

9. Slide the clip to the beginning of the track.

10. Click the second track and delete twice the number of frames.

11. Repeat for each track, increasing the number of frames deleted in each 
subsequent track.

12. Make the end point of each track even by selecting across all tracks from the 
end point of the first track to the end point of the last track and deleting the 
extra frames.

13. Choose Save As Movie from the File menu and check the Mixdown Movie 
option in the Save As Movie dialog box.
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loading
effects  146

local switch  253
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logger
activated  256

basics  252

configuration  255

setup button  255

logging
basics  261

before batch digitizing  269

definition  261

entries  269

preparing for  265

print  273

saving  263

window  29, 254

luma key  317

M
MACE settings  241

Macintosh
configurations  17
PowerBook  254

managing
media  31–48

media files  36

copying  40

memory  308

allocation guidelines  282

and recording  244

changing allocation  282

management  281–284

managing with little  283

requirements  17
saving  283

mesh warp  323

Micons  31

adding  45, 197

creating when recording  233

defining preview  45

MIDI  79

MIDI files  37

mixdown  129, 187, 197

data loss  200

for CD-ROM playback  217

issues  207

saving  200

smart optimize  200

when to  198

modem port  254

monitors  307

morph  328

motion control  131–143

Align command  142

info palette  143

path  131

resizing clips  142

speed  140

mountain buttons  95

movies
archiving  196

composing

overview  23

cross-platform  196

delivering  24

distributing  209, 218

editing  49–80

editing after saving  189

foreground  120

frame-by-frame viewing  56

improving performance  197, 198,
208

in presentations  213

inset  119
layout  24, 81–100

mixdown  197

optimizing  187–208

options for saving  193
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overview  22

picture-in-picture  119
playing  44, 82

playing in reverse  84

previewing  213

recording  253

reference  196

reference vs. self-contained  195

saving  187, 192

self-contained  195

split screen  122

standalone  196

moving tracks  89

multiple tracks  115, 130

filters  152, 321

sound  128

multitasking  35

music  128

music tracks  79

N
narration  77, 128

NTSC  216

O
One Pass Digitization process  275

opening
existing project  262

new sequencers  51

volumes  33

optimizing
editing  129, 199

performance  197, 198

sequencer  129

smart  200

temporary  199

when to  198

Out point  54, 73, 261, 273

P
PAL  216

partitions  247

paste  70

text  288

path editor  131

paths  131

adding path points  134

creating  132

direction  138

editing  136

navigating  141

predefined  138

previously saved  140

removing path points  136

saving  139

patterns  85

canvas background  85

PixPat  331

performance
and low memory conditions  283

improving  94, 198

movie  197

PhotoCD  285, 287

PICS files  191, 285, 286

PICT files  191, 271, 285, 286, 291

picture-in-picture  119
PixPat patterns  331

player settings  197

playing
clip window  54

movies  44, 195, 216

movies in reverse  84

multiple audio tracks  128

only one track  127

sequence  56, 82

playout
point  62, 82, 88
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slowing down  84

speeding up  84

stopping  56, 83

Plug-Ins folder  146

point size  171

port  254

positioning
clips  90, 94

tracks  89

poster
frames  271, 274

view  274

power failure  263

PowerBook, Macintosh  254

predefined paths  138

preroll frames  255

presentations  213

previewing
analog source entry  272

filters  148, 151

Micons  45

transitions  162

printing
catalog entries  301

log  273

printer port  254

print-to-video  214

to videotape  24

video  213

videotape  209

problems  307–311

producing videotapes  209–219

protocol
deck  254

Pull and Stretch transitions  160

Pull In transitions  160

Q
quality

clips  100

compression  204

image  86

slider  236

QuickTime  18, 22, 216, 307

files  31

Windows  196

R
RAM  263, 281–284

recording to  230, 247

rate  275

audio compression  267

recalibrating  258

Record button  260

recording  221–250, 279

"easy" method  243

audio parameters  239

clips  260

compression settings  235

device control  260

establishing partition  247

folder  223

image settings  237

movie  253

overview  23, 222

sample scenarios  243

source settings  234

still frames  230

to RAM  230, 247

to videotape  209

video parameters  231

window  224

with limited disk and memory  244

recording window  27

sizing  225
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reference movies  195

remote
control  256

settings  266

switch  253

removing
blank time  114
paths  137

renaming files and folders  40

repeat  204

frames  111
resetting  258

Resize from Center button  93

resizing
clips  89, 91

clipsmotion control  142

text  170

tracks  89

rolling trim  110
rotoscoping  315

rubberbands  77, 126

audio  78, 128

transparency  96

video  96

run-time players  196

S
safe action area  314

saturation  238

Save as Movie  201

saving
bins  264

copy of bin  264

mixdown  200

movies  187–208

multiple sequencers  190

options  193

paths  139

sequencers  190, 191

to videotape  209

work-in-progress  189

your work  263

scaling
clips  86

zoom buttons  95

zoom vs. resize  95

scrolling titles  181

SECAM  216

selecting
across all tracks  67

across one or more tracks  65

clips  54, 91

existing project  262

extending up or down  67

from the keyboard  68

info palette  157

moving up or down tracks  67

section of clips  54

self-contained movies  195

sequence
playing  82

stopping  83

sequencer
copying  191

distributing  191

editing  70

mixing down  129

new  51

optimizing  129

saving  190, 191

switching to storyboard view  51

window  25

settings
audio  239, 267

compression  202, 267, 286

image  228
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player  197

remote  266

sound  241

source  234, 239

sharpness  238

shooting
video  314

single step  269

slack frames  255

frames

slack  256

sliding
clips  102, 103

clips vs. blank time  114
slower playout  84

smart optimize  200

SND files  191, 285, 288

snipping clips  72

solo tracks  127

audio  128

Sony
serial decks  253, 266

VDeck  278

sound
effects  128

input devices  249

multiple tracks  128

output options  206

rubberbands  128

sample settings  241

Sound Manager  18
source

parameter settings  239

settings  234

tapes  265

time  255

special effects  145–165

overview  23

speed
changing  140

splicing clips  71

split screen movies  122

standalone
movies  192

run-time players  196

Start at Cut transitions  161

starting playout  56

stereo  207, 242

sticky trim  105

still images  291

compression  203

recording  230

stopping
playback  216

playout  56

sequence  83

storage
movies  196

requirements  17
storyboard

overview  23

view  49, 51

stretch  73

clips  72

tool  72, 112
vs. changing duration  154

subtitles  332

S-Video  234

synchronization  314

audio and video  102

clips  101, 106, 114, 141

precision  104

sliding  102

transcripts  334

trimming  74, 108

video and audio  56
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system
configuration  17
extensions  18

T
tapes

source tapes  265

tape logs  263

technical support  21, 307–311

temporary optimization  199

Text files  285, 287

transcripts  333

The Logger  251–279

time
bar  58

blank  113, 114
blank, removing  114
changing titles  180

clips  88

code  255, 258, 277

inserting  114
opening time view  58

readout  102

source  255

switching from storyboard to time
view  58

titles  175

view  49

Time Code Dub  278

tips and techniques  313–336

titles  322

adding  167–186

alignment  172

anti-aliasing  181

changing  180

changing timing  175

color  172

drop shadows  184

duration  176, 178

editing  171, 179

filters  153

fonts  172

inserting  172

positioning  180

resizing  170

scrolling  181

title tool  167

title tracks  168

title window  28, 168

tracks
active  124, 125

adding  116
collapsing  126

deactivating  124

deleting  116
expanding  126

inactive  124

layering  118
mode  88, 117
moving insertion point  65

multiple  115–130

multiple audio  128

music  79

resizing and positioning  89

sliding  103

solo  127

synchronizing  102

title  168

transcript  332

transcript tracks  332

transcripts  333

transitions  145, 156

applying  159

Centered at Cut  161

changing duration  163

effects  156
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End at Cut  162

point  71

previewing  162

Pull and Stretch  160

Pull In  160

Start at Cut  161

transparency
clips  96

rubberbands  96

setting  99

Trim Dialog  75, 109

rolling trim  110
trim tool  73, 108

Trim Dialog  109

trimming
clips  73, 74

rolling trim  110
synchronization  74

Trim Dialog  75, 109

troubleshooting  307–311

two-track filters  152

U
underlining  172

undo  71

clear  70

cut  69

delete  70

unmounting volumes  42

unsynchronizing clips  107

Update button  271

V
VCR  23, 260

VDeck, Sony  278

VDIG  307

video
capture  260

capture rate  267

capture rates  246

compression  202

compression boards  211

compression capture rate  267

device  255

disk  23

formats  216

hardware  248

in titles  322

parameters  231

preparing the device  256

printing to videotape  24

scanning  271

signals  216

standards  234

tape  209, 216

tape production  211

video-out boards  212

wall  334

walls  122

Video Digitizing Component  307

video wall  334

VideoShop
configuration  212, 218

Desktop  31

introduction  22

package contents  17
switching to other applications  35

technical support  21

view
frame-by-frame  56

list  274

poster  274

viewing frames  83

virtual memory  308

virus detection software  307

ViSCA
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decks  266, 278

driver installation  20

ViSCA decks  254

VITC  278

voice-over  128

volumes  41

closing  33

opening  33

unmounting  42

while recording  227

window  33

W
white level  238

windows
canvas  26

clip  26

desktop  27

Device Control  29

folders vs. folders  34

info palette  59

logging  29, 254

recording  27, 224

sequencer  25

titling  28

volumes  33

word processing files  287

workspace view  87

X
x2 button  93

Z
zooming  95

zoom buttons  95
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